# Content

<table>
<thead>
<tr>
<th>1</th>
<th>Introduction. .................................................................................................................. 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Welcome to SAP Data Services. ........................................................................................................... 7</td>
</tr>
<tr>
<td></td>
<td>Welcome. ....................................................................................................................................... 7</td>
</tr>
<tr>
<td></td>
<td>Documentation set for SAP Data Services. ...................................................................................... 7</td>
</tr>
<tr>
<td></td>
<td>Accessing documentation from the Web. ......................................................................................... 9</td>
</tr>
<tr>
<td></td>
<td>SAP information resources. ........................................................................................................... 9</td>
</tr>
<tr>
<td>1.2</td>
<td>Overview of this guide. .................................................................................................................. 10</td>
</tr>
<tr>
<td></td>
<td>About this guide. ............................................................................................................................. 10</td>
</tr>
<tr>
<td></td>
<td>Who should read this guide. ........................................................................................................... 11</td>
</tr>
<tr>
<td>2</td>
<td>Logging into the Management Console. ..................................................................................... 12</td>
</tr>
<tr>
<td>2.1</td>
<td>Management Console navigation. ............................................................................................... 12</td>
</tr>
<tr>
<td>3</td>
<td>Administrator. ............................................................................................................................. 14</td>
</tr>
<tr>
<td>3.1</td>
<td>Administrator navigation. ............................................................................................................ 14</td>
</tr>
<tr>
<td></td>
<td>Status node. .................................................................................................................................. 15</td>
</tr>
<tr>
<td></td>
<td>Batch node. .................................................................................................................................... 16</td>
</tr>
<tr>
<td></td>
<td>Real-Time node. .............................................................................................................................. 17</td>
</tr>
<tr>
<td></td>
<td>Web Services node. ........................................................................................................................ 17</td>
</tr>
<tr>
<td></td>
<td>Adapter Instances node. ................................................................................................................ 18</td>
</tr>
<tr>
<td></td>
<td>Server Groups node. ....................................................................................................................... 18</td>
</tr>
<tr>
<td></td>
<td>Profiler Repositories node. .......................................................................................................... 18</td>
</tr>
<tr>
<td></td>
<td>Management node. ........................................................................................................................ 19</td>
</tr>
<tr>
<td></td>
<td>Job Execution History node. ......................................................................................................... 19</td>
</tr>
<tr>
<td></td>
<td>Pages. ............................................................................................................................................ 20</td>
</tr>
<tr>
<td>3.2</td>
<td>Administrator Management. ....................................................................................................... 20</td>
</tr>
<tr>
<td></td>
<td>Managing database account changes. .......................................................................................... 20</td>
</tr>
<tr>
<td></td>
<td>Editing file location object information. ...................................................................................... 23</td>
</tr>
<tr>
<td></td>
<td>Configuring the report server. ...................................................................................................... 23</td>
</tr>
<tr>
<td></td>
<td>Adding Access Servers. ............................................................................................................... 24</td>
</tr>
<tr>
<td></td>
<td>Setting the status interval. ............................................................................................................ 25</td>
</tr>
<tr>
<td></td>
<td>Exporting certification logs. ......................................................................................................... 25</td>
</tr>
<tr>
<td>3.3</td>
<td>Central Repository management. .............................................................................................. 28</td>
</tr>
<tr>
<td></td>
<td>Setting up users and groups. ........................................................................................................ 29</td>
</tr>
<tr>
<td></td>
<td>Viewing reports. ............................................................................................................................. 31</td>
</tr>
<tr>
<td>3.4</td>
<td>Server Groups. ............................................................................................................................. 32</td>
</tr>
<tr>
<td></td>
<td>Server group architecture. ............................................................................................................ 33</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Editing and removing a server group.</td>
<td>36</td>
</tr>
<tr>
<td>Monitoring Job Server status in a server group.</td>
<td>36</td>
</tr>
<tr>
<td>Executing jobs using server groups.</td>
<td>37</td>
</tr>
<tr>
<td>3.5 Batch Jobs.</td>
<td>37</td>
</tr>
<tr>
<td>Executing batch jobs.</td>
<td>38</td>
</tr>
<tr>
<td>Scheduling jobs.</td>
<td>38</td>
</tr>
<tr>
<td>Downloading a debug package.</td>
<td>50</td>
</tr>
<tr>
<td>Monitoring RFC trace logs.</td>
<td>51</td>
</tr>
<tr>
<td>3.6 Real-Time Jobs.</td>
<td>51</td>
</tr>
<tr>
<td>Supporting real-time jobs.</td>
<td>52</td>
</tr>
<tr>
<td>Configuring and monitoring real-time services.</td>
<td>53</td>
</tr>
<tr>
<td>Creating and monitoring client interfaces.</td>
<td>62</td>
</tr>
<tr>
<td>3.7 Real-Time Performance.</td>
<td>67</td>
</tr>
<tr>
<td>Configuring Access Server output.</td>
<td>67</td>
</tr>
<tr>
<td>Service configuration parameters.</td>
<td>69</td>
</tr>
<tr>
<td>Service statistics.</td>
<td>73</td>
</tr>
<tr>
<td>Service provider statistics.</td>
<td>74</td>
</tr>
<tr>
<td>Using statistics and service parameters.</td>
<td>75</td>
</tr>
<tr>
<td>3.8 Profile Server Management.</td>
<td>76</td>
</tr>
<tr>
<td>Defining a profiler repository.</td>
<td>76</td>
</tr>
<tr>
<td>Profiler task parameters.</td>
<td>77</td>
</tr>
<tr>
<td>Monitoring profiler tasks using the Administrator.</td>
<td>79</td>
</tr>
<tr>
<td>3.9 RFC Server Management.</td>
<td>80</td>
</tr>
<tr>
<td>64-bit platform prerequisites.</td>
<td>81</td>
</tr>
<tr>
<td>Adding an RFC server interface.</td>
<td>81</td>
</tr>
<tr>
<td>Starting or stopping an RFC server interface connection.</td>
<td>82</td>
</tr>
<tr>
<td>Monitoring RFC server interfaces.</td>
<td>82</td>
</tr>
<tr>
<td>Removing one or more RFC server interfaces.</td>
<td>84</td>
</tr>
<tr>
<td>3.10 Adapters.</td>
<td>84</td>
</tr>
<tr>
<td>3.11 Support for Web Services.</td>
<td>85</td>
</tr>
<tr>
<td>3.12 Troubleshooting the Administrator.</td>
<td>85</td>
</tr>
<tr>
<td>Reestablishing network connections.</td>
<td>85</td>
</tr>
<tr>
<td>Finding problems.</td>
<td>86</td>
</tr>
<tr>
<td>Error and trace logs.</td>
<td>87</td>
</tr>
<tr>
<td>Resolving connectivity problems.</td>
<td>92</td>
</tr>
<tr>
<td>Restarting the Access Server.</td>
<td>93</td>
</tr>
<tr>
<td>4 Metadata Reports.</td>
<td>95</td>
</tr>
<tr>
<td>4.1 Requirements.</td>
<td>95</td>
</tr>
<tr>
<td>4.2 Repository reporting tables and views.</td>
<td>95</td>
</tr>
<tr>
<td>5 Impact and Lineage Analysis Reports.</td>
<td>97</td>
</tr>
</tbody>
</table>
8.2 Generating documentation for an object ........................................ 121
  Printing Auto Documentation for an object .................................... 121
8.3 Auto Documentation Settings control panel .................................... 122

9 Data Quality Reports ........................................................................ 123
  9.1 Configuring report generation ...................................................... 123
  9.2 Opening and viewing reports ...................................................... 124
  9.3 Lists of available reports .......................................................... 125
  9.4 List of reports by job ............................................................... 126
  9.5 Data Quality Reports Settings control panel ............................... 126
  9.6 Report options ........................................................................ 127
  9.7 Troubleshooting reports ............................................................ 127
  9.8 USA CASS report: USPS Form 3553 ......................................... 128
  9.9 NCOALink Processing Summary Report ..................................... 128
  9.10 Delivery Sequence Invoice report ............................................ 130
       Contents of report ................................................................. 131
  9.11 US Addressing Report ............................................................. 131
       Enabling the report ............................................................... 132
       Percent calculation ............................................................... 132
       Information in the US Addressing report ................................ 132
       DPV sections ........................................................................ 133
       Information in the DSF2 sections .......................................... 133
       LACSLink sections ............................................................... 134
       SuiteLink sections ............................................................... 134
  9.12 DSF2 Augment Statistics Log File ............................................. 135
  9.13 US Regulatory Locking Report ................................................ 135
  9.14 Canadian SERP report: Statement of Address Accuracy .......... 137
  9.15 Australian AMAS report: Address Matching Processing Summary... 137
  9.16 New Zealand Statement of Accuracy (SOA) report .................... 138
  9.17 Address Information Codes Sample report ................................ 138
  9.18 Address Information Code Summary report .............................. 139
  9.19 Address Validation Summary report ........................................ 140
  9.20 Address Type Summary report ............................................... 141
  9.21 Address Standardization Sample report ................................... 141
  9.22 Address Quality Code Summary report .................................... 142
  9.23 Data Cleanse Information Code Summary report ...................... 143
  9.24 Data Cleanse Status Code Summary report .............................. 144
  9.25 Geocoder Summary report ...................................................... 144
9.26 Overview of match reports ................................................. 145
9.27 Best Record Summary report .............................................. 145
9.28 Match Contribution report .................................................. 146
9.29 Match Criteria Summary report .......................................... 148
9.30 Match Duplicate Sample report .......................................... 149
9.31 Match Input Source Output Select report .............................. 149
9.32 Match Multi-source Frequency report ................................... 150
9.33 Match Source Statistics Summary report ............................... 151
1 Introduction

1.1 Welcome to SAP Data Services

1.1.1 Welcome

SAP Data Services delivers a single enterprise-class solution for data integration, data quality, data profiling, and text data processing that allows you to integrate, transform, improve, and deliver trusted data to critical business processes. It provides one development UI, metadata repository, data connectivity layer, run-time environment, and management console—enabling IT organizations to lower total cost of ownership and accelerate time to value. With SAP Data Services, IT organizations can maximize operational efficiency with a single solution to improve data quality and gain access to heterogeneous sources and applications.

1.1.2 Documentation set for SAP Data Services

Become familiar with all the pieces of documentation that relate to your SAP Data Services product.

The latest Data Services documentation can be found on the SAP Help Portal.

Table 1:

<table>
<thead>
<tr>
<th>Document</th>
<th>What this document provides</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter SDK Guide</td>
<td>Information about installing, configuring, and running the Data Services Adapter SDK.</td>
</tr>
<tr>
<td>Administrator Guide</td>
<td>Information about administrative tasks such as monitoring, lifecycle management, security, and so on.</td>
</tr>
<tr>
<td>Configuration Guide for CTS+</td>
<td>System landscape information and detailed steps for CTS+ configuration.</td>
</tr>
<tr>
<td>Customer Issues Fixed</td>
<td>Information about customer issues fixed in this release.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>In some releases, this information is displayed in the Release Notes.</td>
</tr>
<tr>
<td>Designer Guide</td>
<td>Information about how to use Data Services Designer.</td>
</tr>
<tr>
<td>Documentation Map</td>
<td>Information about available Data Services books, languages, and locations.</td>
</tr>
<tr>
<td>Installation Guide for UNIX</td>
<td>Information about and procedures for installing Data Services in a UNIX environment.</td>
</tr>
<tr>
<td>Installation Guide for Windows</td>
<td>Information about and procedures for installing Data Services in a Windows environment.</td>
</tr>
<tr>
<td>Integrator Guide</td>
<td>Information for third-party developers to access Data Services functionality using web services and APIs.</td>
</tr>
<tr>
<td>Document</td>
<td>What this document provides</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Management Console Guide</td>
<td>Information about how to use Data Services Administrator and Data Services Metadata Reports.</td>
</tr>
<tr>
<td>Master Guide</td>
<td>Information about the application, its components and scenarios for planning and designing your system landscape. Information about SAP Information Steward is also provided in this guide.</td>
</tr>
<tr>
<td>Performance Optimization Guide</td>
<td>Information about how to improve the performance of Data Services.</td>
</tr>
<tr>
<td>Reference Guide</td>
<td>Detailed reference material for Data Services Designer.</td>
</tr>
<tr>
<td>Release Notes</td>
<td>Important information you need before installing and deploying this version of Data Services.</td>
</tr>
<tr>
<td>Sizing Guide</td>
<td>Guidelines and recommendations on hardware requirements and software considerations for your implementation.</td>
</tr>
<tr>
<td>Technical Manuals</td>
<td>A compiled, searchable, “master” PDF of core Data Services books:</td>
</tr>
<tr>
<td></td>
<td>● Administrator Guide</td>
</tr>
<tr>
<td></td>
<td>● Configuration Guide for CTS+</td>
</tr>
<tr>
<td></td>
<td>● Designer Guide</td>
</tr>
<tr>
<td></td>
<td>● Reference Guide</td>
</tr>
<tr>
<td></td>
<td>● Management Console Guide</td>
</tr>
<tr>
<td></td>
<td>● Performance Optimization Guide</td>
</tr>
<tr>
<td></td>
<td>● Integrator Guide</td>
</tr>
<tr>
<td></td>
<td>● Supplement for Adapters</td>
</tr>
<tr>
<td></td>
<td>● Supplement for Google BigQuery</td>
</tr>
<tr>
<td></td>
<td>● Supplement for J.D. Edwards</td>
</tr>
<tr>
<td></td>
<td>● Supplement for Oracle Applications</td>
</tr>
<tr>
<td></td>
<td>● Supplement for PeopleSoft</td>
</tr>
<tr>
<td></td>
<td>● Supplement for SAP</td>
</tr>
<tr>
<td></td>
<td>● Supplement for SAP Cloud Platform Big Data Services</td>
</tr>
<tr>
<td></td>
<td>● Supplement for Siebel</td>
</tr>
<tr>
<td></td>
<td>● Workbench Guide</td>
</tr>
<tr>
<td>Text Data Processing Extraction Customization Guide</td>
<td>Information about building dictionaries and extraction rules to create your own extraction patterns to use with Text Data Processing transforms.</td>
</tr>
<tr>
<td>Text Data Processing Language Reference Guide</td>
<td>Information about the linguistic analysis and extraction processing features that the Text Data Processing component provides, as well as a reference section for each language supported.</td>
</tr>
<tr>
<td>Upgrade Guide</td>
<td>Information to help you upgrade from previous releases of Data Services and release-specific product behavior changes from earlier versions of Data Services to the latest release.</td>
</tr>
<tr>
<td>What’s New</td>
<td>Highlights of new key features in this SAP Data Services release. This document is not updated for support package or patch releases.</td>
</tr>
<tr>
<td>Workbench Guide</td>
<td>Provides users with information about how to use the Workbench to migrate data and database schema information between different database systems.</td>
</tr>
</tbody>
</table>

In addition, you may need to refer to several Supplemental Guides.
Table 2:

<table>
<thead>
<tr>
<th>Document</th>
<th>What this document provides</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplement for Adapters</td>
<td>Information about how to install, configure, and use Data Services adapters.</td>
</tr>
<tr>
<td>Supplement for Google BigQuery</td>
<td>Information about interfaces between Data Services and Google BigQuery.</td>
</tr>
<tr>
<td>Supplement for J.D. Edwards</td>
<td>Information about interfaces between Data Services and J.D. Edwards World and J.D. Edwards OneWorld.</td>
</tr>
<tr>
<td>Supplement for Oracle Applications</td>
<td>Information about the interface between Data Services and Oracle Applications.</td>
</tr>
<tr>
<td>Supplement for PeopleSoft</td>
<td>Information about interfaces between Data Services and PeopleSoft.</td>
</tr>
<tr>
<td>Supplement for SAP</td>
<td>Information about interfaces between Data Services, SAP Applications, and SAP NetWeaver BW.</td>
</tr>
<tr>
<td>Supplement for Siebel</td>
<td>Information about the interface between Data Services and Siebel.</td>
</tr>
</tbody>
</table>

We also include these manuals for information about SAP BusinessObjects Information platform services.

Table 3:

<table>
<thead>
<tr>
<th>Document</th>
<th>What this document provides</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information platform services Administrator Guide</td>
<td>Information for administrators who are responsible for configuring, managing, and maintaining an Information platform services installation.</td>
</tr>
<tr>
<td>Information platform services Installation Guide for UNIX</td>
<td>Installation procedures for SAP BusinessObjects Information platform services on a UNIX environment.</td>
</tr>
<tr>
<td>Information platform services Installation Guide for Windows</td>
<td>Installation procedures for SAP BusinessObjects Information platform services on a Windows environment.</td>
</tr>
</tbody>
</table>

1.1.3 Accessing documentation from the Web

You can access the complete documentation set for SAP Data Services from the SAP Business Users Support site.

To do this, go to http://help.sap.com/bods.

You can view the PDFs online or save them to your computer.

1.1.4 SAP information resources

A list of information resource links.

A global network of SAP technology experts provides customer support, education, and consulting to ensure maximum information management benefit to your business.

Useful addresses at a glance:
Table 4:

<table>
<thead>
<tr>
<th>Address</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Support, Consulting, and Education services <a href="http://service.sap.com/">http://service.sap.com/</a></td>
<td>Information about SAP Business User Support programs, as well as links to technical articles, downloads, and online discussions.</td>
</tr>
<tr>
<td>SAP Data Services Community Network <a href="http://scn.sap.com/community/data-services">http://scn.sap.com/community/data-services</a></td>
<td>Get online and timely information about SAP Data Services, including forums, tips and tricks, additional downloads, samples, and much more. All content is to and from the community, so feel free to join in and contact us if you have a submission.</td>
</tr>
<tr>
<td>EIM Wiki page on SCN <a href="http://wiki.sdn.sap.com/wiki/display/EIM/EIM+Home">http://wiki.sdn.sap.com/wiki/display/EIM/EIM+Home</a></td>
<td>The means with which to contribute content, post comments, and organize information in a hierarchical manner to so that information is easy to find.</td>
</tr>
<tr>
<td>Product Availability Matrix (PAM) <a href="https://apps.support.sap.com/sap/support/pam/">https://apps.support.sap.com/sap/support/pam/</a></td>
<td>Information about supported platforms for SAP Data Services with a search function to quickly find information related to your platform.</td>
</tr>
<tr>
<td>Blueprints <a href="https://wiki.sdn.sap.com/wiki/display/EIM/SAP+Data+Services+Blueprints">https://wiki.sdn.sap.com/wiki/display/EIM/SAP+Data+Services+Blueprints</a></td>
<td>Blueprints for you to download and modify to fit your needs. Each blueprint contains the necessary SAP Data Services project, jobs, data flows, file formats, sample data, template tables, and custom functions to run the data flows in your environment with only a few modifications.</td>
</tr>
</tbody>
</table>

1.2 Overview of this guide

1.2.1 About this guide

An overview of the information in this guide and brief descriptions of SAP Data Services Management Console applications and the Data Services operations that it administers.

This guide contains detailed information about Management Console applications and how to use them.

Management Console contains a collection of Web-based applications for administering the following Data Services features and objects:

- Jobs and services executions
- Object relationship analysis
- Job execution performance evaluation
- Data validity
- Data quality report generation
Install the Management Console on a separate computer from other Data Services components. Management Console runs on your Web application server. Management Console is written in Java and uses a JDBC connection to repositories.

The following table contains Management Console applications and descriptions.

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Manage your production environment including batch job execution, real-time services, web services, adapter instances, server groups, central repositories, profiler repositories, and more.</td>
</tr>
<tr>
<td>Impact and Lineage Analysis</td>
<td>Analyze the end-to-end impact and lineage for source and target objects used within the Data Services local repository.</td>
</tr>
<tr>
<td>Operational Dashboard</td>
<td>View dashboards that provide at-a-glance statistics, status, and performance of your job executions for one or more repositories over a given time period.</td>
</tr>
<tr>
<td>Data Validation Dashboard</td>
<td>Evaluate the reliability of your target data based on the validation rules you created in your batch jobs. Quickly review, assess, and identify potential inconsistencies or errors in source data.</td>
</tr>
<tr>
<td>Auto Documentation</td>
<td>View, analyze, and print graphical representations of all objects as depicted in the Designer including their relationships, properties, and more.</td>
</tr>
<tr>
<td>Data Quality Reports</td>
<td>View and export reports for batch and real-time jobs, such as job summaries and data quality transform reports.</td>
</tr>
</tbody>
</table>

1.2.2 Who should read this guide

This and other SAP Data Services documentation assume the following:

- You are an application developer, consultant or database administrator working on data extraction, data warehousing, data integration, or data quality.
- You understand your source and target data systems, DBMS, legacy systems, business intelligence, and messaging concepts.
- You understand your organization’s data needs.
- You are familiar with SQL (Structured Query Language).
- If you are interested in using this software to design real-time processing, you are familiar with:
  - DTD and XML Schema formats for XML files
  - Publishing Web Services (WSDL, REST, HTTP/S and SOAP protocols, etc.)
- You are familiar with SAP Data Services installation environments: Microsoft Windows or UNIX.
2 Logging into the Management Console

When you log in to the Management Console, you must log in as a user defined in the Central Management Server (CMS). The first time you log into the Management Console, use the default user name and password (admin/admin). It’s recommended that you change the defaults thereafter by updating user roles in the Administrator.

1. Open a web browser, enter the following case-sensitive URL, and then press Enter:
   
   http://<hostname>:28080/DataServices

   where <hostname> is the name of the computer hosting the web application server.

<table>
<thead>
<tr>
<th>i Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are logged in to the Designer, you can also access the Management Console home page in several ways.</td>
</tr>
</tbody>
</table>

   Table 6:
<table>
<thead>
<tr>
<th>From</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start page</td>
<td>Data Services Management Console</td>
</tr>
<tr>
<td>Tools menu</td>
<td>Data Services Management Console</td>
</tr>
<tr>
<td>Toolbar icon</td>
<td>Data Services Management Console</td>
</tr>
</tbody>
</table>

2. Enter your user credentials for the CMS.

   Table 7:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>Specify the server name and optionally the port for the CMS.</td>
</tr>
<tr>
<td>User name</td>
<td>Specify the user name to use to log into CMS.</td>
</tr>
<tr>
<td>Password</td>
<td>Specify the password to use to log into the CMS.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Specify the authentication type used by the CMS.</td>
</tr>
</tbody>
</table>

3. Click Log on.

   The software attempts to connect to the CMS using the specified information. When you log in successfully, the list of local repositories that are available to you is displayed.

2.1 Management Console navigation

The Management Console contains links to various applications that help you manage all aspects of SAP Data Services. Click the application name to open the application.

After you open an application, the name of that application displays under the Management Console banner at the top of the screen. There is a navigation tree along the left of the screen under the banner, that lists the option
categories (as nodes) for the application. Choose a node from the navigation tree, and the right side of the screen displays the related options. Sometimes there is more than one tab to choose from in the right side of the screen.

The upper-right side of the main window for each application includes helpful links based on the application that is open. The links vary based on the application that you have open. The following table describes the links that can appear.

Table 8:

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Click to return to the Management Console home page where you can select another application, for example.</td>
</tr>
<tr>
<td>Settings</td>
<td>Click to open a dialog box for changing a variety of options depending on the selected application.</td>
</tr>
<tr>
<td>Logout</td>
<td>Click to exit the Management Console application and Data Services software, and display the log in page.</td>
</tr>
<tr>
<td>Question mark icon</td>
<td>Click to open the Documentation Map, which lists the SAP Data Services technical documentation available to end users or administrators, and a link to the customer portal where you can find the latest versions of the documentation.</td>
</tr>
</tbody>
</table>

Your Management Console session times out after 120 minutes (2 hours) of inactivity.
This section describes the Administrator and how to navigate through its browser-based, graphical user interface.

Use the Administrator to:

- Set up users and their roles
- Add connections to Access Servers and repositories
- Access job data published for Web Services
- Schedule and monitor batch jobs
- Configure and monitor:
  - Access Server status
  - Real-time services
  - Client interfaces including SAP application client interfaces (to read IDocs) and message traffic moving in and out of an Access Server
  - Adapter instances (a prerequisite for creating adapter datastores)

Additionally, you use the tools under the Promotion Management node to configure options to transport Data Services objects from one system to another. For example, to export changes from a development system to a test system. For more information about lifecycle management, including promotion management, see the Administrator Guide. If you have a Change Transport System (CTS) installed in an SAP NetWeaver or SAP Solution Manager environment, you can use CTS+ to transport Data Services objects. For more information, see the SAP Data Services Configuration Guide for CTS+.

Related Information

Logging into the Management Console [page 12]
Administrator navigation [page 14]

3.1 Administrator navigation

Set up administrative aspects of Data Services such as users, user permissions, access servers, repositories, schedules, and so on.

The navigation tree on the left side of the Administrator screen contains nodes that you can expand to make related settings. The options for each chosen node appear on the right side of the screen. The right portion of the screen may contain one or more tabs based on the node that you choose.

The navigation tree nodes contain options related to the user’s permissions. Therefore not all nodes appear for all users. For example, the Profiler Repositories node only appears if the user has permission to view or manage a profiler repository. An administrator sets user permissions in the Central Management Console (CMC).

Possible nodes that appear in the navigation tree are:
• Status
• Batch
• Real-Time
• Web Services
• Adapter Instances
• Server Groups
• Profiler Repositories
• Management
• Job Execution History

3.1.1 Status node

Displays status indicators and detailed information about aspects of your jobs.

The Status page displays red, yellow, and green status icons that indicate the overall status of your batch and real-time jobs, associated access servers, adapter and profiler repositories jobs, services, and other related systems. You can drill down into the information for more details. The following options appear as column headings in the Status page.

Table 9:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Batch</strong></td>
<td>Contains repository names that are associated with the Job Server on which you run your batch jobs. To see batch jobs status, connect the repository to the Administrator.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>The repository must be connected to the Management Console Administrator before you can view it here.</td>
</tr>
<tr>
<td></td>
<td>Click the repository name listed under the Batch column to display a list of batch jobs and the status for each.</td>
</tr>
<tr>
<td><strong>Real-Time</strong></td>
<td>Contains Access Server names associated with the real-time service. To see real-time jobs status, connect the Access Server to the Administrator.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>The Access Server must be connected to the Management Console Administrator before you can view it here.</td>
</tr>
<tr>
<td></td>
<td>Click the Access Server name listed under the Real-Time column to display a list of services and related client interfaces.</td>
</tr>
</tbody>
</table>
### 3.1.2 Batch node

The **Batch** node contains job status, job configuration, and repository schedule information.

After you add at least one repository connection to the Administrator, you can expand the **Batch** node and view a repository Batch Job Status page.

Click the **All Repositories** option to see jobs in all repositories connected to this Administrator. (The **All Repositories** node appears only when you have more than one repository connected).

Each repository under the **Batch** node includes the following tabs.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Job Status</td>
<td>View the status of the last execution and in-depth information about each job.</td>
</tr>
<tr>
<td>Batch Job Configuration</td>
<td>Configure execution and scheduling options for individual jobs.</td>
</tr>
<tr>
<td>Repository Schedules</td>
<td>View and configure schedules for all jobs in the repository.</td>
</tr>
</tbody>
</table>

There is a **Delete** button in the **Batch** node that deletes the selected job as well as the history and log files. If you intend to create reports based on specific jobs, transforms, time periods, and job statistics, or if you need information to create regulatory or certified reports, you should create a local backup copy of the tables or log files before you delete.
Related Information

Batch Jobs [page 37]

3.1.3 Real-Time node

After you add a connection to an Access Server in the Administrator, you can expand the Real-Time node. Expand an Access Server name under the Real-Time node to view the options.

Table 11:

<table>
<thead>
<tr>
<th>Access Server node options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>View status of real-time services and client interfaces supported by this Access Server, Control, restart, and set a service provider interval for this Access Server.</td>
</tr>
<tr>
<td>Real-time Services</td>
<td>View status for services and service providers, start and stop services, add or remove a service, configure Job Servers for a service.</td>
</tr>
<tr>
<td>Client Interfaces</td>
<td>View status for client interfaces, start and stop interfaces, add or remove an interface.</td>
</tr>
<tr>
<td>Logs - Current</td>
<td>View list of current Access Server logs, content of each log, clear logs, configure content of logs for display, enable or disable tracing for each Access Server.</td>
</tr>
<tr>
<td>Logs - History</td>
<td>View list of historical Access Server logs, view content of each log, delete logs.</td>
</tr>
</tbody>
</table>

Related Information

Real-Time Jobs [page 51]
Real-Time Performance [page 67]

3.1.4 Web Services node

Use this node to select real-time and batch jobs that you want to publish as Web service operations and to monitor the status of those operations. You can also use the node to set security for jobs published as Web service operations and view the WSDL file that SAP Data Services generates.

Related Information

Support for Web Services [page 85]
3.1.5 Adapter Instances node

Use this node to configure a connection between SAP Data Services and an external application by creating an adapter instance and dependent operations. This is a prerequisite requirement for creating a datastore for adapters in the Designer.

After you create a datastore, import data through the adapter and create jobs. Then use this node to view the status of Adapter instances. Options are listed by Job Server under the Adapter Instance node.

Related Information

Adapters [page 84]

3.1.6 Server Groups node

The Server Groups node allows you to group Job Servers that are associated with the same repository into a server group.

Use a server group if you want SAP Data Services to automatically use the Job Server on a computer with the lightest load when a batch job is executed. This functionality improves load balancing (throughput) in production environments and also provides a hot backup method. When a job is launched, if a Job Server is down, another Job Server in the same group executes the job.

Related Information

Server Groups [page 32]

3.1.7 Profiler Repositories node

After you connect a profiler repository to the Administrator, you can expand the Profiler Repositories node. Click a repository name to open the Profiler Tasks Status page.

Related Information

Profile Server Management [page 76]
3.1.8 Management node

The Management node contains the configuration options for the Administrator application. Before you can use some features of the Administrator, you must add connections to other SAP Data Services components using the Management node. For example, expand the management node and:

- Expand **Datastore** and click a repository to manage datastore configurations for that repository.
- Click **Access Servers** to add a connection to your Access Servers (for real-time jobs).

Related Information

**Administrator Management** [page 20]

3.1.9 Job Execution History node

Contains execution history for a job or data flow.

When you expand the Job Execution History node, the following information may be available as applicable:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Execution History</td>
<td>You can view execution history for a single batch job or for all batch jobs.</td>
</tr>
<tr>
<td></td>
<td>You can refine the history by selecting to view reports that were generated</td>
</tr>
<tr>
<td></td>
<td>between a specific start and end date.</td>
</tr>
<tr>
<td></td>
<td>The information for the selected batch job appears in a table. This table dis-</td>
</tr>
<tr>
<td></td>
<td>plays the repository name, job name, the start and end time of the job execu-</td>
</tr>
<tr>
<td></td>
<td>tion, the execution time (elapsed), the status, and whether the job is associ-</td>
</tr>
<tr>
<td></td>
<td>ated with a system configuration.</td>
</tr>
<tr>
<td></td>
<td>• Under the Job information column, click the <strong>Trace, Monitor, or Error</strong> link</td>
</tr>
<tr>
<td></td>
<td>to open the Log Viewer page, which displays the logs associated with the job.</td>
</tr>
<tr>
<td></td>
<td>Click the other tabs in the Log Viewer page to view the other types of logs.</td>
</tr>
<tr>
<td></td>
<td>• Click the <strong>Performance Monitor</strong> link under the Job information column to</td>
</tr>
<tr>
<td></td>
<td>open the Performance Monitor page.</td>
</tr>
</tbody>
</table>
### Tab Description

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Flow Execution History</td>
<td>This page includes three options for customizing the display:</td>
</tr>
</tbody>
</table>
|                                  |   - *Data Flow*: Enter a data flow name for which to search and click *Search*.
|                                  |   - *Job Name*: Select all jobs or an individual job.                        |
|                                  |   - *View history for x days*: Select over how many days you want to view the history |
| Related information appears in a table. This table displays the repository name, data flow name, job name, the start and end time of the data flow execution, the execution time (elapsed), and the number of rows extracted and loaded. |

### 3.1.10 Pages

Each node that you expand on the left opens a page on the right that displays information relating to the node that you have selected.

The top of the page indicates the currently selected node. If applicable, a page contains tabs that you can use to navigate further into the node. For example, the Batch node page contains the tabs: Batch Job Status, Batch Job Configuration, and Repository Schedules.

The tabs names appear on light blue tabs. A dark blue (shaded) tab signifies the active page. Click a light blue tab to go to that page. Some pages do not include tabs.

As you drill into various pages, a “bread crumb” trail often indicates where you are in the Administrator application. In some pages, you can click on the bread crumb links to navigate to a different page.

### 3.2 Administrator Management

Use the Management features to configure the Administrator.

#### 3.2.1 Managing database account changes

SAP Data Services uses several types of user accounts and associated passwords. For various reasons, database account parameters such as user names or passwords change. For example, perhaps your company’s compliance and regulations policies require periodically changing account passwords for security.
3.2.1.1 Updating local repository login parameters

If the login information, particularly the password, for a repository has changed, SAP Data Services provides an optional password file that all schedules or exported execution commands use. In other words, the software uses this password file to store and update connection information in one location that multiple schedules or exported execution commands share for that repository.

**Note**

This description does not apply to central repositories.

The password file:

- Specifies the connection information for the repository.
- Can be stored in a central location for access by others who run jobs in that repository.
- Is created when you create or update a job schedule to minimize associated maintenance.

**Related Information**

Using a third-party scheduler [page 45]

3.2.1.1.1 Updating the CMS connection information and use a password file

1. Expand the **Management** node.
2. Click **CMS Connection**.
3. Edit the connection information as necessary.
4. Click **Apply**.
5. Click **Generate password file** to create or update the password file.
   
   The default name and location of the file are `<DS_COMMON_DIR>\conf\repositoryname.txt`.

3.2.1.1.2 Updating job schedules

When database account information for your repository changes, the SAP Data Services job schedules associated with that account must also be updated. When you use a password file, the job schedules access it at runtime to automatically retrieve the updated account information.
3.2.1.2 Updating datastore connection parameters

If the information associated with a datastore connection changes, particularly passwords, you can update the changes using the Administrator.

**Note**
Only users with Administrator role privileges can edit datastore parameters.

3.2.1.2.1 Editing the connection information for an individual configuration in a datastore

1. Select Management > Datastore, and select the repository that contains the datastore configuration that you want to edit.
2. Click the configuration name to configure.
3. Edit the enabled fields as necessary.
4. Click Apply. To return all fields to the last set of values applied, click Reset.

3.2.1.2.2 Editing the connection information for multiple configurations in a datastore

1. Select Management > Datastore, and select the repository that contains the datastore configurations that you want to edit.
2. Click the datastore name to configure.
   All configurations for that datastore display.
3. Edit the enabled fields as necessary.
   Click More to display the page for that individual configuration, which includes more options specific to it.
4. Click Apply. To return all fields to the last set of values applied, click Reset.
3.2.2 Editing file location object information

Edit a file location object configuration to change current settings like host, port, user, password, remote and local directories.

1. Select Management > File Locations.
2. Select the repository that contains the file location object configuration to edit.
3. Click the File location and configuration name to edit.
4. Edit the enabled fields as necessary.

**i Note**
You cannot change the Name, Type, or Protocol options.

5. Click Apply.

3.2.3 Configuring the report server

For each repository registered in the Central Management Console (CMC), a report server configuration is automatically created with default parameters. The Report Server Configuration node in the Management Console Administrator lets you edit the default parameters, including the location where job reports are written upon execution.

1. Select Management > Report Server Configuration > <repository>.
   The Report Server Configuration page opens and displays the report export configuration parameters. If the configuration has not yet been saved for the selected repository, the page displays default parameters.
2. Enter the appropriate configuration information.

Table 13:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host name</td>
<td>The name of the machine that the report server is running on. By default, the current web application server name is used. Localhost is not a valid name.</td>
</tr>
<tr>
<td>Communication port</td>
<td>The port number of the machine that the report server is running on.</td>
</tr>
<tr>
<td>Export location</td>
<td>The path where the reports will be exported to. The default path is &lt;DS_COMMON_DIR&gt;/DataQuality/reports. Upon execution, the repository name and job name folders are appended to the path. If the Overwrite option is not selected, a run ID folder is also appended to the path.</td>
</tr>
</tbody>
</table>

**i Note**
If you export reports to a location other than a local drive, such as a network drive, before you execute the job you must start the web application server with an account that has access rights to that location.

Export type          | The format in which the reports can be exported (PDF or RTF). |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwrite</td>
<td>Specifies whether existing reports will be overwritten when the reports are exported. If this option is not selected, the reports are exported to a subfolder with the run ID, which specifies a unique identification of an instance of the executed job.</td>
</tr>
<tr>
<td>Language</td>
<td>The supported language that the reports are generated in. Note that some reports, such as country-specific certification reports, are designed only to support English, so changing the option for those reports has no effect.</td>
</tr>
</tbody>
</table>

3. Click **Apply** to save the configuration. To return all fields to the last set of values applied, clicking **Reset**.

4. Verify that the security setting for this operation is disabled. Select **Administrator** ➤ **Web Services** and click the **Web Services Configuration** tab. If the Export_DQReport operation is enabled (displays a check in the Session Security column), select the checkbox next to it, select **Disable Session Security** from the pull-down menu, and click the **Apply** button.

To generate and export all of the job reports to the specified location at runtime, select the Export Data Quality Reports option when you execute the job.

**Related Information**

Adding a job schedule [page 39]

### 3.2.4 Adding Access Servers

The Administrator acts as a front end for Access Servers connected to it. Use the Administrator to:

- Configure real-time jobs as real-time services.
- Configure real-time services with service providers.
- Monitor Access Servers, real-time services, and service providers.

You first must connect an Access Server to the Administrator so that you can use the Administrator to create a real-time service from a real-time job. After a service starts, the Access Server brokers messages between external applications and SAP Data Services.

When a message request comes in, the Access Server communicates with the Job Server to get the repository data needed to run a real-time service and process the message. A reply comes back through the Access Server to the message originator and the Access Server log records the event, which you can monitor from the Administrator.

Use the Access Servers page to connect an Administrator to a repository.

1. Select **Management** ➤ **Access Servers** ➤ .
2. Click **Add**.
3. Enter the following information.
Table 14:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine Name</td>
<td>Host name of the computer on which the Access Server is installed.</td>
</tr>
<tr>
<td>Communication Port</td>
<td>Port assigned to the Access Server in the Server Manager utility.</td>
</tr>
</tbody>
</table>

4. (Optional) Before attempting to register the Access Server with the Administrator, click *Ping* to see if the Access Server is available and exists on the computer and port you specified.

5. Click *Apply*.

The Administrator registers the Access Server, validates the Access Server connection information, and displays the information on the Access Servers page.

To view a list of Access Servers connected to the Administrator, select *Management > Access Servers*.

The Access Servers page lists the Access Servers that are connected to the Administrator. You can also remove a connection to an Access Server from this page.

3.2.5 Setting the status interval

Use the Status Interval page to specify the time period for which the Administrator displays the status (using the red, yellow, and green status icons) on the Batch Job Status page and the Real-Time History page.

1. Select *Management > Status Interval*.

2. On the Status Interval page, specify the time period.

   You can filter the information for Batch and Real-time jobs in the following ways:
   
   - By the last execution of each job
   - By number of days

   **Note**
   
   The default for Real-Time Display is 5 days.

   - By range of dates

3. Click *Apply*.

   The Administrator updates the list of job executions and the status interval displays on the Batch Job Status page and the Real-Time History page.

3.2.6 Exporting certification logs

When you run address cleanse jobs with the appropriate options set, you can generate reports to qualify for mailing discounts with certain countries' postal authorities. In the Management Console, you can generate the certification log files required for those certifications.

The Certification Logs page is available to users who are assigned either the Administrator or Operator role.
3.2.6.1 Exporting NCOALink certification logs

Before you export the certification log, you must have run a job containing a USA Regulatory Address Cleanse transform with the NCOA certification options set appropriately. You must also configure your repository in the Central Management Console (CMC).

You can export the certification log for the data in one repository or in all repositories.

**Caution**

If you select all repositories and have more than one connection to the same repository, your results may contain duplicate records.

1. Select [Management > Certification Logs](#) and select the repository that contains the certification log that you want to export.
2. Click the NCOALink tab.
3. Select the date range that contains the data that you want to export.
4. Specify the location where the certification logs will be exported. Select the NCOALink licensee ID for the logs that you want to export, or select All NCOA Licensee IDs.

**Note**

The location that you specify is relative to the web application server.

To reset the export location to the default, click the Reset button. The default location is `<DS_COMMON_DIR>\DataQuality\certifications\CertificationLogs\<repository>`.

6. If you want to overwrite an existing log file, click the Overwrite option.
7. Click the Search button. The page displays the available log files with the specified criteria. You can sort the log files using the column headers.

The Data Available column has a Yes status when there is data for at least one of the log types (PAF, Bala, or CSL). A No status indicates that no data is available and will result in an empty log file for each type.

8. Select the log file(s) that you want to export or select the checkbox next to Select All.
9. Click the Export button.

After the log file is exported, a confirmation message is displayed at the top of the page.
3.2.6.2 Exporting New Zealand SOA certification logs

Before you export the certification log, you must have run a job containing a Global Address Cleanse transform with the New Zealand SOA certification options set appropriately. You must also configure your repository in the CMC.

You can export the certification log for the data in one repository or in all repositories.

![Caution]

If you select all repositories and have more than one connection to the same repository, your results may contain duplicate records.

1. Select Management Certification Logs, and select the repository that contains the certification log that you want to export.
2. Click the New Zealand SOA tab.
3. Select whether you want to export all certification log data that is in the selected repository or just the data within a specified date range.
   - The Year list contains the current year and the two previous years, because certification logs are required to be retained for two years.
4. Specify the location where the certification logs will be exported.
   - The default location is `<DS_COMMON_DIR>\DataQuality\certifications\CertificationLogs\<repository>\`. To reset the export location to the default, click the Reset button.
5. If you want to overwrite an existing log file, click the Overwrite option.
6. Click the Export button.
   - After the log file is exported, a confirmation message is displayed at the top of the page.

Related Information

New Zealand Statement of Accuracy (SOA) report [page 138]

3.2.6.3 Exporting DSF2 certification log

Before you export the certification log, you must have run a job containing a USA Regulatory Address Cleanse transform with the DSF2 certification options set appropriately. You must also configure your repository in the Central Management Console (CMC).

You can export the certification log for the data in one repository or in all repositories.
Caution

If you select all repositories and have more than one connection to the same repository, your results may contain duplicate records.

1. Open the Data Services Management Console.
2. Click the Administrator icon.
3. Select Management > Certification Logs, and select the repository that contains the certification log that you want to export.
4. Click the DSF2 tab.
5. Select the date range that contains the data that you want to export.
6. Select the DSF2 licensee ID drop list and select the logs that you want to export, or select All DSF2 Licensee IDs.
7. Specify the location where the certification logs will be exported.

Note

The location that you specify is relative to the web application server.

To reset the export location to the default, click the Reset button. The default location is <DS_COMMON_DIR>DataQuality\certifications\CertificationLogs\<repository>\.

8. If you want to overwrite an existing log file, click the Overwrite option.
9. Click the Search button. The page displays the available log files with the specified criteria. You can sort the log files using the column headers.
   The Data Available column has a Yes status when there is data for the log file. A No status indicates that no data is available and will result in an empty log file.
10. Select the log file(s) that you want to export or select the checkbox next to Select All.
11. Click the Export button.
   After the log file is exported, a confirmation message is displayed at the top of the page.

Related Information

US Addressing Report [page 131]

3.3 Central Repository management

This section describes how to manage your secure central repositories using the Administrator.

When you log into the Management Console as a user with the appropriate rights, the name of each secure central repository appears under the Central Repositories node. Links under this node include:

- Users and groups
  Use to add, remove, and configure users and groups for secure object access.
3.3.1 Setting up users and groups

The general process for setting up secure central repository users and groups is as follows:

1. Register the secure central repository in the Central Management Console (CMC).
2. Add central repository groups.
3. Associate users with groups.

The following sections describe these procedures.

3.3.1.1 Adding a group to a central repository

Groups are specific to a secure central repository and are not visible in any other local or central repository.

1. Expand the Central Repositories node in the navigation tree and expand the repository to configure.
2. Click Users and Groups.
   The Groups and Users page displays.
3. On the Groups tab, click Add.
4. Type a Name for the group.
5. Optionally, type a Description for the group.
6. Click Apply.

The group appears on the Groups tab.

3.3.1.2 Adding users

1. Expand the Central Repositories node in the navigation tree and expand the repository to configure.
2. Click Users and Groups.
   The Groups and Users page displays.
3. Click the Users tab.
4. Click Add.
   On the Add/Edit User page, enter the following information.
Table 15:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>Select the user to add to the group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>The list of available users includes all users defined in the Central</td>
</tr>
<tr>
<td></td>
<td>Management Console (CMC).</td>
</tr>
<tr>
<td>Default group</td>
<td>The default central repository group to which the user belongs. You can</td>
</tr>
<tr>
<td></td>
<td>change the default by selecting another from the drop-down list.</td>
</tr>
<tr>
<td>Status</td>
<td>Select a value from the drop-down list:</td>
</tr>
<tr>
<td></td>
<td>○ <strong>Active</strong></td>
</tr>
<tr>
<td></td>
<td>Enables the user’s account for normal activities.</td>
</tr>
<tr>
<td></td>
<td>○ <strong>Suspended</strong></td>
</tr>
<tr>
<td></td>
<td>Select to disable the login for that user.</td>
</tr>
<tr>
<td>Description</td>
<td>Optionally, type a description for the user.</td>
</tr>
</tbody>
</table>

The User is a member of list on the left shows the groups to which this user belongs.

5. Click **Apply**.

Clicking **Reset** returns all fields to the last set of values applied.

### 3.3.1.3 Adding or removing a user from a group

1. Expand the **Central Repositories** node in the navigation tree and expand the repository to configure.
2. Click **Users and Groups**.
3. Click the **Group** tab.
4. Click the group name.
5. The Members list on the left shows the users in this group.

To add users to a group, click the user names from the Not Members list and click **Add Users**. Select multiple user names using the Ctrl or Shift keys.

To remove a user from the group, select a user name from the Members list and click **Remove Users**. Select multiple user names using the Ctrl or Shift keys.

6. Click **Apply**.

Clicking **Reset** returns all fields to the last set of values applied.

Alternately, click the **Users** tab, click the user name, and associate the user with one or more groups by selecting group names and adding or removing them.
3.3.1.4 Deleting a group

1. Expand the Central Repositories node in the navigation tree, expand the repository to configure, and click Users and Groups.
2. Click the Group tab.
3. Select the check box for the group.
4. Click Remove.

**Note**

You cannot delete a group in the following instances:

- It is the default group for any user (whether or not they are active).
- It is the only group with full permissions for an object.
- A member of the group is undertaking any central repository tasks using the Designer.

3.3.2 Viewing reports

You can generate reports about objects in a central repository such as which objects a user currently has checked out or the changes made to an object over a specified time frame.

Expand the central repository to view and expand the Reports link.

**Related Information**

Object state report [page 31]
Change report [page 32]

3.3.2.1 Object state report

Use the object state report to view details on one or more objects such as whether the objects are checked out and by whom.

Click the Object State Report link to display a search page with the following criteria (all fields are optional):

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Object name</strong></td>
<td>Type an object name. You can use the % symbol as a wildcard.</td>
</tr>
<tr>
<td><strong>Object type</strong></td>
<td>For example select Batch job, Table, or Stored procedure.</td>
</tr>
<tr>
<td><strong>State</strong></td>
<td>For example select Checked out.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>User</td>
<td>Select a central repository user name.</td>
</tr>
</tbody>
</table>

Click **Search** to generate the report. The report has the following columns:

- **Object name**
- **Object type**
- **State**
- **User name**—The user account associated with the check-out or check-in.
- **Associated repository**—The repository to which the object belongs.
- **Time**—Check-out or check-in date and time.
- **Comments**—Comments added when user checked out or checked in the object.

Click the object name to display the object’s history.

### 3.3.2.2 Change report

Use the change report to view the change history for an object over a specified period of time.

Click the **Change Report** link to display a search page with the following criteria:

- **Start date**—Enter a date or click the calendar icon to select a start date.
- **End date**—Enter a date or click the calendar icon to select an end date.
- **Object type**—Optionally select an object type; for example batch job, table, or stored procedure.
- **State**—Optionally select an object state; for example Checked out.
- **User**—Optionally select a central repository user name.

Click **Search** to generate the report. The report has the following columns:

- **Object name**
- **Object type**
- **State**
- **Version**—The version number of the object.
- **User name**—The user account associated with the check-out or check-in.
- **Associated repository**—The repository to which the object belongs.
- **Time**—Check-out or check-in date and time.
- **Comments**—Comments added when user checked out or checked in the object.

### 3.4 Server Groups

Use the Administrator to create and maintain server groups.

This section describes how to work with server groups.
### 3.4.1 Server group architecture

You can group Job Servers on different computers into a logical SAP Data Services component called a server group. A server group automatically measures resource availability on each Job Server in the group and distributes scheduled batch jobs to the Job Server with the lightest load at runtime.

There are two rules for creating server groups:

- All the Job Servers in an individual server group must be associated with the same repository, which must be defined as a default repository. The Job Servers in the server group must also have:
  - Identical SAP Data Services versions
  - Identical database server versions
  - Identical locale
- Each computer can only contribute one Job Server to a server group.

The requirement that all Job Servers in a server group be associated with the same repository simply allows you to more easily track which jobs are associated with a server group. It is recommended that you use a naming convention for server groups that includes the name of the repository. For example, for a repository called DEV, a server group might be called `SG_DEV`.

On startup, all Job Servers check the repository to find out if they must start as part of a server group.

Compared to normal Job Servers, Job Servers in a server group each:

- Collect a list of other Job Servers in their server group
- Collect system load statistics every 60 seconds:
  - Number of CPUs (on startup only)
  - Average CPU load
  - Available virtual memory
- Service requests for system load statistics
- Accept server group execution requests
3.4.1.1 Load balance index

All Job Servers in a server group collect and consolidate system load statistics and convert them into a load balance index value for each Job Server. A Job Server’s load balance index value allows the software to normalize statistics taken from different platforms. The Job Server with the lowest index value is selected to execute the current job. The software polls all Job Server computers every 60 seconds to refresh the load balance index.

3.4.1.2 Job execution

After you create a server group, you can select a server group to execute a job from the Designer’s Execution Properties window or from the Execute Batch Job, Schedule Batch Job, and Export Batch Job pages in the Administrator.

When you execute a job using a server group, the server group executes the job on the Job Server in the group that is running on the computer that has the lightest load. The Administrator will also resynchronize a Job Server with its repository if there are changes made to the server group configuration settings.

You can execute parts of your job on different Job Servers in a server group. You can select the following distribution levels from the Designer’s Execution Properties window or from the Execute Batch Job, Schedule Batch Job, and Export Execution Command pages in the Administrator:

- **Job level**
  A job can execute on an available Job Server.
- **Data flow level**
  Each data flow within a job can execute on an available Job Server.
- **Sub data flow level**
  A resource-intensive operation (such as a sort, table comparison, or table lookup) within a data flow can execute on an available Job Server.

3.4.1.3 Job launcher

The Job Launcher, exported as part of a job’s execution commands, includes a specific command line option for server groups. You can use this option to change the Job Servers in a server group.

Related Information

About the job launcher [page 49]
3.4.1.4 Working with server groups and Designer options

Some Designer options assume paths are relative to a Job Server. If your Job Servers are on different machines from your Designer (typically the case in a production environment) you must ensure that connections and directory paths point to the Job Server host that will run the job. Such options include:

- Source and target directories for files
- Bulk load directories
- Source and target connection strings to databases
- Path to repositories

When using server groups consider the additional layer of complexity for connections. For example, if you have three Job Servers in a server group:

- Use the same directory structure across your three host computers for source and target file operations and use relative paths for file names.
- Use the same connection strings to your databases for all three Job Server hosts.

If you use job distribution levels, the Job Servers in the server group must have:

- Identical SAP Data Services versions
- Identical database server versions
- Identical locale
- Identical operating systems

Thoroughly test the Job Server job options when working with server groups.

Adding a server group:

- In the Administrator, use the Server Groups node to create and add a server group.

3.4.1.4.1 Adding a server group

1. Select Server Groups All Server Groups.
2. Click the Server Group Configuration tab.
3. Click Add.
4. Follow the instructions on the Add Server Group page to create a server group.
   - When you select a repository, all Job Servers registered with that repository display. You can create one server group per repository.
   - Notice that the Administrator provides a default server group name. It is the name of your repository with the prefix SG_ (for server group). You can change the default name, however, labeling a server group with the repository name is recommended.
   - One Job Server on a computer can be added to a server group. Use the Host and Port column to verify that the Job Servers you select are each installed on a different host.
5. After you select the Job Servers for a server group, click Apply.

The display returns to the Server Group Configuration page.
3.4.2 Editing and removing a server group

You can select a new set of Job Servers for an existing server group or remove a server group.

Trace messages are written for a change in Job Server status when you create, edit, or remove server groups.

- When a Job Server is upgraded to membership in a server group, the trace message is:
  Collecting system load statistics, maintaining list of Job Server(s) for this server group, and accepting Job Server execution requests.

- When a Job Server is downgraded out of a server group, the trace message is:
  Deleting current system load statistics, and not collecting more. Not accepting job execution requests from a server group.

3.4.2.1 Editing a server group

1. Select a server group from the navigation pane on the left.
2. In the Server Groups page, click the Server Group Configuration tab.
3. Select a new set of Job Servers.
4. Click Apply.

   Your edited server group is saved and the display returns to the Server Groups Configuration tab.

3.4.2.2 Removing a server group

1. In the Server Groups page, click the Server Group Configuration tab.
2. Select the check box for the server group(s) that you want to remove.
3. Click Remove.

   i Note

   If you delete Job Servers from a repository in order to delete all the Job Servers in a server group, the Administrator displays an invalid status for the server group.

3.4.3 Monitoring Job Server status in a server group

If Job Servers are in a server group, you can view their status in the Administrator.
To monitor the status of these Job Servers, select Server Groups All Server Groups. The Server Group Status page opens. All existing server groups are displayed with the Job Servers they contain.

Table 17:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Green Icon]</td>
<td>A green icon indicates that a Job Server is running.</td>
</tr>
<tr>
<td>![Yellow Icon]</td>
<td>A yellow icon indicates that a Job Server is not running.</td>
</tr>
<tr>
<td>![Red Icon]</td>
<td>A red icon indicates that the Job Server cannot connect to the repository.</td>
</tr>
</tbody>
</table>

If a server group contains Job Servers with a mix of green, yellow, or red indicators, then its indicator appears yellow. Otherwise, a server group indicator displays the same color indicator as its Job Servers.

To view the status for a single server group, select its name.

3.4.4 Executing jobs using server groups

After you create a server group, you can select a server group to execute a job from the Designer's Execution Properties window or from the Execute Batch Job and Schedule Batch Job pages in the Administrator.

Related Information

Batch Jobs [page 37]

3.5 Batch Jobs

This section describes how to execute, schedule, and monitor batch jobs from the Administrator.

Before you can manage batch jobs with the Administrator, add repository connections.

You can control some of the behavior in the Batch Job Status tab by making settings in the Central Management Console (CMC). For example, set the number of days to retain the job execution history or the Job Server log. Or set the number of seconds from the job start time that the Management Console displays an accurate job status for jobs that crash mid-execution.

For complete descriptions of these options, see the Server Management section of the Administrator Guide, or search for History Retention Period, Job Server Log Retention Period, or Job History Cleanup Period.
3.5.1 Executing batch jobs

You can execute batch jobs from the Administrator if their repositories are registered in the Central Management Console (CMC) and your user has the appropriate rights.

1. Select Batch <repository>. The Administrator opens the Batch Job Status page, which lists all of the jobs in the selected repository.

   To view jobs in all repositories from this page, select Batch All Repositories. (The All Repositories option appears under the Batch Job node if more than one repository is connected to the Administrator.)

2. Click the Batch Job Configuration tab.

3. To the right of the job you want to run, click Execute. The Administrator opens the Execute Batch Job page.

4. Under Enter Execution Options, set the parameters for the execution of this job.

5. Under Select Trace Options, set the trace properties for this execution of the job.

6. To create a debug package, select the Debug Package option.

   You can download the package from the Batch Job Status page.

7. Click Execute to run the job.

   The Administrator returns to the Batch Job Status page.

3.5.2 Scheduling jobs

There are three ways to manage job schedules.

Related Information

Using the job scheduler [page 38]
Scheduling jobs in SAP BusinessObjects Business Intelligence platform [page 43]
Using a third-party scheduler [page 45]

3.5.2.1 Using the job scheduler

When you schedule batch jobs using the SAP Data Services job scheduler, it creates an entry in the operating system’s scheduling utility on the Job Server computer. Windows uses the Task Scheduler and UNIX systems use the CRON utility. (Note that if you make changes to a schedule directly through these utilities, the job scheduler will not reflect those changes.)
3.5.2.1.1 Adding a job schedule

1. Select **Batch** in the repository.
2. Click the **Batch Job Configuration** tab.
3. For the job to configure, click **Add Schedule**.
4. On the **Schedule Batch Job** page, enter the desired options:

Table 18:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enter a job schedule</strong></td>
<td></td>
</tr>
<tr>
<td>Schedule name</td>
<td>Enter a unique name that describes this schedule.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>You cannot rename a schedule after you create it.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Select this box to enable (activate) this schedule, then click <strong>Apply</strong>.</td>
</tr>
<tr>
<td></td>
<td>This option allows you to create several schedules for a job and then activate the one(s) you want to run.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Select a scheduler</strong></td>
<td></td>
</tr>
<tr>
<td>Data Services scheduler</td>
<td>Creates the schedule on the Job Server computer.</td>
</tr>
<tr>
<td>BOE scheduler</td>
<td>Creates the schedule on the selected Central Management Server (CMS).</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Select scheduled day(s) for executing the job</strong></td>
<td>From the drop-down list on the calendar, select:</td>
</tr>
<tr>
<td>Calendar</td>
<td></td>
</tr>
<tr>
<td></td>
<td>○ <strong>Day of Week</strong> to schedule the job by the day of the week. You can select one or more days. Click again to deselect.</td>
</tr>
<tr>
<td></td>
<td>○ <strong>Day of Month</strong> to schedule the job by date. You can select one or more dates. Click again to deselect.</td>
</tr>
<tr>
<td></td>
<td><strong>If Recurring</strong> is selected, then the Administrator schedules this job to repeat every week or month on the selected day. Note that if you select multiple days of the week or month, the job will run on a recurring basis by default.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Select scheduled time for executing the jobs</strong></td>
<td>Enter the time for the scheduler to start the job (hours, minutes, and either AM or PM).</td>
</tr>
<tr>
<td>Once a day</td>
<td></td>
</tr>
<tr>
<td>Multiple times a day</td>
<td></td>
</tr>
<tr>
<td></td>
<td>○ For the Data Services scheduler, enter the time (hours, minutes, and either AM or PM) for the scheduler to repeatedly run the job for the selected duration (in minutes) at the selected interval (in minutes).</td>
</tr>
<tr>
<td></td>
<td>○ For the BOE scheduler, enter (in minutes) the repeat interval to run the job. You must also select all days in the calendar (for weekly or monthly).</td>
</tr>
<tr>
<td></td>
<td>Select a time when all of the required resources are available. Typically, you want to schedule jobs to ensure they finish before the target database or data warehouse must be available to meet increased demand.</td>
</tr>
<tr>
<td><strong>Select job execution parameters</strong></td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>System configuration</td>
<td>Select the system configuration to use when executing this job. A system configuration defines a set of datastore configurations, which define the datastore connections.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Creating and managing multiple datastore configurations” in the Designer Guide.</td>
</tr>
<tr>
<td></td>
<td>If a system configuration is not specified, the software uses the default datastore configuration for each datastore.</td>
</tr>
<tr>
<td></td>
<td>This option is a run-time property. This option is only available if there are system configurations defined in the repository.</td>
</tr>
<tr>
<td>Job Server or server group</td>
<td>Select the Job Server or a server group to execute this schedule.</td>
</tr>
<tr>
<td>Use password file</td>
<td>Select to create or update the password file that the job schedule accesses for current repository connection information. Deselect the option to generate the batch file with a hard-coded repository information.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>This option is disabled if you have not set up a CMS connection.</td>
</tr>
<tr>
<td>Enable auditing</td>
<td>Select this option if you want to collect audit statistics for this specific job execution. This option is selected by default.</td>
</tr>
<tr>
<td></td>
<td>For more information about auditing, see “Using Auditing” in the Designer Guide.</td>
</tr>
<tr>
<td>Disable data validation statistics collection</td>
<td>Select this option if you do not want to collect data validation statistics for any validation transforms in this job. This option is not selected by default.</td>
</tr>
<tr>
<td>Enable recovery</td>
<td>Select this option to enable the recovery mode when this job runs.</td>
</tr>
<tr>
<td>Recover from last failed execution</td>
<td>Select this option if an execution of this job has failed and you want to enable the recovery mode.</td>
</tr>
<tr>
<td>Collect statistics for optimization</td>
<td>Select this option to collect statistics that the optimizer will use to choose an optimal cache type (in-memory or pageable). This option is not selected by default.</td>
</tr>
<tr>
<td></td>
<td>See “Monitoring and tuning caches” in the Performance Optimization Guide.</td>
</tr>
<tr>
<td>Collect statistics for monitoring</td>
<td>Select this option to display cache statistics in the Performance Monitor in the Administrator. This option is not selected by default.</td>
</tr>
<tr>
<td></td>
<td>See “Monitoring and tuning cache types” in the Performance Optimization Guide.</td>
</tr>
<tr>
<td>Use collected statistics</td>
<td>Select this option if you want the optimizer to use the cache statistics collected on a previous execution of the job. The option is selected by default.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Monitoring and tuning caches” in the Performance Optimization Guide.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Export Data Quality reports</td>
<td>Generates and exports all specified job reports to the location specified in the <code>Management &gt; Report Server Configuration</code> node. By default, the reports are exported to <code>&lt;DS_COMMON_DIR&gt;/DataQuality \reports\&lt;repository\job&gt;</code>.</td>
</tr>
</tbody>
</table>
| Distribution level           | Select the level within a job that you want to distribute to multiple Job Servers for processing:  
  - **Job**: The whole job will execute on an available Job Server.  
  - **Data flow**: Each data flow within the job can execute on an available Job Server.  
  - **Sub data flow**: Each sub data flow (can be a separate transform or function) within a data flow can execute on an available Job Server.  
  For more information, see “Using grid computing to distribute data flows execution” in the Performance Optimization Guide. |

5. Click **Apply**. Clicking **Reset** returns all fields to the last set of values applied.

**Related Information**

- Managing database account changes [page 20]
- Data Validation Dashboard Reports [page 109]
- Configuring the report server [page 23]

### 3.5.2.1.2 Activating or deactivating one or more job schedules

In order for a job schedule to run, it must be active.

To change an existing job schedule, you must first deactivate it, make the changes, then reactivate it.

1. Select **Batch > <repository>**.
2. Click the **Repository Schedules** tab.

In order for a job schedule to run, it must be active.

The Repository Schedules tab lists all schedules for all jobs in the repository, and you can remove, activate, or deactivate one or more schedules.

Alternately, click the Batch Job Configuration tab, then for a particular job, click the Schedules link. The Batch Job Schedules tab lists all schedules for that particular job. Here you can add, remove, activate, or deactivate one or more schedules:

The Job Server column listed next to each schedule indicates which Job Server will execute it.

If there is a server group icon in the Job Server column, this indicates the schedule will be executed by the server group, and the schedule is stored on the indicated Job Server. To see which server group is associated with the schedule, roll your cursor over the server group icon.
If there is CMS icon in the Job Server column, this indicates the job schedule is managed by a Central Management Server.

Click the System Configuration names, if configured, to open a page that lists the datastore configurations in that system configuration.

3. On either the Repository Schedules tab or the Batch Job Schedules tab, select one or more check boxes for a schedule.
4. Click Activate (or Deactivate).

Related Information

Updating a job schedule [page 42]

3.5.2.1.3  Updating a job schedule

To edit a job schedule, you must first deactivate it, make the changes, then reactivate it.

1. Select Batch <repository>.
2. Click the Batch Job Configuration tab.
3. Click the Schedules link for the desired job.
4. Click the schedule name to edit.
5. The Schedule Batch Job page displays.
6. If the schedule is currently active, deactivate it by clearing the Active check box and click Apply.

Note

You do not need to deactivate the schedule to update most of the job execution parameters at the bottom of the page. Only the schedule-related parameters require deactivation in order to update them.

7. Edit the schedule parameters as required.
8. To reactivate the schedule now, select the Active check box.
9. Click Apply.

The status bar at the top of the page confirms that the schedule has been created and/or activated.

Related Information

Adding a job schedule [page 39]
3.5.2.1.4 Removing a job schedule

1. Select \Batch\ <repository>.
2. Click the Repository Schedules tab.
3. Select one or more check boxes for a schedule.
4. Click Remove.
   The Administrator deletes the information about this job schedule.

3.5.2.1.5 Migration considerations

Changes made to the Job Server, such as an upgrade, do not affect schedules created in SAP Data Services as long as:

- The new version of the software is installed in the same directory as the original version (Data Services schedulers use a hard-coded path to the Job Server).
- The new installation uses the Job Server name and port from the previous installation. (This occurs automatically when you install over the existing DSConfig.txt file.)

When you export a repository via an .atl file, jobs and their schedules (created in Data Services) automatically export as well.

You can also import a repository .atl file including jobs and their associated schedules (previously created in Data Services) back into Data Services.

Remember that once imported, you must reactivate job schedules to use them. If the job schedule uses a password file, then reactivating it will automatically generate the password file.

3.5.2.2 Scheduling jobs in SAP BusinessObjects Business Intelligence platform

If you are using SAP BusinessObjects Business Intelligence platform and you want to manage your SAP Data Services job schedules in that application, first create a connection to a Central Management Server (CMS), then configure the schedule to use that server.

3.5.2.2.1 Adding a CMS connection

1. Select \Management\ CMS Connection.
2. Click Add.
3. On the CMS Connections page, enter the connection information.
The parameters in the top section are the same as when logging in to an SAP BusinessObjects Business Intelligence platform Central Management Console (CMC) or InfoView. For details, refer to the SAP BusinessObjects Business Intelligence platform InfoView User's Guide.

The parameters in the bottom section (User account credentials for executing the program) depend on how the CMS server is set up. For details, refer to "Authentication and program objects" in the SAP BusinessObjects Business Intelligence platform Administrator Guide.

Table 19:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>Type the computer name that hosts the Central Management Server (CMS), a colon, and the port number.</td>
</tr>
<tr>
<td>User name</td>
<td>Type the CMC/InfoView user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Type the CMC/InfoView user password.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Select the authentication type for the server</td>
</tr>
</tbody>
</table>

User account credentials for executing the program (optional)

Note

If you do not have the following option cleared in the Central Management Console, you will be required to enter user account credentials in order for your schedules to run:

In the CMC, select Objects Objects Settings Program objects and clear the Use Impersonation option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>The CMS computer might require operating system login credentials to run the schedule. If so, type the user name (and password) for the applicable account.</td>
</tr>
<tr>
<td>Password</td>
<td>The CMS computer might require operating system login credentials to run the schedule. If so, type the (user name and) password for the applicable account.</td>
</tr>
</tbody>
</table>

4. Click Apply.

3.5.2.2.2 Creating a job schedule in SAP BusinessObjects Business Intelligence platform

1. Select Batch <repository>.
2. Click the Repository Schedules tab.
3. Click the schedule name to configure.
4. If the schedule is currently active, deactivate it by clearing the Active check box and click Apply.
5. Edit the schedule parameters as necessary.

Note

Time-sensitive parameters reflect the time zone of the computer where the Administrator is installed, not where the CMS is installed.
6. Under the Select a scheduler section, select **BOE scheduler**.
7. From the drop-down list, select a CMS name.
8. To reactivate the schedule now, select the Active check box.
9. Click **Apply**.

The status bar at the top of the page confirms that the schedule has been created and/or activated.

If it doesn’t already exist, SAP BusinessObjects Business Intelligence platform creates a folder called Data Services and stores the schedule file and a parameters file (called schedulename.txt).

For a BOE schedule with the **Use password file** option selected, then SAP Data Services also creates a password file in the Data Services folder (called repositoryname.txt).

**Note**

When you deactivate a schedule created on a CMS, SAP BusinessObjects Business Intelligence platform deletes the object. Therefore, any changes made to the calendar will be lost.

### 3.5.2.2.3 Removing a CMS connection

1. Select **Management > CMS Connection**.
2. Select the check box for the connection to remove from the administrator.
3. Click **Remove**.

### 3.5.2.3 Using a third-party scheduler

When you schedule jobs using third-party software:

- The job initiates outside of SAP Data Services.
- The job runs from an executable batch file (or shell script for UNIX) exported from Data Services.
- When you execute a Data Services job using the exported execution command on a Unix/Linux environment from a third-party scheduler or any other application, source the $LINK_DIR/bin/al_env.sh file before calling the script that contains the command to start the job. This can be done by adding following lines in the beginning of the script containing the execution command:

```bash
export LINK_DIR="/usr/sw/sap/dataservices"
. $LINK_DIR/bin/al_env.sh
```

Where /usr/sw/sap/dataservices is the directory where Data Services is installed.

**Note**

When a third-party scheduler invokes a job, the corresponding Job Server must be running.
Related Information

About the job launcher [page 49]

3.5.2.3.1 Executing a job with a third-party scheduler

1. Export the job’s execution command to an executable batch file (.bat file for Windows or .sh file for UNIX environments).
2. Ensure that the Data Services Service is running (for that job’s Job Server) when the job begins to execute. The Data Services Service automatically starts the Job Server when you restart the computer on which you installed the Job Server.
   ○ You can also verify whether a Job Server is running at any given time using the Designer. Log in to the repository that contains your job and view the Designer’s status bar to verify that the Job Server connected to this repository is running.
   ○ You can verify whether all Job Servers in a server group are running using the Administrator. In the navigation tree select [Server Groups] >> [All Server Groups] to view the status of server groups and the Job Servers they contain.
3. Schedule the batch file from the third-party software.

   **Note**
   To stop an SAP Data Services job that is launched through [AL_RWJobLauncher], press CTRL+C on the application’s keyboard. The job will be terminated and the termination status will be recorded. [AL_RWJobLauncher] is used by the Data Services job scheduler and third party schedulers for jobs exported from Data Services Management Console.

3.5.2.3.2 Exporting a job for scheduling

1. Select [Batch] >> [repository]
2. Click the [Batch Job Configuration] tab.
3. For the batch job to configure, click the [Export Execution Command] link.
4. On the [Export Execution Command] page, enter the desired options for the batch job command file that you want the Administrator to create:
### Table 20:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **File name**                       | The name of the batch file or script containing the job. The third-party scheduler executes this file. The Administrator automatically appends the appropriate extension:  
  ○ .sh for UNIX  
  ○ .bat for Windows |
| **System configuration**            | Select the system configuration to use when executing this job. A system configuration defines a set of datastore configurations, which define the datastore connections.  
  For more information, see “Creating and managing multiple datastore configurations” in the *Designer Guide*.  
  If a system configuration is not specified, the software uses the default datastore configuration for each datastore.  
  This option is a run-time property. This option is only available if there are system configurations defined in the repository. |
| **Job Server or server group**      | Select the Job Server or a server group to execute this schedule.                                                                                                                                              |
| **Enable auditing**                 | Select this option if you want to collect audit statistics for this specific job execution. The option is selected by default.  
  For more information about auditing, see “Using Auditing” in the *Designer Guide*.                                                   |
| **Disable data validation statistics collection** | Select this option if you do not want to collect data validation statistics for any validation transforms in this job. The option is not selected by default.                                    |
| **Enable recovery**                 | Select this option to enable the automatic recovery feature. When enabled, the software saves the results from completed steps and allows you to resume failed jobs.  
  See “Automatically recovering jobs” in the *Designer Guide* for information about the recovery options.                                   |
| **Recover from last failed execution** | Select this option to resume a failed job. The software retrieves the results from any steps that were previously executed successfully and re-executes any other steps. This option is a run-time property. This option is not available when a job has not yet been executed or when recovery mode was disabled during the previous run. |
| **Use password file**               | Select to create or update a password file that automatically updates job schedules after changes in database or repository parameters. Deselect the option to generate the batch file with a hard-coded repository user name and password.  
  **Note**  
  This option is disabled if you have not set up a CMS connection.                                                                                                                                  |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect statistics for optimization</td>
<td>Select this option to collect statistics that the optimizer will use to choose an optimal cache type (in-memory or pageable). This option is not selected by default. See “Monitoring and tuning caches” in the Performance Optimization Guide.</td>
</tr>
<tr>
<td>Collect statistics for monitoring</td>
<td>Select this option to display cache statistics in the Performance Monitor in the Administrator. The option is not selected by default. For more information, see “Monitoring and tuning cache types” in the Performance Optimization Guide.</td>
</tr>
<tr>
<td>Use collected statistics</td>
<td>Select this check box if you want the optimizer to use the cache statistics collected on a previous execution of the job. The option is selected by default. See “Monitoring and tuning caches” in the Performance Optimization Guide.</td>
</tr>
<tr>
<td>Export Data Quality reports</td>
<td>Generates and exports all specified job reports to the location specified in the Management &gt; Report Server Configuration node. By default, the reports are exported to <code>&lt;DS_COMMON_DIR&gt;/DataQuality/reports/</code> &lt;repository\job&gt;.</td>
</tr>
<tr>
<td>Distribution level</td>
<td>Select the level within a job that you want to distribute to multiple Job Servers for processing: ○ <strong>Job</strong>: The whole job will execute on one Job Server. ○ <strong>Data flow</strong>: Each data flow within the job will execute on a separate Job Server. ○ <strong>Sub data flow</strong>: Each sub data flow (can be a separate transform or function) within a data flow can execute on a separate Job Server. For more information, see “Using grid computing to distribute data flows execution” in the Performance Optimization Guide.</td>
</tr>
</tbody>
</table>

5. Click **Export**.

The Administrator creates command files `<filename>.txt` (the default for filename is the job name) and a batch file for the job and writes them to the local `<DS_COMMON_DIR>/log` directory.

**Note**

You can relocate the password file from the `<DS_COMMON_DIR>/conf` directory, but you must edit the `<filename>.txt` file so that it refers to the new location of the password file. Open the file in a text editor and add the relative or absolute file path to the new location of the password file in the argument `-R "<repositoryname>.txt"`. 

**Related Information**

- Data Validation Dashboard Reports [page 109]
- Managing database account changes [page 20]
- Configuring the report server [page 23]
3.5.2.4 About the job launcher

SAP Data Services exports job execution command files as batch files on Windows or CRON files on UNIX. These files pass parameters and call `AL_RWJobLauncher`. Then, `AL_RWJobLauncher` executes the job, sends it to the appropriate Job Server, and waits for the job to complete.

⚠️ Caution
Do not modify the exported file without assistance from SAP Business User Support.

3.5.2.4.1 Job launcher flag values and arguments

The following table lists job launcher flags and their values.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-w</code></td>
<td>The job launcher starts the job(s) and then waits before passing back the job status. If <code>-w</code> is not specified, the launcher exits immediately after starting a job.</td>
</tr>
<tr>
<td><code>-t</code></td>
<td>The time, in milliseconds, that the Job Server waits before checking a job's status. This is a companion argument for <code>-w</code>.</td>
</tr>
<tr>
<td><code>-s</code></td>
<td>Status or return code. 0 indicates successful completion, non-zero indicates an error condition. Combine <code>-w</code>, <code>-t</code>, and <code>-s</code> to execute the job, wait for completion, and return the status.</td>
</tr>
<tr>
<td><code>-C</code></td>
<td>Name of the engine command file (path to a file which contains the Command line arguments to be sent to the engine).</td>
</tr>
<tr>
<td><code>-v</code></td>
<td>Prints <code>AL_RWJobLauncher</code> version number.</td>
</tr>
<tr>
<td><code>-S</code></td>
<td>Lists the server group and Job Servers that it contains using the following syntax: &quot;SvrGroupName;inet:JobSvr1Host:JobSvr1Port;inet:JobSvr2Host:JobSvr2Port&quot;;</td>
</tr>
<tr>
<td><code>-R</code></td>
<td>The location and name of the password file. Replaces the hard-coded repository connection values for <code>-S</code>, <code>-N</code>, <code>-U</code>, <code>-P</code>.</td>
</tr>
<tr>
<td><code>-xC</code></td>
<td>Generates and exports all specified job reports to the location specified in the <code>Report Server Configuration</code> node. By default, the reports are exported to <code>&lt;DS_COMMON_DIR&gt;\DataQuality\reports\&lt;repository\&gt;job&gt;</code>. In order to use this flag, you must disable the security for the Export_DQReport operation in the <code>Web Services Configuration</code> tab.</td>
</tr>
</tbody>
</table>

There are two arguments that do not use flags:

- `inet address`: The host name and port number of the Job Server. The string must be in quotes. For example:

  "inet:HPSVR1:3500"
If you use a server group, inet addresses are automatically rewritten using the -S flag arguments. On execution, the first Job Server in the group checks with the others and the Job Server with the lightest load executes the job.

- **server log path:** The fully qualified path to the location of the log files. The server log path must be in quotes. The server log path argument does not appear on an exported batch job launch command file. It appears only when Data Services generates a file for an active job schedule and stores it in the following directory: `<DS_COMMON_DIR>/Log/<JobServerName>/<RepositoryName>/<JobInstanceName>`. You cannot manually edit server log paths.

### 3.5.2.4.2 Job launcher error codes

The job launcher also provides error codes to help debug potential problems. The error messages are:

<table>
<thead>
<tr>
<th>Error number</th>
<th>Error message</th>
</tr>
</thead>
<tbody>
<tr>
<td>180002</td>
<td>Network failure.</td>
</tr>
<tr>
<td>180003</td>
<td>The service that will run the schedule has not started.</td>
</tr>
<tr>
<td>180004</td>
<td><code>LINK_DIR</code> is not defined.</td>
</tr>
<tr>
<td>180005</td>
<td>The trace message file could not be created.</td>
</tr>
<tr>
<td>180006</td>
<td>The error message file could not be created.</td>
</tr>
<tr>
<td>180007</td>
<td>The GUID could not be found.</td>
</tr>
<tr>
<td></td>
<td>The status cannot be returned.</td>
</tr>
<tr>
<td>180008</td>
<td>No command line arguments were found.</td>
</tr>
<tr>
<td>180009</td>
<td>Invalid command line syntax.</td>
</tr>
<tr>
<td>180010</td>
<td>Cannot open the command file.</td>
</tr>
</tbody>
</table>

### 3.5.3 Downloading a debug package

Download a job debug package that includes the ATL and trace, monitor, and log files.

You can generate a debug package as you execute the job either from the Execution Properties window of the Designer or in the Execution Options page of the Management Console Administrator. The debug package includes the ATL and trace, monitor, and log files.

After you execute a job and create a debug package, you can download the package from its location on the machine where the Job Server is installed.

1. Select **Batch > <repository>**

   The Administrator opens the Batch Job Status page, which lists all of the jobs in the selected repository.

   To view jobs in all repositories from this page, select **Batch > All Repositories**. (The All Repositories option appears under the Batch Job node if more than one repository is connected to the Administrator.)
2. To the right of the job that you want to download the package for, click Download Logs/Debug Package.

3. Open or save the .zip or .tar file.

   **Note**
   The download option is available even if the package has not been created or is not available. If the package is not available on the Job Server, a package containing log files is downloaded and a message alerts you.

   You can send the generated .zip or .tar file to SAP customer support to help you troubleshoot execution-related issues.

### 3.5.4 Monitoring RFC trace logs

Get brief, verbose, or full trace logs for SAP RFC functions calls.

For a batch job, you can choose to generate a trace log for RFC function calls, and set the level of detail in the trace log.

1. In Management Console, navigate to the Administrator > Management > Datastore > Datastore Configurations page.

   **Note**
   You can also set the trace level in the Design datastore editor.

2. For the RFC Trace Level option, select brief, verbose, or full. The default value is brief.

3. When executing the job, in the Execution Properties window of the Designer or in the Execution Options page of the Management Console Administrator, set the Trace RFC Function option value to Yes.

### 3.6 Real-Time Jobs

This section describes how to support real-time jobs using the Administrator.

Before configuring services, add real-time job repository and Access Server connections to the Administrator.

**Related Information**

- Supporting real-time jobs [page 52]
- Configuring and monitoring real-time services [page 53]
- Creating and monitoring client interfaces [page 62]
3.6.1 Supporting real-time jobs

The Access Server manages real-time communication between SAP Data Services and external applications (such as ERP or web applications). The Access Server determines how to process incoming and outgoing messages based on the settings you choose for each real-time job in the Administrator.

In particular you use the Administrator to define:

- **Services**: A service is a name that identifies a task. The Access Server receives requests for a service. You associate a service with a real-time job. The real-time job contains the real-time processing loop that can process requests for this service and generate a response.

- **Service providers**: A service provider is the engine process that performs a service; the service provider completes the tasks in a real-time job. A service provider is controlled by a Job Server. A Job Server can control several service providers—each service provider is a unique process instance.

The Access Server uses services and service providers to process message requests. The following is an example:

1. An external application sends a request to the Access Server.
2. The Access Server determines the appropriate service for the request.
3. The Access Server finds the associated service providers and dispatches the request to the next available service provider.
4. Under the control of a Job Server, that service provider completes the processing for the request. A different Job Server might control each service provider.

The Access Server manages the entire set of service providers, implementing configuration changes and telling the appropriate Job Servers to start and stop service providers. At a prescribed interval, the Access Server updates service providers, balancing loads and implementing configuration changes. To balance loads, the Access Server monitors requests for services to ensure that no service provider is over-used or under-used.
Based on the number of requests for a service, the Access Server tells Job Servers to start or stop service providers.

To support real-time jobs, you must:

- Create any number of Access Servers using the Server Manager utility, then add a connection to each local or remote Access Server using the Management node in the Management Console Administrator.
- In the Real-Time node of the Administrator, create a service for each real-time job under each Access Server’s node.
- Create one or more service providers for each service.
- Start the services.
- Monitor the services.

**Related Information**

Creating services and service providers [page 53]
Starting and stopping services [page 57]
Monitoring services [page 60]

### 3.6.2 Configuring and monitoring real-time services

To enable an Access Server to support real-time jobs, you must configure and monitor real-time services and service providers for it.

- Configure services by specifying a real-time job and other operational parameters.
- Configure service providers by specifying a Job Server and indicating the maximum and minimum number of instances that you want the Job Server to control. Each service provider is a unique process or instance controlled by a Job Server.

**Related Information**

Creating services and service providers [page 53]
Starting and stopping services [page 57]
Updating service providers [page 59]
Monitoring services [page 60]

#### 3.6.2.1 Creating services and service providers

In the Administrator, you create a service that processes requests for each real-time job. You also create the service providers to perform that service. A service provider is the process that completes the tasks in a real-time job.
3.6.2.1.1 Adding a service

2. Click the Real-Time Services Configuration tab.
3. Click the Add button.
4. In the Service configuration section, enter information that describes this service.

Table 23:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service name</td>
<td>A unique name for this service.</td>
</tr>
<tr>
<td>Job name</td>
<td>Click Browse Jobs to view a list of all the real-time jobs available in the repositories that you connected to the Administrator. Select a job name to fill the service configuration form.</td>
</tr>
<tr>
<td>Repository name</td>
<td>Logical name for a repository (used in the Administrator only).</td>
</tr>
<tr>
<td>Processing retry count max</td>
<td>The number of times that the Access Server attempts to restart a job that fails to respond.</td>
</tr>
<tr>
<td>Enable job tracing</td>
<td>A flag that indicates whether the service will write trace messages. Select Enable for the job to write trace messages.</td>
</tr>
<tr>
<td>Startup timeout</td>
<td>The maximum time that the Access Server waits for the service to register after startup (in seconds).</td>
</tr>
<tr>
<td>Queuing timeout</td>
<td>The maximum time that the Access Server waits for the service to process the request (in seconds).</td>
</tr>
<tr>
<td>Processing timeout</td>
<td>The maximum time that the Access Server waits for a response from the service (in seconds).</td>
</tr>
<tr>
<td>Recycle request count max</td>
<td>The number of requests that the Access Server sends to a given real-time service before automatically recycling the flow.</td>
</tr>
<tr>
<td>System Configuration</td>
<td>If configured, select the system configuration to use when executing this service. This option is available only if there are system configurations defined in the repository. For more information, see “Parameters” in the Reference Guide.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Enable</td>
<td>A flag that indicates whether the Access Server attempts to automatically start this service when the Access Server restarts. Select <strong>Enable</strong> if you want to automatically start this service when the Access Server restarts. This is the default setting. If you clear the <strong>Enable</strong> option, when the Access Server restarts, it does not automatically start this service. If you manually attempt to start a disabled service, an error message appears in the Service’s Status column.</td>
</tr>
</tbody>
</table>

5. Add one or more job servers to start this service provider. In the **Service provider** section, click the **Add** button to insert a new Job Server.

6. In the **Job Server** list, select a Job Server to control the service provider. Job Servers are defined by host name and port number.
   You may not select a Job Server more than one time.

7. In the **Min instances** and **Max instances** fields, enter a minimum and a maximum number of service providers that you want this Job Server to control for this service.

8. The job server is enabled by default. To configure but not start the service providers controlled by this Job Server, select the checkbox next to the Job Server, and click the **Disable** button.

9. To add a substitution parameter, click the **Add Overridden Parameter** link.

10. From the drop-down list, select the substitution parameter to override, and enter the override value.

11. Click **Apply**.

   The Administrator updates the configuration parameters for this service. These configuration parameters apply to all providers of this service.

When you are ready for the Access Server to process requests, start the service.

**Related Information**

Service startup behavior [page 70]
High-traffic behavior [page 71]
Response time controls [page 72]
Starting a service [page 57]

### 3.6.2.1.2 Adding or changing a service provider for a service

1. Select **Real-time** &lt;**Access Server**&gt; **Real-Time Services**

2. Click the **Real-Time Services Configuration** tab.

3. Click the name of the service for which you want to change the service provider.

4. In the **Service provider** section, click the **Add** button.
5. In the Job Server list, select a Job Server to control the service provider. Job Servers are defined by host name and port number.
   You may not select a Job Server more than one time.
6. In the Min instances and Max instances fields, enter a minimum and a maximum number of service provider instances that you want this Job Server to control.
7. The job server is enabled by default. To configure but not start the service providers controlled by this Job Server, select the checkbox next to the Job Server, and click the Disable button.
8. Click the Apply button.

   If the service has already started, the Access Server adds this service provider to the available list when it next updates the service providers.

   If the service has not yet started, the Access Server starts enabled service providers when the service starts.

Related Information

Updating service providers [page 59]

3.6.2.1.3 Setting the service provider update interval

The Provider update interval for services option sets the time interval, in seconds, between service provider updates. Valid values range from 10 to 120 seconds. The default is 30 seconds. When updating service providers, the Access Server balances loads and implements any configuration changes you have applied to a service provider.

If the provider update interval is too small, performance can decrease because the Access Server must frequently check for events and collect statistics. It’s recommended that you set the Provider update interval for services to 30 seconds. On systems with heavy loads and production systems with fewer start and stop events, you can increase the interval.


   This is the time interval, in seconds, between service provider updates. Valid values range from 10 to 120 seconds. The default is 30 seconds. When updating service providers, the Access Server balances loads and implements any configuration changes you have applied to a service provider.

   If the provider update interval is too small, performance can decrease because the Access Server must frequently check for events and collect statistics. It’s recommended that you set the Provider update interval for services option to 30 seconds. On systems with heavy loads and production systems with fewer start and stop events, you can increase the interval.

2. Click the Access Server Configuration tab.

3. Enter the desired Provider update interval for services.
3.6.2.2 Starting and stopping services

After you create the required services and service providers, you can start them. After you start a service or service provider, SAP Data Services ensures that it continues to run. You can also use the Administrator to stop a service (such as for maintenance). Similarly, use the Administrator to remove, enable, or disable services and service providers.

3.6.2.2.1 Starting a service

2. In the Real-Time Services Status tab, select the check box next to the service or services that you want to start.
3. Click Start.

   The Access Server starts the minimum number of service providers for this service.

3.6.2.2.2 Enabling a service

2. Click the Real-Time Services Configuration tab. The table of services displays the status in the Enabled column.
3. Select the check box next to the service or services that you want to enable.
4. Click the Enable button.

   The Access Server enables the minimum number of service providers for this service, and the Enabled column displays Yes.

   This change does not start the service. Instead, the service is enabled the next time that the Access Server attempts to start the service, such as after the Access Server restarts.

3.6.2.2.3 Disabling a service

2. Click the Real-Time Services Configuration tab. The table of services displays the status in the Enabled column.
3. Select the check box next to the service or services that you want to disable.
4. Click the Disable button.

This change does not have an immediate effect on the service. Instead, the service is disabled the next time that the Access Server attempts to start the service, such as after the Access Server restarts. If you attempt to start a disabled real-time service, an error message displays in the service’s status.

### 3.6.2.2.4 Aborting or shutting down a service

1. Select **Real-Time** &lt;Access Server&gt; **Real-Time Services**
2. In the Real-Time Services Status tab, select the check box next to the service or services that you want to abort or shut down.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort</td>
<td>Shuts down all service providers for this service without waiting for them to complete processing. The Access Server responds to current and new requests for this service with an error.</td>
</tr>
<tr>
<td>Shutdown</td>
<td>Shuts down all service providers for this service after they complete processing any current requests. The Access Server responds to new requests for this service with an error.</td>
</tr>
</tbody>
</table>

3. Click **Abort** or **Shutdown**.

**Related Information**

- Starting a service [page 57]
- Disabling a service [page 57]

### 3.6.2.2.5 Removing a service

1. Select **Real-Time** &lt;Access Server&gt; **Real-Time Services**
2. Click the **Real-Time Services Configuration** tab.
3. Select the check box next to the service or services that you want to remove.
4. Click **Remove**.

The Administrator stops processing this service. The Access Server shuts down each of the service providers defined for this service and removes the service from the list.

### 3.6.2.2.6 Removing, enabling, or disabling a service provider

1. Select **Real-Time** &lt;Access Server&gt; **Real-Time Services**
2. Click the **Real-Time Services Configuration** tab.

3. If you want to change a Job Service’s service providers, select the check box next to a Job Server.

4. Click one of the buttons below the list of Job Servers to perform the appropriate action:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable</strong></td>
<td>Start the service providers controlled by the selected Job Servers. Each Job Server starts the minimum number of service providers. The Access Server now includes the selected Job Servers in the set of available service providers. If a Job Server is already enabled, this choice has no effect.</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Discontinue using the service providers controlled by the selected Job Servers to process requests for this service. The Access Server shuts down the service providers and removes the Job Server from the list.</td>
</tr>
</tbody>
</table>

5. Shut down the service providers controlled by the selected Job Servers. The Access Server finishes processing any current requests and no longer includes the selected Job Servers in the set of service providers available to process requests for this service.

   The Administrator completes this action during the next service provider update.

### Related Information

**Updating service providers** [page 59]

### 3.6.2.2.7 Restarting a service provider

1. Select **Real-Time** ➔ **<Access Server>** ➔ **Real-Time Services** ➔

2. Select the service that you want to restart the service provider for. The **Service Provider Status** page opens.

   ![Note](image)

   Select Restart only if the service providers controlled by this Job Server are currently enabled. To verify the status, select the Real-Time Services Configuration tab and view service provider status in the Job Servers for Service section.

3. Click **Restart**.

   The Administrator completes this action during the next service provider update. The Administrator shuts down any service providers controlled by the selected Job Servers and immediately restarts the minimum number of service providers. For example, you might restart a service provider after a computer running its Job Server reboots following a crash.

### 3.6.2.3 Updating service providers

At a specified provider update interval, the Access Server updates service providers. When updating service providers, the Access Server balances the work load—starting or stopping service providers as necessary—and implements other events that you initiated since the last update.
When balancing the work load, the Access Server checks the number of requests in a service queue and the minimum idle time for a service. If the number of requests in a service queue is greater than the number of service providers started, the Access Server tries to start a new service provider. Conversely, if the minimum idle time for a service is more than 10 minutes, the Access Server will shut down a service provider. However, the number of service providers cannot exceed the maximum number of instances configured nor can it be less than the minimum number of instances configured.

When implementing events that you initiated, the Access Server does the following:

- Enables service providers
- Disables service providers
- Reconfigures service providers
- Restarts service providers
- Adds service providers
- Removes service providers

### Related Information

Setting the service provider update interval [page 56]

### 3.6.2.4 Monitoring services

Use the Administrator to monitor services. With the Administrator you can do the following:

- View service status—From the Access Server Status page or the Real-Time Services Status page, view whether a service is running or not. Based on this information, you can begin troubleshooting problems.
- View service provider status—From the Real-Time Services Status page, click a service name to view:
  - The statistics for a particular service.
  - Detailed statistics about each service provider. Using this information, you can monitor and evaluate system performance.
  - The status of all service providers in that service.
- View logs—The Access Server node provides access to current and historical service provider trace and error logs.

### Related Information

Viewing the status of services [page 61]
Service statistics [page 73]
Service provider statistics [page 74]
Viewing the statistics for a service provider [page 61]
Viewing the logs for a service provider [page 88]
3.6.2.4.1 Viewing the status of services


The Administrator opens the Real-Time Services Status page. For each service, this page shows the overall status and statistics about the number of available service providers and the number of started service providers.

2. Verify that the services are working.

Table 24:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>A green icon indicates that the service is operating properly.</td>
</tr>
<tr>
<td>🟡</td>
<td>A yellow icon indicates that some aspect of the service is not working, and that the Access Server is attempting to reestablish the service using error handling.</td>
</tr>
<tr>
<td>🟠</td>
<td>A red icon indicates that one or more aspects of the service is not working, and the Access Server cannot reestablish the service.</td>
</tr>
</tbody>
</table>

3. If a service shows a yellow or red status, click the service name to see more information.

Related Information

Service statistics [page 73]
Troubleshooting the Administrator [page 85]

3.6.2.4.2 Viewing the statistics for a service provider


2. Click the name of the service.

This page shows the overall statistics for the service, the service providers for the service (listed by Job Server), and the status of each service provider. Start a service to see its service provider status information.

3. Under Service Provider Status Information, click the Process ID of a service provider to view its statistics.

The Administrator opens the Service Provider Status page.

Under Service Provider Status Information, the page shows the statistics for this service provider.

Related Information

Service provider statistics [page 74]
Viewing the logs for a service provider [page 88]
3.6.3 Creating and monitoring client interfaces

A client is an external application that communicates with SAP Data Services through the Access Server.

There are two types of client interfaces in the Administrator:

- Remote Function Call (RFC) clients
- Message broker clients

Configure RFC clients in the Administrator for real-time jobs that use SAP IDocs. To support these jobs, create an RFC client interface and attach IDoc configuration information to it.

Data Services creates message broker client interfaces when communication occurs between the Access Server and an external application that uses Data Services message client libraries. To monitor message statistics, view the message broker clients of each Access Server as needed.

This section describes configuration and monitoring for each type of client.

For more information about using the Message Client library, see the SAP Data Services Integrator Guide.

3.6.3.1 RFC clients

You can configure IDoc message sources in the Administrator as well as in the Designer. You can configure other IDoc sources and targets using the Designer.

**i Note**

Using the Administrator, create a service for your real-time job that contains an IDoc as a message source before you configure an RFC client.

An RFC client uses the SAP RFC protocol to communicate with the Access Server. An RFC client requires connection information so that an Access Server can register to receive IDocs from an SAP application server. An RFC client can process one or more IDoc types. An RFC client specifies which service will process a particular IDoc type and whether or not the RFC client connection can process an IDoc type in parallel.

The process of creating an RFC client interface for IDocs has two parts:

- Adding an RFC client
- Adding IDoc configurations to an existing RFC client

Configure one RFC client per Access Server. This means that you can process IDocs from one instance of SAP. To process IDocs from more than one instance, configure more than one Access Server.

**i Note**

SAP application function modules are responsible for IDoc processing. In SAP Data Services, the RFC client might fail if multiple IDocs are sent from SAP and you previously set the SAP packet size to 1. Therefore:

- Do not enable the option of immediate IDoc dispatch in SAP unless the volume of produced IDocs is very low (no more than one IDoc per minute).
For batch processing of IDocs, the packet size should never be smaller than 5 or larger than 1000. The following table provides estimates for this parameter:

<table>
<thead>
<tr>
<th>IDoc Processing Volume</th>
<th>IDocs per day</th>
<th>Packet size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light</td>
<td>1 to 300</td>
<td>5</td>
</tr>
<tr>
<td>Medium</td>
<td>301 to 1000</td>
<td>20</td>
</tr>
<tr>
<td>Heavy</td>
<td>1001 to 5000</td>
<td>80</td>
</tr>
<tr>
<td>Very Heavy</td>
<td>more than 5000</td>
<td>800</td>
</tr>
</tbody>
</table>

For more information, see the SAP Data Services Supplement for SAP.

### 3.6.3.1.1 Adding an RFC client

2. Click the Client Interface Configuration tab.
3. Click Add.
   The Administrator opens the RFC Client Configuration page.
4. Enter the client configuration information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFC program ID</td>
<td>The registered server program ID from transaction SM59.</td>
</tr>
<tr>
<td>User name</td>
<td>The user name through which SAP Data Services connects to this SAP application server.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the user account through which SAP Data Services connects to this SAP application server.</td>
</tr>
<tr>
<td>SAP application server name</td>
<td>The domain name or IP address of the computer where the SAP application server is running.</td>
</tr>
<tr>
<td>Client number</td>
<td>The SAP application client number.</td>
</tr>
<tr>
<td>System number</td>
<td>The SAP application system number.</td>
</tr>
<tr>
<td>SAP gateway host name</td>
<td>The domain name or IP address of the computer where the SAP RFC gateway is located.</td>
</tr>
<tr>
<td>SAP gateway service name</td>
<td>The TCP/IP service name for the SAP application server gateway. Typically, this value is SAPGW and the system number. It can also be a service number, for example 3301.</td>
</tr>
<tr>
<td>Use sapnwrfc.ini</td>
<td>Select to use an sapnwrfc.ini file, which overrides the datastore settings associated with this RFC client. The default location to place the sapnwrfc.ini file is in the current directory of the process being executed (%LINK_DIR/bin).</td>
</tr>
<tr>
<td>Destination name</td>
<td>If using an sapnwrfc.ini file, enter the destination name to reference.</td>
</tr>
</tbody>
</table>
5. Click **Apply**.

For more information, see the *SAP Data Services Supplement for SAP*.

### 3.6.3.2 Adding IDoc configurations to an RFC client

After you create an RFC client, you can list the IDoc types that you want to receive.

#### 3.6.3.2.1 Adding an IDoc configuration to an RFC client

1. Select **Real-time** &gt; **<Access Server>** &gt; **Client Interfaces**.
2. Click the **Client Interface Configuration** tab.
3. Click the name of an existing RFC client interface.
   The RFC Client Configuration page opens.
4. Click the **Supported IDocs** link.
5. Click **Add**.
6. Enter IDoc information:
   a. In the **IDoc Type** box, enter the IDoc type that this SAP application server will send to the Access Server.
   b. In the **Service Name** box, enter the name of the service that will process this IDoc.
      The service identifies the job that processes this IDoc.
   c. If you want the Access Server to read IDocs (of this type and from the specified SAP source) in parallel, check the **Parallel Processing** check box.
      Real-time services that contain an IDoc message source can be processed one at a time or in parallel. The **Parallel Processing** option allows you to increase the number of IDoc source messages processed per minute for the IDoc type specified. This option is disabled by default. The option allows the Access Server to send an IDoc to a service queue (where it waits for a service provider) and continue with the next IDoc without waiting for reply. The maximum number of outstanding IDoc requests in the queue is the number of IDocs received or four, whichever is smaller.

   **Note**
   Where a strict IDoc processing sequence is required, do not use the Parallel Processing option.

7. Click **Apply**.
8. (Optional) Select **Real-time** &gt; **<Access Server>** &gt; **Client Interfaces**.
9. From the Client Interface Status page, select the check box next to the new RFC client and click **Start**.
   The Administrator starts the RFC client. A green indicator signifies that the client is running. Detailed status information is provided in the Status column.
3.6.3.2.2 Closing connections to an RFC client interface

2. Select the check box next to the RFC client you want to disconnect.
   - If you choose Shut down, the Access Server allows the clients to finish processing any active requests before closing the connection. The Access Server responds with an error to any new requests that arrive during that interval.
   - If you choose Abort, the Access Server closes the connection to the client without responding to requests currently being processed.
3. Click Shut down or Abort.

3.6.3.3 Message Broker clients

A Message Broker client uses an XML message to communicate with an Access Server.

Message Broker clients include:
- External applications
- Adapters
- Service providers

Use the Administrator to monitor Message Broker clients.

3.6.3.4 Monitoring client interfaces

From the Client Interface Status page, you can view the overall status of all client connections.

3.6.3.4.1 Viewing the overall status of client connections

2. Verify that the RFC client connections are working.
Table 27:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>A green icon indicates that each client of this type has an open connection with Access Server.</td>
</tr>
<tr>
<td>🟢</td>
<td>A yellow icon indicates that at least one client of this type is disconnecting.</td>
</tr>
<tr>
<td>⚠️</td>
<td>A red icon indicates that the Access Server could not reserve the specified port to listen for client requests.</td>
</tr>
</tbody>
</table>

If an RFC client interface has a red status:

a. View the Status column and click the name of the client to view statistics about the particular client connection with a problem.

b. If you want to restart, abort, or shut down a client interface, click the Back button in the navigation bar. The Administrator returns to the Client Interface Status page.

c. Click **Start**, **Abort**, or **Shutdown**.

### Related Information

**Finding problems [page 86]**

#### 3.6.3.4.2 Monitoring Message Broker clients

Select **Real-time** > **<Access Server>** > **Client Interfaces**.

Under **Message Broker Clients**, this page lists each message broker client that has registered with the Access Server along with statistics for that client.

**Note**

The first client in this list is the Administrator. You registered with the Access Server when you added connection information to the Administrator.

Message broker client interface information includes:

Table 28:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the client.</td>
</tr>
<tr>
<td>Time Connected</td>
<td>The total time that this client has been connected to the Access Server.</td>
</tr>
<tr>
<td>Last Message Received</td>
<td>The length of time since the Access Server has received a message from this client.</td>
</tr>
<tr>
<td>Last Message Sent</td>
<td>The length of time since the Access Server has sent a message to this client.</td>
</tr>
</tbody>
</table>
### 3.7 Real-Time Performance

#### About this section

This section discusses the Access Server parameters, statistics for services and service providers, and how to tune the performance of services and service providers.

#### Related Information

- Configuring Access Server output [page 67]
- Service configuration parameters [page 69]
- Service statistics [page 73]
- Service provider statistics [page 74]
- Using statistics and service parameters [page 75]

#### 3.7.1 Configuring Access Server output

You can configure the Access Server to control its operation and output such as sending specific event information to its trace log.

SAP Data Services installation includes a server configuration utility called the Server Manager. The Server Manager allows you to view and change the following Access Server information:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Directory          | The location of the configuration and log files for this instance of the Access Server.  
                      | Do not change this value after the initial configuration.                                                                                   |
| Communication Port | The port on this computer the Access Server uses to communicate with the Administrator and through which you can add additional configuration information to an Access Server.  
<pre><code>                  | Make sure that this port number is not used by another application on this computer.                                                      |
</code></pre>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters</td>
<td>Command-line parameters used by the Data Services Service to start this Access Server.</td>
</tr>
<tr>
<td></td>
<td>For development, consider including the following parameters:</td>
</tr>
<tr>
<td></td>
<td>-P -T16</td>
</tr>
<tr>
<td></td>
<td>where -P indicates that trace messages are recorded, and -T16 indicates that the Access Server collects events for services and service providers.</td>
</tr>
<tr>
<td></td>
<td>For parameter descriptions, see &quot;Configuring an Access Server&quot;.</td>
</tr>
<tr>
<td>Enable Access Server</td>
<td>An option to control the automatic start of the Access Server when the Data Services Service starts.</td>
</tr>
</tbody>
</table>

**Related Information**

[Configuring an Access Server](page 68)

### 3.7.1.1 Configuring an Access Server

1. Open Data Services Server Manager.
2. Navigate to the Access Server tab and click on **Configuration Editor**.
   
   The **Access Server Configuration Editor** opens.
3. Click **Add** to configure a new Access Server or select an existing Access Server, then click **Edit** to change the configuration for that Access Server.
4. Make the appropriate changes in the **Access Server Properties** window.
5. Click **OK** to return to the **Access Server Configuration Editor**.
6. Click **OK** to return to the Server Manager.
7. Click **Restart** to stop and start the Data Services Service with the new Access Server configuration.

The following parameters are available to control the operation and output of an Access Server:

**Table 30:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-A</td>
<td>Specifies the communication port for an Access Server. The default value is -A4000.</td>
</tr>
<tr>
<td>-C</td>
<td>Disables display output.</td>
</tr>
<tr>
<td>-H</td>
<td>Prints the parameter list to the console.</td>
</tr>
<tr>
<td>-P</td>
<td>Enables trace messages to the console and log.</td>
</tr>
</tbody>
</table>
### Parameter Descriptions

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-R &lt;root_directory&gt;</code></td>
<td>Indicates the location of the Access Server directory.</td>
</tr>
<tr>
<td><code>-T &lt;value&gt;</code></td>
<td>Determines the type of tracing information displayed in the console and the Access Server log. You can use any value or any combination of values. For example, to enable tracing for both system-level and service-level operations, include the value 17 (16 for service plus 1 for system) after the <code>-T</code> parameter.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value</th>
<th>Tracing information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>system</td>
</tr>
<tr>
<td>2</td>
<td>real-time service flow</td>
</tr>
<tr>
<td>4</td>
<td>client</td>
</tr>
<tr>
<td>8</td>
<td>transaction</td>
</tr>
<tr>
<td>16</td>
<td>service</td>
</tr>
<tr>
<td>64</td>
<td>administration</td>
</tr>
<tr>
<td>128</td>
<td>all requests</td>
</tr>
<tr>
<td>256</td>
<td>failed requests</td>
</tr>
</tbody>
</table>

#### Note
If you use `-T 384`, which is 128 (all requests) plus 256 (failed requests), the all requests tracing will take precedence.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-V</code></td>
<td>Displays the version number of the Access Server.</td>
</tr>
<tr>
<td><code>-VC</code></td>
<td>Displays communication protocol and version number.</td>
</tr>
<tr>
<td><code>-X</code></td>
<td>Validates the Access Server configuration without launching the Access Server.</td>
</tr>
</tbody>
</table>

The `-A` and `-R` parameters can also be set using the Server Manager.

The `-P` and `-T` parameters can be set using the Administrator. Select `Real-Time` > `<Access Server>` > `Logs-Current` and click the `Access Server Log Configuration` tab.

### 3.7.2 Service configuration parameters

Each service contains configuration parameters that control how the Access Server dispatches requests to the assigned real-time job. These parameters determine how the system handles errors that occur during operation.
Often, requirements during development differ from requirements during production. Therefore, the values of your configuration parameters differ during development and production. To ensure that the system works as expected, test the values before committing the Access Server configuration to production use.

Parameters control different categories of Access Server operation:

- Service startup behavior
- High-traffic behavior
- Response time controls

### Related Information

- Adding a service [page 54]
- Service startup behavior [page 70]
- High-traffic behavior [page 71]
- Response time controls [page 72]

### 3.7.2.1 Service startup behavior

Use two parameters to configure how the Access Server starts service providers associated with a particular service:

- **Startup timeout**—The maximum time that the Access Server waits for a flow (service and its providers) to register after startup.
- **Recycle request count max**—The number of requests that the Access Server sends to a given flow before automatically recycling.

When the Access Server starts, it immediately starts the service providers for each service. If you want the Access Server to start more than one instance of a service to process a particular type of message, you must define more than one service provider for the service.

The Job Servers launch the jobs, which in turn initiate their corresponding real-time services. The first operation of each real-time service is to register with the Access Server.

If an error occurs and a real-time service fails to register, the Access Server instructs the Job Server to restart the job. The Access Server waits the length of time that you configure as the startup timeout before instructing the Job Server to start the job again. The startup timeout is in seconds. The Access Server continues to instruct the Job Server to restart the job until the real-time service registers.
You can also control how many requests a particular service provider processes. After a provider processes the number of requests specified by the Recycle request count max parameter, the Access Server automatically recycles the service provider—that is, the Access Server automatically stops the current instance of the real-time service and starts a new instance of that service. Setting this parameter to a higher value increases the time that the service provider is available to accept requests for processing. Setting this parameter to a lower value refreshes any data cached in the real-time service more often.

### 3.7.2.2 High-traffic behavior

Use the Queuing Timeout parameter to specify the maximum amount of time the client application must wait for a request to be processed.

If the number of requests the Access Server receives for a particular service exceeds the number of registered service providers that can process those requests, the Access Server queues the requests in the order they are received. When a service provider completes processing a request and responds to the Access Server, the Access Server dispatches the next request in the queue for that service to the open service provider.

If there are many requests and the queue causes requests to exceed the queuing timeout, the Access Server removes the oldest request from the queue and responds to the client with an error indicating that the request failed. You can use the queuing timeout to ensure that the client receives a timely response, even during high-traffic periods.

The queuing timeout is in seconds.
A service experiences high traffic when the available resources cannot process the received requests efficiently. High traffic occurs when the time messages wait to be processed exceeds the time required to process them.

**Related Information**

Using statistics and service parameters [page 75]

### 3.7.2.3 Response time controls

Use two parameters to configure how long the Access Server waits for responses from service providers for a particular service:

- *Processing timeout*
- *Processing retry count max*

After the Access Server sends a request to a service provider to process, the Access Server waits for the response. If the response does not arrive within the specified processing timeout, the Access Server sends the request to another waiting service provider. The *Processing timeout* is in seconds.

If the first attempt fails, the Access Server will attempt to process the request as many times as you specify in the *Processing retry count max* parameter.
If Processing retry count max is set to zero, the maximum response time is equal to the queuing timeout plus the processing timeout.

### 3.7.3 Service statistics

The Real-Time Services Status page for a particular service shows overall statistics.

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of processed requests</td>
<td>The number of requests for this service from any client that the Access Server received and responded to since the last time the Access Server started.</td>
</tr>
<tr>
<td>Number of requests in queue</td>
<td>The number of messages that the Access Server has received from a client for this service but has not sent to a service provider for processing. This value reflects the current state of the Access Server.</td>
</tr>
<tr>
<td>Maximum queuing time (milliseconds)</td>
<td>The maximum time any request for this service waited after the Access Server received the message and before the Access Server sent the request to a service provider for processing.</td>
</tr>
<tr>
<td>Average queuing time (milliseconds)</td>
<td>The average time that requests for this service waited after the Access Server received the request and before the Access Server sent the request to a service provider for processing.</td>
</tr>
<tr>
<td>Queuing timeout</td>
<td>The number of requests to which the Access Server replied to the client with an error indicating that there was no service provider available to process the request.</td>
</tr>
</tbody>
</table>
### 3.7.4 Service provider statistics

The Service Provider Status page shows the statistics for an instance of a real-time service.

When SAP Data Services measures a statistic “from the start,” the value does not restart when the Access Server restarts the service provider. The value restarts when the Access Server restarts.

When the software measures a statistic “for the current service provider,” the value restarts when the Access Server restarts the service provider, either due to error or when the service provider reaches the maximum number of requests defined for the service.

Table 32:

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max processing time (milliseconds)</td>
<td>The longest time it took between when the Access Server sent a message to this service provider and when the service provider returned a response.</td>
</tr>
<tr>
<td>Average processing time (milliseconds)</td>
<td>The average time it took between when the Access Server sent a message to this service provider and when the service provider returned a response.</td>
</tr>
<tr>
<td>Processing timeouts</td>
<td>The number of requests that the Access Server sent to a service provider and did not receive a response before exceeding the processing timeout. These requests are either successfully processed by another service provider, or if they are left unprocessed beyond the time indicated by the queuing timeout parameter, the Access Server returns an error to the client.</td>
</tr>
<tr>
<td>Processed requests (for the current service provider)</td>
<td>The number of requests that the Access Server sent to this service provider to which the service provider responded.</td>
</tr>
<tr>
<td>Processed requests (since start)</td>
<td>The number of requests that the Access Server sent to this service provider to which the service provider responded.</td>
</tr>
<tr>
<td>Error replies received from the start</td>
<td>The number of requests that the Access Server sent to this service provider to which the service provider responded with an error.</td>
</tr>
<tr>
<td>Communication errors encountered from the start</td>
<td>The number times that the communication link between the Access Server and this service provider failed.</td>
</tr>
</tbody>
</table>
### Table 33: Statistic and Description

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeout errors encountered from the start</td>
<td>The number of times the Access Server sent requests to this service provider and did not receive a response within the time specified by the processing timeout.</td>
</tr>
<tr>
<td>Service provider connections (restarts) from the start</td>
<td>The number of times the Access Server restarted this service provider when it did not receive a response from the service provider.</td>
</tr>
</tbody>
</table>
| The last time of a successful flow launch      | The system time when the Access Server last started the real-time service associated with this service provider. If the Access Server never successfully started an instance of this service provider, the value is “N/A.”  
This time is from the computer running the Access Server. |
| Time since start attempt                       | The amount of time since the Access Server last attempted to start this service provider. This value reflects successful and unsuccessful attempts. |
| Time since last request start                  | The amount of time since the Access Server last sent a request to this service provider. This value reflects successful and unsuccessful attempts. |

### 3.7.5 Using statistics and service parameters

You can use the statistics for a service to tune the service parameters.

*Table 33:*

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average and maximum processing time</td>
<td>If the average or maximum processing time for a service provider is equal or close to the processing timeout value resulting in processing timeouts, consider increasing the processing timeout parameter for the service.</td>
</tr>
</tbody>
</table>
| Maximum queuing time                           | In a tuned system, the maximum and average queuing times should be close together, the difference being an indication of the traffic distribution for this service. Values should not approach the value of the queuing timeout parameter listed for the service.  
If the maximum queuing time for a service provider is equal or close to the queuing timeout parameter and there are queuing timeouts listed, consider the following changes:  
- Increase the queuing timeout parameter for the service.  
- Increase the number of service providers available, either controlled by the same Job Server host or by a different Job Server.  
If you find that the average time in the queue is longer than the average processing time, the traffic for this service is too high for the resources provided. Consider running multiple service providers to process the same message type. You can add the same job many times in the service list, or you can add the same job controlled by a different Job Server on a separate computer to the service list.  
If you find that the average queuing time is growing, consider increasing the queuing timeout or adding processing resources. |
### 3.8 Profile Server Management

Use the Administrator to manage the data in the profiler repository and manage tasks on the profiler server.

The Data Profiler executes on a profiler server to provide the following data profiler information that multiple users can view:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column analysis</td>
<td>This information includes minimum value, maximum value, average value, minimum string length, and maximum string length. You can also generate detailed column analysis such as distinct count, distinct percent, median, median string length, pattern count, and pattern percent.</td>
</tr>
<tr>
<td>Relationship analysis</td>
<td>This information identifies data mismatches between any two columns for which you define a relationship, including columns that have an existing primary key and foreign key relationship.</td>
</tr>
</tbody>
</table>

You can execute the Data Profiler on data contained in databases and flat files. Databases include DB2, Oracle, SQL Server, SAP Sybase, and Attunity Connector for mainframe databases. See the Release Notes for the complete list of sources that the Data Profiler supports.

This section assumes that you have already installed SAP Data Services, which includes the Data Profiler.

### 3.8.1 Defining a profiler repository

The Data Profiler repository is a set of tables that holds information about your data that the Data Profiler generates.

1. Create a database to use as your profiler repository.
   - The profiler repository can be one of the following database types: DB2, MySQL, Oracle, Microsoft SQL Server, SAP HANA, or SAP Sybase.
2. Create a profiler repository with the Repository Manager.
   - Select Profiler in the Repository type option.
3. Associate the profiler repository with a Job Server with the Server Manager.
3.8.2 Profiler task parameters

Set configuration parameters to control the amount of resources that profiler tasks use to calculate and generate profiler statistics.

### Note

If you plan to use Detailed profiling or Relationship profiling, ensure that you use the Server Manager to specify a pageable cache directory that:

- Contains enough disk space for the amount of data you plan to profile.
- Is on a separate disk or file system from the system where SAP Data Services is installed.

3.8.2.1 Configuring profiler task parameters

1. Select [Management > Profiler Configuration](#) to access the Profiler Configuration page.
2. Keep or change the parameters values listed on the Profiler Configuration page.

The Profiler Configuration page groups the parameters into the following categories:

- Task execution parameters
- Task management configuration parameters

Related Information

- Task execution parameters [page 77]
- Task management configuration parameters [page 78]

3.8.2.2 Task execution parameters

Table 35:
The Profiler Configuration page groups the Task execution parameters into subcategories Reading Data, Saving Data, and Performance.

<table>
<thead>
<tr>
<th>Task execution subcategory</th>
<th>Parameter</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading Data</td>
<td>Profiling size</td>
<td>All</td>
<td>The maximum number of rows to profile. You might want to specify a maximum number of rows to profile if the tables you profile are very large and you want to reduce memory consumption.</td>
</tr>
</tbody>
</table>
### Task execution subcategory

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading Data: Sampling rows</td>
<td>1</td>
<td>Profiles the first row of the specified number of sampling rows. For example, if you set <em>Profiling size</em> to 1000000 and set <em>Sampling rows</em> to 100, the Profiler profiles rows number 1, 101, 201, and so forth until 1000000 rows are profiled. Sampling rows throughout the table can give you a more accurate representation rather than profiling just the first 1000000 rows.</td>
</tr>
<tr>
<td>Saving Data: Number of distinct values</td>
<td>100</td>
<td>The number of distinct values to save in the profiler repository.</td>
</tr>
<tr>
<td>Saving Data: Number of patterns</td>
<td>100</td>
<td>The number of patterns to save in the profiler repository.</td>
</tr>
<tr>
<td>Saving Data: Number of days to keep results</td>
<td>90</td>
<td>The number of days to keep the profiler results in the profiler repository.</td>
</tr>
<tr>
<td>Saving Data: Number of records to save</td>
<td>100</td>
<td>The number of records to save in the profiler repository for each attribute.</td>
</tr>
<tr>
<td>Saving Data: Rows per commit</td>
<td>5000</td>
<td>The number of rows to save before a commit is issued.</td>
</tr>
<tr>
<td>Performance: Degree of Parallelism</td>
<td>2</td>
<td>The number of parallel processing threads that the profiler task can use.</td>
</tr>
<tr>
<td>Performance: File processing threads</td>
<td>2</td>
<td>The number of file processing threads for file sources.</td>
</tr>
</tbody>
</table>

### 3.8.2.3 Task management configuration parameters

Table 36:
The Profiler Configuration page groups the Task management configuration parameters into subcategories, basic and advanced.

<table>
<thead>
<tr>
<th>Task management subcategory</th>
<th>Parameter</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>Maximum concurrent tasks</td>
<td>10</td>
<td>The maximum number of profiler tasks to run simultaneously.</td>
</tr>
<tr>
<td>Basic</td>
<td>Refresh interval (days)</td>
<td>0</td>
<td>The number of days that must elapse before a profiler task is rerun for the same table or key columns when the user clicks the <em>Submit</em> option. The <em>Submit</em> option is on the <em>Submit Column Profile Request</em> and <em>Submit Relationship Profile Request</em> windows in the Designer. The default is 0, which is to always rerun the profiler task when the user clicks the <em>Submit</em> option. In other words, there is no limit to the number of Data Profiler tasks that can be run per day. To override this interval, use the <em>Update</em> option on the Profile tab of the View Data window in the Designer.</td>
</tr>
</tbody>
</table>
### Advanced

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Invoke sleep interval (seconds)</strong></td>
<td>5</td>
<td>The number of seconds to sleep before the Data Profiler checks for completion of an invoked task. Invoked tasks run synchronously, and the Data Profiler must check for their completion.</td>
</tr>
<tr>
<td><strong>Submit sleep interval (seconds)</strong></td>
<td>10</td>
<td>The number of seconds to sleep before the Data Profiler attempts to start pending tasks. Pending tasks have not yet started because the maximum number of concurrent tasks was reached.</td>
</tr>
<tr>
<td><strong>Inactive interval (minutes)</strong></td>
<td>2</td>
<td>The number of minutes a profiling task can be inactive before the Data Profiler cancels it.</td>
</tr>
</tbody>
</table>

### 3.8.3 Monitoring profiler tasks using the Administrator

You can monitor your profiler task by name in either the Designer or the Administrator.

On the Administrator, you can see the status of profiler tasks, cancel profiler tasks, or delete a profiler task with its generated profile statistics.

1. Expand the **Profiler Repositories** node.
2. Click the profiler repository name.
3. The Profiler Tasks Status window displays.

   This status window contains the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select</strong></td>
<td>If you want to cancel a profiler task that is currently running, select this check box and click <strong>Cancel</strong>. If you want to delete a profiler task and its profiler data from the profiler repository, select this check box and click <strong>Delete</strong>. If you click <strong>Delete</strong> on a running task, the Profiler cancels the task before it deletes the data.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>The status of a profiler task can be: ○ <strong>Done</strong>—The task completed successfully. ○ <strong>Pending</strong>—The task is on the wait queue because the maximum number of concurrent tasks has been reached or another task is profiling the same table. ○ <strong>Running</strong>—The task is currently executing. ○ <strong>Error</strong>—The task terminated with an error.</td>
</tr>
<tr>
<td><strong>Task Name</strong></td>
<td>The name of the profiler task. The name is a link to the Profiler Task Items report.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The names of the tables on which the profiler task was run.</td>
</tr>
<tr>
<td><strong>Run #</strong></td>
<td>The identification number for this profiler task instance.</td>
</tr>
</tbody>
</table>
4. Click the task name to display the Profiler Task Items report, which displays the profiling type that was done for each column.

This Profiler Task Items report contains the following columns:

Table 38:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Update</td>
<td>The date and time that this profiler task last performed an action.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Is blank if the profiler task completed successfully. Displays an error message if the profiler task failed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The status for each column on which the profiler task executed. The status can be:</td>
</tr>
<tr>
<td></td>
<td>○ Done—The task completed successfully.</td>
</tr>
<tr>
<td></td>
<td>○ Pending—The task is on the wait queue because the maximum number of concurrent tasks has been reached or another task is profiling the same table.</td>
</tr>
<tr>
<td></td>
<td>○ Running—The task is currently executing.</td>
</tr>
<tr>
<td></td>
<td>○ Error—The task terminated with an error.</td>
</tr>
<tr>
<td>Item</td>
<td>The column number in the data source on which this profiler task executed.</td>
</tr>
<tr>
<td>Job Server</td>
<td>The machine name and port number of the Job Server where the profiler task executed.</td>
</tr>
<tr>
<td>Process ID</td>
<td>The process ID that executed the profiler task.</td>
</tr>
<tr>
<td>Profiling Type</td>
<td>Indicates what type of profiling was done on each column. The Profiling Type can be:</td>
</tr>
<tr>
<td></td>
<td>○ Single Table Basic—Column profile with default profile statistics.</td>
</tr>
<tr>
<td></td>
<td>○ Single Table Detailed—Column profile with detailed profile statistics.</td>
</tr>
<tr>
<td></td>
<td>○ Relational Basic—Relational profile with only key column data.</td>
</tr>
<tr>
<td></td>
<td>○ Relational Detailed—Relational profile with data saved from all columns.</td>
</tr>
<tr>
<td>Datastore</td>
<td>The name of the datastore.</td>
</tr>
<tr>
<td>Source</td>
<td>The name of the data source (table, flat file, or XML file).</td>
</tr>
<tr>
<td>Column</td>
<td>The name of the column on which the profiler task executed.</td>
</tr>
<tr>
<td>Last Update</td>
<td>The date and time that this profiler task last performed an action.</td>
</tr>
<tr>
<td>Status Message</td>
<td>Is blank if the profiler task completed successfully. Displays an error message if the profiler task failed.</td>
</tr>
</tbody>
</table>

3.9 RFC Server Management

Data Services uses the SAP RFC Server Interface for the following tasks:

- Scheduling SAP jobs
- Reading from SAP Open Hub destinations
- Loading SAP NetWeaver BW
- Viewing Data Services logs from SAP NetWeaver BW

This section describes how to use the RFC Server Interface in the Administrator.
To access the RFC Server Interface, in the Administrator expand the **SAP Connections** node and click **RFC Server Interface**. Two tabs display: **RFC Server Interface Status** and **RFC Server Interface Configuration**.

### 3.9.1 64-bit platform prerequisites

To use the RFC Server Interface on 64-bit UNIX platforms, first confirm that your environment is configured correctly:

1. Ensure that the 64-bit Java Development Kit (JDK) is installed.
2. Ensure that SAP Data Services is correctly installed with a supported web application server.
3. Export the JAVA_HOME environment variable, pointing to the location of the 64-bit JDK.
4. Restart your web application server.

For the latest update of these configuration steps, see SAP Note [1394367](https://support.sap.com).

### 3.9.2 Adding an RFC server interface

1. Select **SAP Connections»RFC Server Interface**.
2. Click the **RFC Server Interface Configuration** tab.
3. Click **Add**.
   - The Administrator opens the RFC Server Configuration page.
4. Enter the configuration information.

All options except the **RFC Program ID**, **SAP Gateway Host Name**, and **SAP Gateway Service Name** must match the SAP Applications datastore settings.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFC program ID</td>
<td>The registered server program ID in the SAP RFC destination to which this RFC Server will connect.</td>
</tr>
<tr>
<td>User name</td>
<td>The user name through which SAP Data Services connects to this SAP application server. Use the same user name used to create the SAP BW Source dataset.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the user account through which SAP Data Services connects to this SAP application server.</td>
</tr>
<tr>
<td>SAP application server name</td>
<td>The domain name or IP address of the computer where the SAP application server is running.</td>
</tr>
<tr>
<td>Client number</td>
<td>The SAP application client number.</td>
</tr>
<tr>
<td>System number</td>
<td>The SAP application system number.</td>
</tr>
</tbody>
</table>
The domain name or IP address of the computer where the SAP RFC gateway is located.
The TCP/IP service name or service number for the SAP application server gateway. Typically, this value is SAPGW plus the system number.
The number of TCP/IP connections to the SAP gateway host.

5. Click Apply.

The Administrator adds the RFC server interface definition and returns to the RFC Server Interface Status page. After adding the interface, you must manually start it from the RFC Server Interface Status page.

### 3.9.3 Starting or stopping an RFC server interface connection

After adding an interface, you must start it manually. To start the interface connection, on the RFC Server Interface Status page, select the check box for the interface to start and click Start.

To stop an interface connection:

1. Select the check box for the RFC server to disconnect.
2. Click Abort or Shut down.
   - If you choose Abort, the RFC server closes the connection to SAP BW without responding to requests currently being processed.
   - If you choose Shut down, the RFC server finishes processing any active requests before closing the connection. Any new requests to this RFC server will result in an error.

### 3.9.4 Monitoring RFC server interfaces

From the RFC Server Interface Status page (expand SAP Connections and click RFC Server Interface), you can access the status, statistics, and logs for all interface connections.

#### 3.9.4.1 Viewing the status of interface connections

The following tables describes the status icons.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Green Icon" /></td>
<td>A green icon indicates that each client of this type has an open connection with SAP BW server.</td>
</tr>
<tr>
<td><img src="#" alt="Yellow Icon" /></td>
<td>A yellow icon indicates that at least one client of this type is disconnecting.</td>
</tr>
</tbody>
</table>
A red icon indicates that there was a problem starting the RFC server or processing an SAP BW request.

If an RFC server interface has a red status, view the Status column and click the name of the interface to view the log details.

To restart, abort, or shut down an interface, click the Back button in the navigation bar to return to the RFC Server Interface Status page.

**Related Information**

Finding problems [page 86]

### 3.9.4.2 Monitoring interface statistics

The *RFC Server Interface Statistics* section lists each configured interface and statistics for that interface:

Table 41:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the RFC server interface.</td>
</tr>
<tr>
<td>Time connected</td>
<td>The total time that this interface has been connected to the SAP BW server.</td>
</tr>
<tr>
<td>Last message received</td>
<td>The length of time since the RFC server has received a message from SAP BW.</td>
</tr>
<tr>
<td>Last message sent</td>
<td>The length of time since the RFC server has sent a message to SAP BW.</td>
</tr>
<tr>
<td>Received messages</td>
<td>The number of messages that the RFC server has received from SAP BW.</td>
</tr>
<tr>
<td>Sent messages</td>
<td>The number of messages that the RFC server has sent to SAP BW.</td>
</tr>
</tbody>
</table>

### 3.9.4.3 Viewing RFC server interface logs

You can view the last three logs for an interface, each of which is 500 Kb in size. To view the logs for an interface, from the *RFC Server Interface Status* page, click the name of the interface. A page with two tabs displays:

- **RFC Server Log Viewer**: This tab displays the most recent log for the interface with the log path displayed at the top of the window.
- **RFC Server History Log**: This tab displays the previous two logs for the interface. Click a log name to view it.
3.9.5 Removing one or more RFC server interfaces

1. Under the SAP Connections node, click RFC server Interface.
2. On the RFC Server Interface Configuration tab, select the check box for one or more interfaces.
3. Click Remove.

3.10 Adapters

An SAP Data Services adapter is a Java program that allows Data Services to communicate with front-office and back-office applications. Depending on the adapter implementation, adapter capabilities include the ability to:

- Browse application metadata.
- Import application metadata into the repository.
- Move batch and real-time data between Data Services and information resource applications.

Adapters can handle the following types of metadata: tables, documents, functions, outbound messages, and message functions. Each of these can be used in real-time or batch jobs. Outbound messages and message functions are the only objects that include operations.

An adapter can process several predefined operations. An operation is a unit of work or set of tasks that the adapter completes. Operations include:

- Taking messages from an application and send them to a real-time service for processing, possibly returning a response to the application.
- Taking messages from a real-time service and send them to an application for processing, possibly returning a response to the real-time service.
- Taking messages produced by a function call inside a real-time service, send the messages to an application, and return responses to the function.

An adapter connects Data Services to a specific information resource application. You can create one or more instances of an adapter. Each adapter instance requires a configuration file. That configuration file defines the operations available.

All adapters communicate with Data Services through a designated Job Server. You must first install an adapter on the Job Server’s computer before you can use the Administrator and Designer to integrate the adapter with Data Services. See your specific adapter’s documentation for its installation instructions.

After installing the adapter, configure its instances and operations in the Administrator before creating adapter datastores in the Designer, because you must select an adapter instance name as part of an adapter datastore configuration. It might help to think of the Adapter Instances node of the Administrator as part of your adapter datastore configuration.

To enable an adapter datastore connection:

**Tip**

Adapter installation and configuration information appears in Supplement for Adapters. You should also keep the Designer Guide and the Administrator Guide handy for reference.
1. Use the Server Manager to configure a Job Server that supports adapters.
2. Use the Administrator to add, configure, and start an adapter instance using the Adapter Instances node.
3. Use the Designer to create an adapter datastore and import metadata. Use the metadata accessed through the adapter to create batch and/or real-time jobs.

### 3.11 Support for Web Services

For information about using SAP Data Services as both a Web services server and client, see the Integrator Guide.

### 3.12 Troubleshooting the Administrator

The Administrator provides status and error information. Use this information to discover problems with your implementation and to find the source of those problems. This section describes how you can use the Administrator to find and help resolve job processing issues.

**Related Information**

- Reestablishing network connections [page 85]
- Finding problems [page 86]
- Error and trace logs [page 87]
- Resolving connectivity problems [page 92]
- Restarting the Access Server [page 93]

### 3.12.1 Reestablishing network connections

When you disconnect from your network and re-connect or otherwise change an IP address (Dynamic IPs), the Administrator encounters a database connection error.

To reestablish network connections for your repository, you can do one of two things:

- Rename the repository in the Administrator. This change forces the Administrator to drop and recreate the connection to the database.
- Restart the Administrator.
3.12.2 Finding problems

The Administrator uses colored indicators to show the status of the various system components. Generally, the indicators mean the following:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🟢</td>
<td>A green icon indicates that the object is running properly.</td>
</tr>
<tr>
<td>🟠</td>
<td>A yellow icon indicates that some aspect of this object is not working. Either the Access Server is in the process of its error-handling efforts to reestablish an operation, or the Access Server is waiting for a manual intervention. For example, when you first add a service to the Access Server configuration, the service displays a yellow icon until you manually start the service or until you restart the Access Server.</td>
</tr>
<tr>
<td>🔴</td>
<td>A red icon indicates that one or more aspects of this object is not working, and the error handling efforts of Access Server were not able to reestablish the operation of the object.</td>
</tr>
</tbody>
</table>

When you see a yellow or red icon, the system requires manual intervention. You must:

- Determine which object is not operating properly.
- Determine the cause of the problem.
- Fix the problem.
- Restart the affected service providers if necessary.

3.12.2.1 Determining which object is not operating properly

1. In the Administrator, click Home.
   If there is an error anywhere in the system, you will see a red indicator next to a repository or Access Server name.
2. If you see a red indicator, click a repository or Access Server name.
   The page for that repository or Access Server appears.
3. Look for another red indicator on objects listed at this level.
4. If you can identify lower-level objects that have a red indicator, repeat the previous two steps.
   When you have identified the lowest level object with the error, you are ready to determine the cause of the error.

3.12.2.2 Determining the cause of the error

1. Examine the error log for the affected subsystem, such as a batch job, a service provider, or an adapter interface, or for the Access Server itself.
   Use the timestamp on the error entries to determine which error accounts for the problem that you are experiencing.
2. Cross-reference the error to the trace information. When you identify the appropriate error message, you can use the timestamp to determine what other events occurred immediately before the error.

For example, if an error occurred for a specific service provider, you can use the error timestamp in the service provider error log to look up Access Server activities that preceded the error.

### 3.12.3 Error and trace logs

The Administrator provides access to trace and error log files for each service provider, each batch job that ran, and for the Access Server. Use these detailed log files to evaluate and determine the cause of errors.

You can set a period of time to save these log files. After the set time expires, the software deletes all log files.

#### 3.12.3.1 Batch job logs

The **Batch Jobs Status** page provides access to trace, monitor, and error log files for each batch job that ran during a specified period.

The **Batch Jobs Status** page also includes a button named **Ignore Error Status** and **Delete**. These buttons are important job monitoring tools for administrators to help them solve job execution problems.

⚠️ **Caution**

Do not use these buttons unless you fully understand what they are for. Read about monitoring jobs in the **Administrator Guide**.

**Related Information**

[Setting the status interval](page 25)

#### 3.12.3.1.1 Viewing a batch job trace log

The trace log file lists the executed steps and the time that execution began. Use the trace log to determine where an execution failed, whether the execution steps occurred in the order you expect, and which parts of the execution were the most time-consuming.

1. Select **Batch Jobs** \(<repository>\).
2. Identify the instance of the job execution in which you are interested by the job name, start time, and so on.
3. Under **Job Information** for that instance, click **Trace**.

The Administrator opens the Job Trace Log page.
3.12.3.1.2 Viewing a batch job error log

The error log file shows the name of the object that was executing when an error occurred and the text of the resulting error message. If the job ran against SAP application data, the error log might also include ABAP errors.

Use the error log to determine how an execution failed. If the execution completed without error, the error log is blank.

1. Select Batch Jobs <repository>.
2. Identify the instance of the job execution in which you are interested by the job name, start time, and so on.
3. Under Job Information for that instance, click Error.
   The Administrator opens the Job Error Log page.

3.12.3.2 Service provider logs

The Service Provider Status page provides access to the error and trace log files for a service provider. These are the log files produced by the Job Server that controls the service provider.

3.12.3.2.1 Viewing the logs for a service provider

2. Click the name of a service.
   The Administrator opens the Real-time Service Status page. This page shows a list of service providers for the service and overall statistics for the service.
3. Click the name of the service provider process ID in which you are interested.
   The Administrator opens the Service Provider Status page.
4. Click a link to view the desired service provider log.
   To delete these logs, set the log retention period. To filter the list of real-time services on the Real-time Service Status page by date, set the status interval.

Table 43:

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace Log</td>
<td>Opens the Trace Log page for the current service provider execution.</td>
</tr>
<tr>
<td></td>
<td>This link appears only if the real-time service is registered with the Access Server.</td>
</tr>
</tbody>
</table>
The computer running the Job Server stores text files containing the batch and service provider trace, error and monitor logs. If you installed SAP Data Services in the default installation location, these files are located in the `<DS_COMMON_DIR>/Logs/<JobServerName>/<RepoName>` folder.

The name of the log file describes the contents of the file: `<type>_<timestamp>_<sequence>_<jobname>.txt`, where:

- `<type>` is trace, monitor, or error.
- `<timestamp>` is the system date and time from when the job created the log.
- `<sequence>` is the number of this job related to all jobs run by this Job Server instance.
- `<jobname>` is the name of the job instance.

Batch job trace and error logs are also available on the Log tab of the Designer project area. To see the logs for jobs run on a particular Job Server, log in to the repository associated with the Job Server when you start the Designer.

**Related Information**

Setting the status interval [page 25]

### 3.12.3.3 Access Server logs

Trace and error logs for each Access Server are available in Real-Time > <Access Server> > Logs-Current and Real-Time > <Access Server> > Logs-History. In addition, these files are located in the Access Server configuration location, which you specify when you configure the Access Server.

**Note**

For remote troubleshooting, you can also connect to any Access Server through the Administrator.

### 3.12.3.3.1 Viewing the current day's logs

1. Select Real-time > <Access Server> > Logs-Current
2. This page lists the error log file followed by the trace log file. The Administrator shows the last 100,000 bytes of the Access Server error log or trace log for the current date.

   The date of the file is included in the name:
   ○ error_MM_DD_YYYY.log
   ○ trace_MM_DD_YYYY.log

3. To view a file, click the file name. The Administrator shows the last 100,000 bytes of the Access Server error log or trace log for the current date.
   ○ The error log contains error information that the Access Server generates.
   ○ The trace log contains a variety of system information. You can control the information the Access Server writes to the trace log.

Related Information

Configuring the trace log file [page 90]

3.12.3.3.2 Viewing the previous day’s logs

1. Select [Real-Time] [Access Server] [Logs-History].

2. This page lists error log files followed by trace log files. The date of the file is included in the name:
   ○ error_MM_DD_YYYY.log
   ○ trace_MM_DD_YYYY.log

3. To view a file, click the file name.

3.12.3.3.3 Configuring the trace log file

1. Select [Real-Time] [Access Server] [Logs-Current].

2. Click the Access Server Log Configuration tab.

3. Under Log Contents, the Administrator lists several trace parameters that control the information that the Access Server writes to the trace file.

Table 44:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>Writes a message when an Access Server connection to the Administrator changes.</td>
</tr>
<tr>
<td>Flow</td>
<td>Writes a message when an Access Server exchanges information with a real-time service.</td>
</tr>
<tr>
<td>Request</td>
<td>Writes a message when an Access Server receives requests.</td>
</tr>
</tbody>
</table>
### Name | Description
---|---
Security | Writes a message when an Access Server processes authentication information (IP addresses, user name, or password).  
Service | Writes a message when an Access Server starts or stops a service.  
System | Writes a message when an Access Server initializes, activates, or terminates.  
Failed_request | Writes a message when a request to the Access Server fails.

4. Select the check box next to the name if you want the Access Server to write corresponding messages to the trace log file.
5. Under Log Tracing, select the Enabled check box.
6. Click Apply.

   The Administrator changes the Access Server configuration. The Access Server will now write the selected trace messages to the trace log.

**Note**
Until you set the parameters on this page, the Access Server uses the startup parameters to determine trace options. Each time you restart the Access Server, the startup parameters take precedence over parameters set on this page. You can control the content of this log by setting parameters when configuring the Access Server.

### Related Information

- Restarting the Access Server [page 93]
- Configuring Access Server output [page 67]
- Configuring an Access Server [page 68]

### 3.12.3.3.4 Deleting Access Server logs

2. Select the check box next to any log file that you want to delete.
   Alternatively, to delete all of the log files, select the Select all check box.
3. Click Clear or Delete.

   The Administrator clears the file size for current logs and deletes the selected history files from the display and from the Access Server log directory.
3.12.3.4 Adapter logs

For more detailed information about an adapter or an adapter’s operations, see the adapter’s error and trace log files.

3.12.3.4.1 Viewing log files for an adapter instance

1. Select Adapter Instance <Job Server>.
2. Find the adapter instance for which you want to view logs and from the Log Files column, click the Error Log or Trace Log link.
3. The corresponding page opens.

These log files are also found in the <DS_COMMON_DIR>\adapters\log directory. The error log file is named <adapter_instance_name>_error.txt and the trace log file is named <adapter_instance_name>_trace.txt.

3.12.4 Resolving connectivity problems

If you have determined that you have connectivity problems among your real-time system components, consider the following possible failures:

- **Application client cannot connect to Access Server**
  For example, an error appears in the logs generated by your application client or in the command prompt when you execute the client test utility that looks like this:

- **Error: unable to get host address**
  If you specified an IP address and received this error, your network might not support static IP address resolution. Try using the computer name instead.
  Match the port number that you specified in the client test utility (or in the Message Client library call) to the Access Server’s port number.
  Make sure that the port that you specified is not in use by other applications on the computer where an Access Server is installed.

- **Access Server cannot connect to Job Server**
  If this error occurs, you would see a red indicator for a service provider and an error log for the Access Server.
  Match the host name and port number of the Job Server for the service being called (configured in the Administrator) to the host name and port number that the Job Server is configured to use (as listed in the Server Manager).
  To make sure that the Job Server is running, check the Windows Task Manager for the Al_jobobserver.exe and Al_jobservice.exe processes or open the Designer, log in to the repository that corresponds to the Job Server, and look for the Job Server icon at the bottom of the window.

- **Job Server cannot start real-time service**
  If this error occurs, the status indicator for the related service and its service provider would be red and you would be able to open the error log file from the Service Provider Status page.
  Make sure that the job is properly indicated for the service called in the Real-Time Service Status page.
  Make sure that the real-time jobs are available in the repository associated with the Job Server.
Make sure the repository and the Access Server are connected to the Administrator and that the repository is available. If you change the password for your repository database, the Job Server will not be able to start real-time services. To fix this problem, re-register your repository in the Administrator and reconfigure the real-time services.

- **Real-time service cannot register with Access Server**
  If this error occurs, you would see:
  - A red indicator for the service provider.
  - An error log in the Logs-Current page (the startup timeout will eventually be triggered).
  - An error log available from the Service Provider Status page.
  Make sure the Access Server host name correctly identifies the computer where the Access Server is running.

- **Access Server cannot connect back to application client**
  If this error occurs, you would see an error log under the Access Server’s Logs-Current node.
  Make sure that the host name and port used by the message broker client to communicate with the Access Server is correct.

### 3.12.5 Restarting the Access Server

To restart the Access Server, you can use either of two methods:

- **Controlled Restart**
  The Access Server responds to new and queued messages with a shutdown error. It waits for service providers to complete processing existing messages, then returns the responses to those clients. Next, the Access Server closes existing client connections (including adapters), stops, and restarts itself. Finally, the Access Server reads the current configuration settings and restarts services, service providers, and adapters. Restarting the Access Server this way requires as much time as it takes to process requests in the system.

- **Abort and Restart**
  The Access Server responds to new and queued messages with a shutdown error. It shuts down existing service providers and responds to these messages with a shutdown error. Next, the Access Server closes existing client connections (including adapters), stops, and restarts itself. Finally, the Access Server reads the current configuration settings and restarts services, service providers, and adapters.

#### 3.12.5.1 Performing a controlled restart of the Access Server

1. Select **Real-Time** > `<Access Server>` > **Status**.
2. Under **Life Cycle Management**, click **Controlled Restart**.
3. Click the **Real-Time Services** node to verify that all services started properly.

   The Access Server allows running services to complete and returns incoming and queued messages to the client with a message that the Access Server has shut down. When all services have stopped, the Access Server stops and restarts itself. The Access Server reads the new configuration settings and starts services as indicated.

   If all service providers started properly, the Real-Time Service Status page shows a green indicator next to each service name. A red indicator signifies that a component of the service did not start.
3.12.5.2 Performing an abort and restart of the Access Server

3. Click the `Real-Time Services` node to verify that all services started properly.
4 Metadata Reports

This section describes the overall requirements for enabling and viewing metadata reports including software and configuration requirements and logging in to the Management Console.

4.1 Requirements

Use the SAP Data Services Administrator to configure repositories for metadata reporting applications to access.

To make metadata reports available for objects, the metadata reporting applications require:

- A web application server
- JDBC drivers to connect to a repository
- Configured repositories

4.2 Repository reporting tables and views

The SAP Data Services repository is a database that stores your software components and the built-in design components and their properties. The open architecture of the repository allows for metadata sharing with other enterprise tools.

Within your repository, the software populates a special set of reporting tables with metadata describing the objects in your repository. When you query these tables, you can perform analyses on your applications.

The following table lists the Metadata reporting tables and what they contain:

<table>
<thead>
<tr>
<th>Name</th>
<th>Contains</th>
</tr>
</thead>
<tbody>
<tr>
<td>AL_ATTR</td>
<td>Attribute information about native objects</td>
</tr>
<tr>
<td>AL_AUDIT</td>
<td>Audit information about each data flow execution</td>
</tr>
<tr>
<td>AL_AUDIT_INFO</td>
<td>Information about audit statistics</td>
</tr>
<tr>
<td>AL_CMS_BV</td>
<td>Components of a Business View</td>
</tr>
<tr>
<td>AL_CMS_BVFIELDS</td>
<td>Business Fields within Business Elements in a Business View</td>
</tr>
<tr>
<td>AL_CMS_REPORTS</td>
<td>Information that uniquely identifies Crystal Reports reports, SAP BusinessObjects Desktop Intelligence documents, or SAP BusinessObjects Web Intelligence documents</td>
</tr>
<tr>
<td>AL_CMS_REPORTSUSAGE</td>
<td>Tables, columns, or Business Views that a Crystal Reports report, SAP BusinessObjects Desktop Intelligence document, or SAP BusinessObjects Web Intelligence document uses</td>
</tr>
<tr>
<td>Name</td>
<td>Contains</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AL_CMS_FOLDER</td>
<td>Folder names in which a Crystal Reports report, SAP BusinessObjects Desktop Intelligence document, or SAP BusinessObjects Web Intelligence document resides</td>
</tr>
<tr>
<td>AL_HISTORY</td>
<td>Execution statistics about jobs and data flows</td>
</tr>
<tr>
<td>AL_INDEX</td>
<td>Index information about imported tables</td>
</tr>
<tr>
<td>AL_LANG</td>
<td>Information about native (.atl) objects</td>
</tr>
<tr>
<td>AL_LANGXMLTEXT</td>
<td>Information about objects represented in XML format</td>
</tr>
<tr>
<td>AL_PCOLUMN</td>
<td>Column information about imported table partitions</td>
</tr>
<tr>
<td>AL_PKEY</td>
<td>Primary key information about imported tables</td>
</tr>
<tr>
<td>AL_QD_VRULE</td>
<td>Validation rule names</td>
</tr>
<tr>
<td>AL_QD_VRULE_OFLOW</td>
<td>Rule name if it cannot fit it into AL_QD_VRULE (if there is an overflow)</td>
</tr>
<tr>
<td>AL_QD_STATS</td>
<td>Runtime validation rule statistics</td>
</tr>
<tr>
<td>AL_QD_ROW_DATA</td>
<td>Sample row data for which the validation rules have failed</td>
</tr>
<tr>
<td>AL_QD_COLINFO</td>
<td>All the column information for the failed validation rules</td>
</tr>
<tr>
<td>AL_USAGE</td>
<td>All ancestor-descendant relationships between objects</td>
</tr>
<tr>
<td>ALVW_COLUMNATTR</td>
<td>Attribute information about imported columns</td>
</tr>
<tr>
<td>ALVW_COLUMNINFO</td>
<td>Information about imported column</td>
</tr>
<tr>
<td>ALVW_FKREL</td>
<td>Primary-foreign key relationships among imported tables</td>
</tr>
<tr>
<td>ALVW_FLOW_STAT</td>
<td>Execution statistics about individual transforms within data flows</td>
</tr>
<tr>
<td>ALVW_FUNCINFO</td>
<td>Information about both native functions and functions imported from external systems</td>
</tr>
<tr>
<td>ALVW_MAPPING</td>
<td>Mapping and lineage information for target tables</td>
</tr>
<tr>
<td>ALVW_PARENT_CHILD</td>
<td>Direct parent-child relationships between objects</td>
</tr>
<tr>
<td>AL_SETOPTIONS</td>
<td>Option settings for all objects</td>
</tr>
<tr>
<td>ALVW_TABLEATTR</td>
<td>Attribute information about imported (external) tables</td>
</tr>
<tr>
<td>ALVW_TABLEINFO</td>
<td>Information about imported tables</td>
</tr>
</tbody>
</table>

**Note**

This is not the complete list because some repository tables and views are for internal use.

The software automatically creates reporting tables for each new or upgraded repository. Except for AL_USAGE, the software automatically updates all reporting tables.
5 Impact and Lineage Analysis Reports

The Impact and Lineage analysis provides a simple, graphical, and intuitive way to view and navigate through various dependencies between objects that are within the Data Services local repository.

Impact and lineage analysis allows you to identify which objects are affected if you change or remove other connected objects.

For example for impact analysis, a typical question might be, “If I drop the source column Region from this table, what targets are affected?”

For lineage analysis, the question might be, “Where does the data come from that populates the Customer_ID column in this target?”

In addition to the objects in your datastores, impact and lineage analysis allows you to view the connections to other objects including classes and objects, Business Views, Business Elements and Fields, and reports (Crystal Reports, SAP BusinessObjects Desktop Intelligence documents, and SAP BusinessObjects Web Intelligence documents).

**Note**

SAP Information Steward has additional impact and lineage capabilities, including the ability to combine metadata from multiple external systems such as SAP BusinessObjects Enterprise and Hadoop.

5.1 Navigation

From the Management Console home page, view impact and lineage information by clicking the **Impact and Lineage Analysis** link.

The Impact and Lineage Analysis page contains two primary panes:

- The left pane contains a hierarchy (tree) of objects. The top of the tree is the default repository. This pane also includes a search tool.
- The right pane displays object content and context based on how you navigate in both panes.

In general, expand the tree in the left pane by clicking plus signs (+) next to object nodes. Select an object in the tree to learn more about it. Details associated with an object appear in the right pane on one or more tabs. Tabs vary depending on the object you select.

The top level of the navigation tree displays the current repository. (You can change this repository in the Settings control panel; for details, see Impact and Lineage Analysis Settings control panel [page 102].)

Objects in a repository include:

- Datastores—Contain tables and columns.
- CMS server(s)—This node contains folders as defined in the Central Management Console, and Business Views.
To narrow the view of objects to display in the navigation tree or to quickly find specific objects in the repository, use the **Objects to analyze** search feature. You can do one or both of the following:

1. Select a category in the **Select an object type** drop-down list:
   - Table and column
   - Class and object
   - Business view
   - Element and field
   - Report
   AND/OR
2. Search for a specific object by typing all or part of the object name in the search field. The search field is not case sensitive, spaces are allowed, and you can use the percent symbol (%) as a wildcard.
3. Click the search icon (binoculars).

Metadata Reports highlights with a red border each object that meets your search criteria.

- To repopulate the CMS navigation tree with any objects that might have been changed (added, deleted, renamed, and so on) in the CMS repository after you display an impact and lineage report, log out and log back in to the Management Console to display the changes.
- If you receive an error such as the following:

```
This image is scaled to 50% of the original image. You could avoid scaling the image by allocating more memory to the current java process.
```

it means the java process (JVM) does not have enough memory to process the current task. Circumvent this error by allocating more heap memory to the Java process associated with the Web server.

### 5.1.1 Increasing the java heap memory in Windows

1. In the Windows Services control panel, stop the Data Services Web Server.
2. In the installation directory, navigate to `\ext\WebServer\conf`.
3. Using a text editor, open the `wrapper.properties` file.
4. To allocate a minimum of 256 MB and a maximum of 512 MB to the java process, add the following parameters to `wrapper.cmd_line`:

```
-Xms256M -Xmx512M
```

The result will appear as follows:

```
wrapper.cmd_line=$(wrapper.javabin) -Xms256M -Xmx512M -Djava.endorsed.dirs==$(ACTAHOME)\ext\webserver\common\endorsed ...
```

5. Save and close the file.

### 5.1.2 Increasing the java heap memory in UNIX

1. Stop the Data Services Web Server.
2. In the installation directory, navigate to /ext/WebServer/bin.
3. Using a text editor, open the setclasspath.sh file.
4. To allocate a minimum of 256 MB and a maximum of 512 MB to the java process, add the following lines to the end of the setclasspath.sh file:

   ```
   JAVA_OPTS="-Xms256M -Xmx512M"
   export JAVA_OPTS
   ```

5. Save and close the file.

5.2 Analysis options

The following table lists the types of objects that can appear in the navigation tree and provides a summary of what information appears in the right pane when you select that object type.

To view or hide a pane in the display such as an attributes pane, click the up/down arrow in its header bar.

Moving the cursor over an object displays a pop-up window with more information about that object; for example:

- Table: Data flow (if applicable), datastore, and owner
- Business Objects report: Depending on the report type, the pop-up window displays the CMS server name or the Business View name for example.

The following table lists the objects in the navigation tree, the corresponding tabs, and the content of each.

<table>
<thead>
<tr>
<th>Object</th>
<th>Tab</th>
<th>Associated content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repository</td>
<td>Overview</td>
<td><strong>Repository name</strong>&lt;br&gt;<strong>Repository type</strong>—The database type&lt;br&gt;<strong>Repository version</strong>—The repository version number</td>
</tr>
<tr>
<td>Datastore</td>
<td>Overview</td>
<td>Overview information varies depending on the datastore type. The following entries apply to a datastore on Microsoft SQL Server.&lt;br&gt;<strong>Datastore type</strong>—Database&lt;br&gt;<strong>Database type</strong>—Microsoft_SQL_Server&lt;br&gt;<strong>User</strong>—&lt;Database user name&gt;&lt;br&gt;<strong>Case sensitive</strong>—Whether or not the database is case sensitive&lt;br&gt;<strong>Configuration</strong>—&lt;The configuration selected in the datastore editor&gt;&lt;br&gt;<strong>SQL_Server version</strong>—Microsoft SQL Server 2000&lt;br&gt;<strong>Database name</strong>—&lt;Database name&gt;&lt;br&gt;<strong>Server name</strong>—&lt;The host computer name&gt;</td>
</tr>
<tr>
<td>Object</td>
<td>Tab</td>
<td>Associated content</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Table  | Overview| *Table name*—Table name  <br>*Datastore*—Datastore to which this table belongs <br>*Owner name*—The table owner name in the database.  
<br>*Business name*—Business-use name of the table if defined  
<br>*Table type*—Table or template table  
<br>*Last update date*—When the software last updated the table |
| Impact |         | Graphically shows the end-to-end impact of the selected source table and the targets it affects. 
<br>Clicking a table in the Impact diagram displays the object’s attributes, which are the same as on the Overview tab. |
| Lineage|         | Contains the same information as on the Impact tab except it describes the flow from target to source. |
| Mapping tree | | Displays the overall mapping information for each column in the table. Select between *Group by data flow* or *Group by column*. |
| Column | Overview| *Column name*—Column name  
<br>*Table name*—Parent table of the column  
<br>*Data type*—The data type for the column  
<br>*Nullable*—yes/no  
<br>*Primary key*—yes/no  
<br>*Foreign key*—yes/no |
| Impact |         | Graphically shows the end-to-end impact of the selected source column and the targets it affects. 
<br>Clicking a column in the Impact diagram displays the object’s attributes, which are the same as on the Overview tab. |
| Lineage|         | Contains the same information as on the Impact tab except it describes the flow from target to source. 
<br>It also displays any data flow objects associated with the column. Move the cursor over a data flow icon to display a pop-up window with the mapping information. 
<br>Click on a data flow icon to open another pop-up window that displays the Auto Documentation information including mapping. Notice that in the auto documentation window, any objects that are not part of the lineage for this column are dimmed. |
<table>
<thead>
<tr>
<th>Object</th>
<th>Tab</th>
<th>Associated content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business View</td>
<td>Overview</td>
<td><em>Business View</em> name</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Folder</em>—The folder name on the CMS server to where the Business View has been</td>
</tr>
<tr>
<td></td>
<td></td>
<td>exported</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Last update date</em>—When the Business View was last updated in the Business View</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>CMS server</em>—The name of the CMS server for this Business View</td>
</tr>
<tr>
<td>Class</td>
<td>Overview</td>
<td><em>Class</em> name</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>CMS server</em>—The name of the CMS server for this class</td>
</tr>
<tr>
<td>Object</td>
<td>Overview</td>
<td><em>Object</em> name</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Class</em>—The class to which this object belongs</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>CMS Server</em>—The name of the CMS server for this object</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Source column</em>—The name of the source column for this object followed by the</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>&lt;owner.table name&gt;</em></td>
</tr>
<tr>
<td>Impact</td>
<td></td>
<td>Shows all of the reports that use the selected object</td>
</tr>
<tr>
<td>Lineage</td>
<td></td>
<td>Shows column-level lineage for the selected object</td>
</tr>
<tr>
<td>Business Element</td>
<td>Overview</td>
<td><em>Business element</em> name</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Business view</em>—The Business View to which this business element belongs</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>CMS server</em>—The name of the CMS server for this object</td>
</tr>
<tr>
<td>Business Field</td>
<td>Overview</td>
<td><em>Business field</em> name</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Business element</em>—The Business Element to which this Business Field belongs</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Business view</em>—The Business View to which this Business Field belongs</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>CMS server</em>—The name of the CMS server for this object</td>
</tr>
<tr>
<td>Impact</td>
<td></td>
<td>Shows all the reports that use the field.</td>
</tr>
<tr>
<td>Lineage</td>
<td></td>
<td>Shows column-level lineage for the selected Business Field.</td>
</tr>
<tr>
<td>Reports: Crystal</td>
<td>Overview</td>
<td><em>Report</em> name</td>
</tr>
<tr>
<td>and Web Intelligence/</td>
<td></td>
<td><em>Folder</em>—The folder on the CMS server where the report is stored</td>
</tr>
<tr>
<td>Desktop Intelligence</td>
<td></td>
<td><em>CMS server</em>—The name of the CMS server for this report</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Last update date</em>—When the report was last updated</td>
</tr>
</tbody>
</table>
### Table-level and column-level analysis

Impact and lineage analysis at the table level shows datastores, tables, and reports/documents.

Impact and lineage analysis at the column level shows datastores, objects, fields, and reports/documents.

### Impact and Lineage Analysis Settings control panel

The Impact and Lineage Analysis Settings control panel allows you to change the options for your reports. To open it, click **Settings** in the upper-right corner of the window.

#### 5.4.1 Settings tab

The Settings tab allows you to change repositories. Select a repository from the drop-down list box and click **Apply**.

#### 5.4.2 Refresh Usage Data tab

On the Refresh Usage Data tab, you can manually calculate column mappings.
5.4.2.1 Calculating column mappings

SAP Data Services can calculate information about target tables and columns and the sources used to populate them, for example for impact and lineage or auto documentation reports.

Calculating column mappings populates the internal ALVW_MAPPING view and the AL_COLMAP_NAMES table. The ALVW_MAPPING view provides current data to metadata reporting applications like Impact and Lineage Analysis. If you need to generate a report about a data flow that processes nested (NRDM) data, query the AL_COLMAP_NAMES table using a custom report.

Whenever a column mapping calculation is in progress, the Designer displays a status icon at the bottom right of the window. You can double-click this icon to cancel the process.

To calculate column mappings, you can:

- Enable the option in the Designer to automatically calculate column mappings.
- Execute the column mapping process manually from either the Designer or the Impact and Lineage Analysis application in the Management Console.

5.4.2.1.1 Automatically calculating column mappings

To set the option to automatically calculate column mapping information, in the Designer select Tools > Options > Designer > General > Automatically calculate column mappings. This option is selected by default.

Note that if the Designer option Automatically calculate column mappings is cleared, any subsequent changes made to the data flow require that you manually recalculate the column mappings to ensure the ALVW_MAPPING view and the AL_COLMAP_NAMES table have the most current information.

5.4.2.1.2 Manually calculating column mappings

If the Designer option Automatically calculate column mappings is cleared and you want to generate reports, you can manually calculate the mappings. You can manually calculate column mappings at any time in either the Designer or the Management Console.

In the Designer, right-click in the object library and select Repository > Calculate column mappings.

In the Management Console:
1. Select Impact and Lineage Analysis.
2. Open the Settings control panel.
3. Click the Refresh Usage Data tab.
4. Select the Job Server that is associated with the repository you want to use.
5. Click Calculate Column Mapping.

On the Impact and Lineage Analysis Overview tab, you can expand Data Flow Column Mapping Calculation to view a list of data flows and the calculation status of each. If the mapping calculation is complete, the Status indicator is checked.
5.4.3 About tab

This tab provides SAP Data Services version information.
6 Operational Dashboard

The Operational Dashboard has two tabs: **Dashboard** and **License Management**.

The **Dashboard** tab provides graphical depictions of SAP Data Services job execution statistics. Being able to see task statuses across repository organizations allows you to view the status and performance of your job executions for one or more repositories over a given time period.

You can use the information in the detailed visualized dashboard to:

- determine how many jobs succeeded or failed over a given time period.
- identify your performance by checking the CPU or buffer uses of dataflow.
- streamline and monitor your job scheduling and management for maximizing overall efficiency and performance.

For more information about how to use the dashboard to answer performance questions, see "Measuring Performance" in the *Performance Optimization Guide*.

The **License Management** tab enables you to generate a report which contains licensing information and CPU metrics for all of your registered job servers. You can then send the file containing the report to SAP's Global License Auditing Services (GLAS).

For more information about how to use license management, see the "License Management" topic.

### Related Information

- Job Execution History node [page 19]
- License Management [page 108]

### 6.1 Dashboard tab

The **Dashboard** tab displays a summary of executed jobs.

To view the dashboard, click **Operational Dashboard** on the Management Console home page, then **Dashboard**, if it is not already selected. To return to the Management Console home page, click **Home**.

The dashboard is divided into three parts:

- The pie chart shows task statuses (successful, failed, and warning).
- The bar chart shows the task execution time duration for a specific period of time.
- The table shows the repository name, job/task name, start and end time, execution time, and status for all aggregated tasks.

The **Available Repositories** drop down allows you to view job execution history for all repositories (default) or just one.
You can also search job execution history by time period.

- Last 24 hours (default)
- Last 7 days
- Last 30 days
- All

### 6.1.1 Job Execution Status pie chart

The pie chart displays status information for jobs running on one or more repositories during a specific time period.

The chart identifies the number and ratio of jobs that succeeded, had one or more warnings, had one or more errors, or are still currently running.

### 6.1.2 Job Execution Statistics History bar chart

The Job Execution Statistics History bar chart shows the trend of the execution status.

The bar chart displays job execution numbers, which are broken down into four month periods. It provides you with the following information:

- Number of jobs that completed successfully
- Number of jobs that failed
- Number of jobs that completed with warnings

### 6.1.3 Job Execution table

The Job Execution table lists all the aggregated tasks for a repository.

You can do the following with the information in this table:

- Filter the data by selecting a Start Time and an End Time. Once you specify dates and times, click Apply.
- Sort the data in a column by clicking on the column heading and selecting a sort option. For example, most columns can be sorted in ascending or descending order.
- Click Export to save the data to a .csv file.
- Drill into the data for more details. Double click on a row to open the Job Execution Details page for a job.

The table displays the following information:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repository name</td>
<td>The repository associated with this job.</td>
</tr>
<tr>
<td>Job name</td>
<td>The name of the job in the Designer.</td>
</tr>
</tbody>
</table>
### 6.1.3.1 Job Execution Details window

The Job Execution Details window shows execution history data for a job.

The following information is available in this window:

- The Job Execution History table shows the history of a job. The following information is available:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repository name</td>
<td>The repository associated with this job.</td>
</tr>
<tr>
<td>Job name</td>
<td>The name of the job in the Designer.</td>
</tr>
<tr>
<td>Start time and End time</td>
<td>The start and end timestamps in the format <a href="">hh:mm:ss</a>.</td>
</tr>
<tr>
<td>Execution time</td>
<td>The elapsed time to execute the job.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the job. To filter the data in the table by status, click the Status column heading and select an option.</td>
</tr>
<tr>
<td>RunID</td>
<td>An identifier that represents a single job over its duration.</td>
</tr>
</tbody>
</table>

- The Job Execution History Status pie chart shows the status of the task that is highlighted in the Job Execution History table. Green indicates the task was a success, yellow indicates that there were warnings, and red indicates that there were errors.

- The Job Details table shows data flow information and indicates if audit data is available.

### 6.1.3.1.1 Viewing thread information for a data flow

To view information about the first thread in a data flow, do the following:

1. Select an item in the Job Details table. Three bar charts appear showing you information about the buffer used, row processes, and the CPU used.
2. To view information about another thread, select a name from the Thread Name drop-down.
6.1.3.1.2 Viewing audit details

If auditing is enabled for a job, the Contains Audit Data column in the Job Details table indicates if audit data is available. To view audit information, click View Audit Data.

The Audit Details window opens and provides the following information:

- An audit rule summary, if applicable
- A table with audit labels and values

For more information about auditing, see "Using auditing" in the Designer Guide.

6.2 License Management

Use the license management feature to generate a report which contains licensing information and CPU metrics for all of your registered job servers.

To view the License Measurement tab, click Operational Dashboard on the Management Console home page, then License Management, if it is not already selected. To return to the Management Console home page, click Home.

The pane on the left of the window lists all of the measurement reports. Use the filter to display different time periods. The pane on the right displays the contents of the .xml file for the selected time period.

Click the New Measurement button to collect current licensing information for all of your registered servers into a single report, which is saved as an .xml file on the Central Management Server (CMS).

If requested by SAP's Global License Auditing Services (GLAS) to provide a license management report, click Export to download the .xml report to a local server where you can access it. SAP’s GLAS group will provide you with instructions for sending the report to them.

i Note

If the CMS is deployed on clustered BOE, you should configure the FRS (File Repository Server) as a shared folder. You can find information on how to do this in SAP Note 2341002.
7 Data Validation Dashboard Reports

Data Validation dashboard reports provide graphical depictions that let you evaluate the reliability of your target data based on the validation rules you created in your SAP Data Services batch jobs. This feedback allows business users to quickly review, assess, and identify potential inconsistencies or errors in source data.

7.1 Configuring Data Validation dashboards

Create meaningful data validation dashboards.

The following steps describe the process for generating meaningful Data Validation dashboards.

1. In your jobs in Designer, create data flows that contain validation transforms with validation rules. You use validation transforms to:
   ○ Verify that your source data meets your business rules.
   ○ Take the appropriate actions when the data does not meet your business rules.

2. In the Data Validation application of Management Console, create functional areas. A functional area is a virtual group of jobs that relate to the same business function, for example Human Resources or Customers. Functional areas can contain multiple jobs and one or more data validation business rules.

3. In the Data Validation application, create business rules. Business rules are typical categories of data, for example Social Security Number or Address. These business rules contain validation rules that you created in your validation transforms in your data flows.

After you complete this process, begin to create validation dashboards by opening the Data Validation application in the Management Console.

Related Information

Creating functional areas [page 109]
Creating business rules [page 110]

7.1.1 Creating functional areas

After you create data flows with validation transforms and rules in Designer, next create functional areas.

Note

If you do not create any functional areas, the dashboard displays statistics for all jobs for the selected repository.
1. In the Data Validation module, click the Settings link.
   
   The Repository tab displays.

2. Verify the desired repository displays.
   
   To change the repository, select a different one from the drop-down list and click Apply.

3. Click the Functional area tab.
   
   The selected repository displays.

4. Type a name for the new functional area (such as Customer) and optionally a description.

5. Click Save.
   
   A list of batch jobs (and the associated system configuration for each, if any) appears that lets you select the jobs you want to include in this functional area.
   
   You can change the sort order of the table by clicking the arrow in a column heading.

6. From the list of Available batch jobs, select the check box for each job to include in this functional area and click the arrow button to move it to the Associated batch jobs window.
   
   ○ Jobs are not reusable among functional areas.
   
   ○ In the Administrator, deleting job information on the Batch Job Status page (Batch Jobs History) also clears data validation statistics from Data Validation Metadata Reports.

7. Click Apply to save the changes and keep the Functional area window open, for example to add more functional areas.

   Clicking OK saves your changes and closes the Settings control panel.

   Clicking Cancel closes the Settings control panel without saving changes.

To add another functional area, on the Functional area tab click Add and follow steps 4 through 7 in the previous procedure.

To display a different functional area for editing, select it from the drop-down list.

Delete a functional area by clicking Delete next to the functional area selected in the drop-down list.

Next, create business rules to associate the validation rules in your data flows with your functional areas.

### 7.1.2 Creating business rules

After creating functional areas, associate the business rules to each functional area as follows.

> **Note**
>
> If you do not create business rules, each validation rule in the jobs that you have associated with a functional area becomes its own business rule.

1. In the Settings control panel, click the Business rule tab.

   On the Business rule tab, the default repository displays. (To change the repository, click the Repository tab, select a different repository, and click Apply.)

2. From the drop-down list, select the functional area to which this business rule will belong.
3. In the business rule definition area, type a name for the business rule such as *Phone number*.

4. Select a priority for how significant this group will be to your business end users: High, Medium, or Low.

5. Type an optional description for the business rule such as *Phone and FAX*. In this example, the validation rule checks to see if telephone and fax numbers in the USA conform to the seven-digit standard.

6. Click *Save*.

   A list of validation rules appears. Select the validation rules you want to include in this business rule. See the following table for a description of the columns in the lists of validation rules (scroll horizontally to view the other columns).

7. From the list of *Available validation rules*, select the check box for all of the rules to include in this business rule and click the arrow button to move it to the Associated validation rules pane.

   **Note**

   Validation rules are not reusable among business rules (you can use a validation rule only once and only in one business rule).

8. Click *Apply* to save the changes and keep the *Business rule* window open, for example to add more business rules.

   Clicking *OK* saves your changes and closes the Settings control panel.

   Clicking *Cancel* closes the Settings control panel without saving changes.

The columns in the validation rule lists are as follows. Scroll horizontally to view the other columns. Note that you can change the sort order of the tables by clicking the arrow in a column heading.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validation rule name</td>
<td>The validation rule name. The default is the column name, unless you create a new name in the Validation transform <em>Properties</em> dialog box.</td>
</tr>
<tr>
<td>Description</td>
<td>The description for the validation rule.</td>
</tr>
<tr>
<td>Full path</td>
<td>Describes the hierarchy in the software from the job level to the data flow level to indicate where this validation rule has been defined.</td>
</tr>
<tr>
<td>System configuration</td>
<td>The name of the system configuration selected for this job.</td>
</tr>
</tbody>
</table>

To add another business rule, on the *Business rule* tab click *Add* and follow steps 3 through 8 in the previous procedure.

To display a different functional area so you can edit its business rules, select it from the *Functional area* drop-down list.

To display a different business rule for editing, select it from the *Business rule* drop-down list.

Delete a business rule by clicking *Delete* next to the business rule selected in the drop-down list.
7.1.3 Enabling data validation statistics collection

To enable data validation statistics collection for your reports, you must verify two options—one at the validation transform level and one at the job execution level.

7.1.3.1 Validation transform level

In Designer, navigate to the validation transforms from which you want to collect data validation statistics for your reports. For the columns that have been enabled for validation, in the transform editor click the Validation transform options tab and select the check box Collect data validation statistics.

7.1.3.2 Job execution level

When you execute a job, the Execution Properties window displays. On the Parameters tab, clear the option Disable data validation statistics collection (the default) before executing the job.

To execute a job without collecting statistics, select the Disable data validation statistics collection option, which suppresses statistics collection for all the validation rules in that job.

7.2 Viewing Data Validation dashboards

To view Data Validation dashboards, on the Management Console Home page, click Data Validation. The functional area view displays.

The upper-right corner identifies the repository for the reports you are viewing. You can change the repository to view in the Settings control panel.

Some dashboards let you to drill in to some of the components for more details. The navigation path at the top of the window indicates where you are in the Data Validation dashboard reports hierarchy. Click the hyperlinks to navigate to different levels.

Related Information

Functional area view [page 113]
Repository tab [page 117]
7.3 Functional area view

The top-level Data Validation dashboard view is the functional area view. This view includes two dashboards:

<table>
<thead>
<tr>
<th>Dashboard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functional area pie chart</td>
<td>A current (snapshot) report.</td>
</tr>
<tr>
<td>History line chart</td>
<td>A historical (trend) report that displays trends over the last 7 days.</td>
</tr>
<tr>
<td></td>
<td>To display this chart, click the link below the pie chart.</td>
</tr>
</tbody>
</table>

To change the functional area dashboards to view, select a different functional area from the drop-down list at the top of the window. Select All to view data for all batch jobs in that repository.

If there are no functional areas defined, the chart displays statistics for all jobs for the selected repository.

Related Information

- Functional area pie chart [page 113]
- History line chart [page 114]

7.3.1 Functional area pie chart

The pie chart displays status information for jobs that ran in the time period displayed. The data collection period begins at the time set on the Repository tab in the Settings control panel and ends with the time you open the report Web page.

The color codes on this chart apply to the volume of validation rules that passed or failed:

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>The percentage of rules that passed for the selected functional area.</td>
</tr>
<tr>
<td>Red</td>
<td>The percentage of rules that failed for the selected functional area with a High priority label.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>If you have All selected for Functional area, the failed portion appears red and does not include priority information.</td>
</tr>
<tr>
<td>Orange</td>
<td>The percentage of rules that failed for the selected functional area with a Medium priority label.</td>
</tr>
<tr>
<td>Blue</td>
<td>The percentage of rules that failed for the selected functional area with a Low priority label.</td>
</tr>
</tbody>
</table>

Click on the failed pie “slices” to drill into the report:

- If there is at least one functional area and business rule defined, the Business rule view displays.
If no functional areas or business rules are defined, the Validation rule view displays.

Related Information

Repository tab [page 117]
Business rule view [page 114]
Validation rule view [page 115]
Creating business rules [page 110]

7.3.2 History line chart

The History line chart displays the percentage of all validation rule failures that occurred on each of the last seven days. The software collects the number of failures for the last run of all of the batch jobs that are associated with this functional area on each day.

To display the History line chart, click the link below the pie chart.

7.4 Business rule view

The Business rule dashboard is a bar chart that shows the percentage of validation failures for each defined business rule. You access this chart by clicking on one of the failed “slices” of the functional area pie chart.

Note

If no functional areas or business rules have been defined, drilling down on the functional area pie chart displays the Validation rule view. Therefore, the “business rules” are the same as the validation rules.

The data collection period begins at the time set on the Repository tab in the Settings control panel and ends with the time you open the report Web page.

You can filter the view by selecting an option from the Priority drop-down list:

- All
- High priority
- Medium priority
- Low priority

The chart displays 10 bars per page; click the Next or Previous links to view more.

To view the business rules associated with another functional area, select it from the Functional area drop-down list.

To see the validation rules that apply to a particular business rule, click on that bar in the chart. The Validation Rule View displays.
Related Information

Repository tab [page 117]
Validation rule view [page 115]

7.5 Validation rule view

When you view the Functional area pie chart (the Data Validation Home page) and click on one of the failed pie “slices” to drill into the report, if no functional areas or business rules have been defined, the Validation rule view displays.

The Validation Rule page includes two dashboards:

Table 52:

<table>
<thead>
<tr>
<th>Dashboard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validation rule bar chart</td>
<td>A current (snapshot) report.</td>
</tr>
<tr>
<td>History line chart</td>
<td>A historical (trend) report that displays trends over the last 7 days. To display this chart, click the link below the Validation rules bar chart.</td>
</tr>
</tbody>
</table>

The chart displays 10 bars per page; click the Next or Previous links to view more.

To view the validation rules for a different business rule, select it from the Business rule drop-down list.

Related Information

Validation rule bar chart [page 115]
History line chart [page 116]

7.5.1 Validation rule bar chart

The Validation rule bar chart displays the percentage of rows that failed for each validation rule.

The Data collection period begins at the time set on the Repository tab in the Settings control panel and ends with the time you open the report Web page.

You can click on a bar to display the Sample data view.
Related Information

Repository tab [page 117]
Sample data view [page 116]

### 7.5.2 History line chart

The History line chart displays the percentage of all validation rule failures that occurred on each of the last seven days. The software collects the number of failures for the last run of all of the batch jobs that are associated with this functional area.

To display this chart, click the link below the Validation rules bar chart.

### 7.6 Sample data view

If you have enabled the option to collect sample data in a validation transform, the Sample data page includes two images:

- Sample data table [page 116]
- History line chart [page 116]

If you have not configured the validation transform to collect sample data, only the History line chart displays.

To view sample data from another validation rule, select it from the drop-down list.

#### 7.6.1 Sample data table

If you have configured the validation transform to collect sample data, this page displays up to 50 rows of sample data in tabular form.

The column that maps to the currently selected validation rule appears highlighted.

#### 7.6.2 History line chart

The History line chart displays the percentage of all validation rule failures that occurred on each of the last seven days. The software collects the number of failures for the last run of all of the batch jobs that are associated with this functional area.

To display this chart, click the link below the sample data table.
7.7 Data Validation dashboards Settings control panel

The dashboard settings window allows you to change the options for your reports.

In the upper-right corner of the window, click Settings.

The three settings tabs are:

- Repository tab [page 117]
- Functional area tab [page 117]
- Business rule tab [page 117]

For all of the Settings pages:

- Click Apply to save the changes and keep the Business rules dialog box open, for example to add more business rules.
- Clicking OK saves your changes and closes the Settings control panel.
- Clicking Cancel closes the Settings control panel without saving changes.

7.7.1 Repository tab

The settings on the Repository tab include:

- Repository—Select a repository to view from the drop-down list.
- View data starting at—Enter the time from when you want start viewing data in the format HH:MM (from 00:00 to 23:59). On the Data Validation dashboard charts, the end of the time window is the moment you open one of the dashboard Web pages.
  For example, entering 02:00 means your data validation reports will display data from the repository starting at 2:00 a.m. through the time you open the report page. Each dashboard page displays the time frame for which the dashboard statistics apply.

7.7.2 Functional area tab

For details on how to use the Functional area tab settings, see Creating functional areas [page 109].

7.7.3 Business rule tab

For details on how to use the business rule tab settings, see Creating business rules [page 110].
Auto Documentation reports provide a convenient and comprehensive way to create printed documentation for all of the objects you create in SAP Data Services.

Auto Documentation reports capture critical information for understanding your jobs so you can see at a glance the entire ETL process.

After you create a project, you can use Auto Documentation reports to quickly create a PDF or Microsoft Word file that captures a selection of job, work flow, and/or data flow information including graphical representations and key mapping details.

The types of information provided by Auto Documentation reports include:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object properties</td>
<td>Apply to work flows, data flows, and ABAP data flows.</td>
</tr>
<tr>
<td>Variables and parameters</td>
<td>Apply to jobs, work flows, data flows, and ABAP data flows.</td>
</tr>
<tr>
<td>Table usage</td>
<td>Shows all tables used in this object and its child objects. For example for a data flow, table usage information includes data stores and the source and target tables for each.</td>
</tr>
<tr>
<td>Thumbnails</td>
<td>An image that reflects the selected object with respect to all other objects in the parent container. Applies to all objects except jobs.</td>
</tr>
<tr>
<td>Mapping tree</td>
<td>Applies to data flows.</td>
</tr>
</tbody>
</table>

8.1 Navigation

Auto Documentation reports allow you to navigate to any project, job, work flow, data flow, or ABAP data flow created in the Designer and view information about the object and its components.

To open Auto Documentation reports, from the Management Console Home page, click Auto Documentation.

Auto Documentation navigation is similar to that of Impact and Lineage reports. The Auto Documentation page has two primary panes:

- The left pane shows a hierarchy (tree) of objects.
- The right pane shows object content and context.

Expand the tree to select an object to analyze. Select an object to display pertinent information in the right pane. In the right pane, select tabs to display desired information. Tabs vary depending on the object you are exploring.

Note that if the subcategory within a tab has a window icon on the far right side of its header bar, you can collapse or expand that part of the display.
Related Information

Impact and Lineage Analysis Reports [page 97]

8.1.1 Searching for a specific object

1. Type the object name in the *Objects to analyze* search field. The search field is not case sensitive, you may use the percent symbol (%) as a wildcard, and spaces are allowed.
2. Click the search icon (binoculars) or press Enter.

The top level of the navigation tree displays the current repository. You can change this repository in the Settings control panel.

When you first open Auto Documentation, in the right pane the Project tab displays with hyperlinks to the projects in the repository. You can click on these links to drill into the project to display a list of jobs. You can also continue to click the job name links to continue drilling into objects for more information (thumbnails, object properties, and so on).

You can also navigate to this content by selecting objects in the navigation tree. The hierarchy of the tree matches the hierarchy of objects created in Designer.

- Repository
- Project
- Job
- Work flow
- Data flow

8.1.2 Repository

Clicking a repository name in the navigation tree displays the *Overview* tab in the right pane, which includes the following:

Table 54:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repository name</td>
<td>The name given to the repository in the Repository Manager.</td>
</tr>
<tr>
<td>Repository type</td>
<td>The type of repository such as the database type.</td>
</tr>
<tr>
<td>Repository version</td>
<td>The repository version.</td>
</tr>
</tbody>
</table>

8.1.3 Project

Clicking on a project name in the navigation tree displays the Project tab in the right pane, which displays the list of jobs in the project. You can click on these jobs to drill into the hierarchy.
8.1.4 Job

Clicking on a job name displays information on two tabs:

Table 55:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of job</td>
<td>This tab includes:</td>
</tr>
<tr>
<td></td>
<td>● Description</td>
</tr>
<tr>
<td></td>
<td>● A graphical image of the next level of objects in the job (for example one or more work flows or data flows)</td>
</tr>
<tr>
<td></td>
<td>● Variables and parameters used in the job</td>
</tr>
<tr>
<td>Table usage</td>
<td>This tab lists the datastores and associated tables contained in the selected object if applicable.</td>
</tr>
</tbody>
</table>

8.1.5 Work flow

Clicking on a work flow name displays information on two tabs:

Table 56:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of work flow</td>
<td>This tab includes:</td>
</tr>
<tr>
<td></td>
<td>● A thumbnail image reflects the selected object with respect to all other objects in the parent container. For example, if this work flow is the only one in the job, it appears alone; but if there are two other work flows in the job, they will also appear in the thumbnail image. You can click the other thumbnail images to navigate to them, which replaces the content in the right pane with that of the selected object.</td>
</tr>
<tr>
<td></td>
<td>● A graphical image of the object’s workspace window as it appears in the Designer. You can click on objects to drill into them for more details. Objects that have a workspace in Designer will display that workspace.</td>
</tr>
<tr>
<td></td>
<td>● The object properties displays properties such as Execute only once or Recover as a unit if set.</td>
</tr>
<tr>
<td></td>
<td>● Variables and parameters used in the work flow</td>
</tr>
<tr>
<td>Table usage</td>
<td>This tab lists the datastores and associated tables contained in the selected object if applicable.</td>
</tr>
</tbody>
</table>

8.1.6 Data flow

Clicking a data flow name displays information on three tabs:
Table 57:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of data flow</td>
<td>This tab includes the following:</td>
</tr>
<tr>
<td></td>
<td>● A thumbnail image reflects the selected object with respect to all other objects in the parent container.</td>
</tr>
<tr>
<td></td>
<td>● A graphical image of the object’s workspace window as it appears in Designer. You can click on an object in the data flow to drill into it for more information:</td>
</tr>
<tr>
<td></td>
<td>○ A thumbnail of the table with respect to the other objects in the data flow</td>
</tr>
<tr>
<td></td>
<td>○ Table properties including Optimizer hints (caching and join rank settings) and Table basics (datastore and table name)</td>
</tr>
<tr>
<td></td>
<td>○ A thumbnail of the transform with respect to the other objects in the data flow</td>
</tr>
<tr>
<td></td>
<td>○ Mapping details including column names, mapping expressions, descriptions, and data types.</td>
</tr>
<tr>
<td></td>
<td>To go to the top level of the data flow object, click the data flow name in the navigation tree, or click the Back button on your browser.</td>
</tr>
<tr>
<td></td>
<td>● Object properties—Data flow properties such as <em>Execute only once</em> and <em>Degree of parallelism</em></td>
</tr>
<tr>
<td></td>
<td>● Variables and parameters used in the job</td>
</tr>
<tr>
<td>Mapping tree</td>
<td>This tab displays a list of target tables. You can expand or collapse each table display by clicking its header bar. Each target table lists its target columns and the mapping expressions (sources) for each.</td>
</tr>
<tr>
<td>Table usage</td>
<td>This tab lists the datastores and associated tables contained in the selected object if applicable.</td>
</tr>
</tbody>
</table>

8.2  Generating documentation for an object

For most objects, you can quickly generate documentation in Adobe PDF or Microsoft Word format by clicking the printer icon next to the object name in the right pane.

8.2.1  Printing Auto Documentation for an object

1. Select the highest-level object you want to document in the left pane.
2. In the right pane, click the printer icon next to the object name.
3. In the Print window, select the check boxes for the items to include in your printed report.
4. Select PDF or Microsoft Word format.
5. Click *Print*.

The Windows File download dialog box displays. Click Open to generate and open the file now, or click Save to save the file to any location.
6. After saving or printing your report, click Close to close the Print window.

8.3 Auto Documentation Settings control panel

The Auto Documentation Settings control panel allows you to change the options for your reports. In the upper-right corner of the window, click Settings.

The following options are available in the Settings tab:

- **Repository**—Select a repository from the drop-down list box and click Apply.
- **ImageDisplay**—Specify whether a whole or partial image is displayed for large images. Setting the option to Partial improves performance and memory utilization.

The About tab provides software version information.
9 Data Quality Reports

Many Data Quality transforms generate information about the data being processed. Data Quality reports provide access to that data processing information. You can view and export these Crystal Reports for batch and real-time jobs. The statistics-generating transforms include Match, USA Regulatory Address Cleanse, Data Cleanse, Global Address Cleanse, Geocoder, and DSF2 Walk Sequencer transforms. Report types include addressing reports, transform-specific reports, and transform group reports.

Note

Viewing or exporting data quality reports requires that you have first installed the Data Services APS services on the same machine that contains the BI platform (or IPS) Central Management Server. See the Data Services Installation Guide and Master Guide for more information.

9.1 Configuring report generation

To enable report generation, ensure the option Generate report data in the transform editor is enabled, or use substitution variables to set this and other transform options at a repository level.

For details about setting the options for transforms, see the Reference Guide. For details about using substitution variables, see the Designer Guide.

The following table lists the available reports and their associated transforms.

Table 58:

<table>
<thead>
<tr>
<th>Report</th>
<th>Transform</th>
</tr>
</thead>
<tbody>
<tr>
<td>US CASS report: USPS Form 3553</td>
<td>USA Regulatory Address Cleanse</td>
</tr>
<tr>
<td>NCOALink Processing Summary report</td>
<td>USA Regulatory Address Cleanse</td>
</tr>
<tr>
<td>US Addressing report</td>
<td>USA Regulatory Address Cleanse</td>
</tr>
<tr>
<td>US Regulatory Locking report</td>
<td>USA Regulatory Address Cleanse</td>
</tr>
<tr>
<td>Delivery Sequence Invoice report</td>
<td>DSF2 Walk Sequencer</td>
</tr>
<tr>
<td>Canadian SERP report: Statement of Address Accuracy</td>
<td>Global Address Cleanse</td>
</tr>
<tr>
<td>Australia AMAS report: Address Matching Processing Summary</td>
<td>Global Address Cleanse</td>
</tr>
<tr>
<td>Address Information Codes Sample report</td>
<td>Global Address Cleanse and USA Regulatory Address Cleanse</td>
</tr>
<tr>
<td>Address Information Code Summary report</td>
<td>Global Address Cleanse and USA Regulatory Address Cleanse</td>
</tr>
<tr>
<td>Address Validation Summary report</td>
<td>Global Address Cleanse and USA Regulatory Address Cleanse</td>
</tr>
</tbody>
</table>
### Opening and viewing reports

To view Data Quality reports, from the Management Console Home page, click **Data Quality Reports**. The **Batch job reports** tab appears.

**Note**

To view a Data Quality report, after clicking it, you will need to enter a user name and password for the Data Services repository. Once you have logged in, you may view as many Data Quality reports as you want during a single session in the Management Console without needing to provide the password again. This is the default behavior. See the *Administrator Guide* for more information, including how to change this behavior.

**Note**

Reports require the Arial Unicode MS font. This font is designed to support a wide variety of code pages and is included with Microsoft Office 2002 and later. To view Unicode data in PDF reports, this font must be installed on the computer being used to view the reports. For more information about the Arial Unicode MS font, including how to install from a Microsoft Office CD, visit the Microsoft Web site.

---

<table>
<thead>
<tr>
<th>Report</th>
<th>Transform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Type Summary report</td>
<td>Global Address Cleanse and USA Regulatory Address Cleanse</td>
</tr>
<tr>
<td>Address Standardization Sample report</td>
<td>Global Address Cleanse and USA Regulatory Address Cleanse</td>
</tr>
<tr>
<td>Address Quality Code Summary report</td>
<td>Global Address Cleanse</td>
</tr>
<tr>
<td>Data Cleanse Information Code Summary report</td>
<td>Data Cleanse</td>
</tr>
<tr>
<td>Data Cleanse Status Code Summary report</td>
<td>Data Cleanse</td>
</tr>
<tr>
<td>Best Record Summary report</td>
<td>Match</td>
</tr>
<tr>
<td>Match Contribution report</td>
<td>Match</td>
</tr>
<tr>
<td>Match Criteria Summary report</td>
<td>Match</td>
</tr>
<tr>
<td>Match Source Stats Summary report</td>
<td>Match</td>
</tr>
<tr>
<td>Match Duplicate Sample report</td>
<td>Match</td>
</tr>
<tr>
<td>Match Input Source Output Select report</td>
<td>Match</td>
</tr>
<tr>
<td>Match Multi-source Frequency report</td>
<td>Match</td>
</tr>
<tr>
<td>Geocoder Summary report</td>
<td>Geocoder</td>
</tr>
</tbody>
</table>
9.3 Lists of available reports

After opening the Data Quality Reports module in the Data Services Management Console, the **Batch job reports** tab displays a list of jobs and their associated available reports. Click the **Real-time job reports** tab to display reports available for real-time jobs. The **Real-time job reports** tab includes the same information that is on the **Batch job reports** tab.

The upper-right corner of either the Batch or Real-time pages displays the repository for the reports you are viewing. You can change the repository that you want to view in the **Settings** control panel.

You can filter the list of reports displayed by selecting a job name and/or a date or date range.

To filter by job, select the job name from the **Job name** drop-down menu. Or type the name, or type part of the name and a wildcard character (% or *), into the wildcard search string box and click **Search**. The Search field is not case sensitive and spaces are allowed.

To filter by when the job(s) executed, select one of the following options:

- Show last execution of a job.
- Show status relative to today: Select the number of previous days over which to view job executions.
- Show status as a set period: Type the date range or select the dates by clicking the calendar icons.

Click **Search** to update the list.

The report list includes the following headings. You can sort or reverse sort on any column by clicking the arrow next to the column name.

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Click the icon in this column to go to a page that lists the reports for the associated job.</td>
</tr>
<tr>
<td>Job name</td>
<td>The name of the job in the Designer.</td>
</tr>
<tr>
<td>Status</td>
<td>The execution status of the job: green (succeeded), yellow (had one or more warnings), red (had one or more errors), or blue (still executing).</td>
</tr>
<tr>
<td>Start time and End time</td>
<td>The start and end dates (in the format yyyy-mm-dd) and times (in the format hh:mm:ss).</td>
</tr>
<tr>
<td>Execution time</td>
<td>The elapsed time to execute the job.</td>
</tr>
<tr>
<td>Rows extracted and Rows loaded</td>
<td>The number of rows read by the job and the number of rows loaded to the target.</td>
</tr>
</tbody>
</table>

**Related Information**

Data Quality Reports Settings control panel [page 126]
9.4 List of reports by job

On the list of available reports page (either the Batch job reports or Real-time reports tabs), click an icon in the Report column to display a page with the list of reports that are available for the associated job. The job name displays at the top of the page.

Filter the list by performing one of the following actions:

Table 60:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a report name from the drop-down list.</td>
<td>This action automatically populates the Search box and submits the request.</td>
</tr>
<tr>
<td>Type the name or part of the name and a wildcard character (% or *) into the Search box and click Search.</td>
<td>The Search field is not case sensitive and spaces are allowed.</td>
</tr>
</tbody>
</table>

The list of reports includes the following column headings. You can sort or reverse sort on any column by clicking the arrow next to the column name.

Table 61:

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Click the icon in this column to open the report, which displays in a new browser window. The three icons represent the type of report:</td>
</tr>
<tr>
<td></td>
<td>● Summary</td>
</tr>
<tr>
<td></td>
<td>● Transform-specific report</td>
</tr>
<tr>
<td></td>
<td>● Report for a group of transforms (match set or associate set)</td>
</tr>
<tr>
<td>Path name</td>
<td>The transform location within the job if the report comes from a transform, match set, or associate set. The location displays in the form of &lt;data flow name&gt;/&lt;transform name&gt;. If the report comes from a job summary report, the job name displays.</td>
</tr>
<tr>
<td>Report name</td>
<td>The type of report (for example Address Type Summary report or Match Contribution report).</td>
</tr>
<tr>
<td>Object name</td>
<td>The source object used for the report, typically the transform name used in the data flow (blank for job summary reports).</td>
</tr>
</tbody>
</table>

9.5 Data Quality Reports Settings control panel

Use the Settings control panel to select a different repository for viewing reports. In the upper-right corner of the window, click Settings. Select a repository from the drop-down list box and click Apply.
9.6 Report options

After opening a report, use the toolbars at the top (and bottom) of the report window to perform the following tasks:

- Export to one of the following formats: Crystal Report (RPT), Adobe Acrobat (PDF), Microsoft Word - Editable (RTF), or Rich Text Format (RTF). The Export Report dialog box also lets you select a page range to export.
- Print the full report or a range of pages
- Show the group tree, which displays a hierarchical navigation tree pane. Select links in the tree to navigate to different sections of the report.
- Navigate through the report using the page links and fields at the top and bottom of the report page
- Refresh the report
- Search for text
- Resize the view

In many of the reports, you can select the transform name, path, charts, or other components to display a separate report that is specific to that component. To identify which components are enabled for viewing as a subreport, move the cursor over the report and look for objects that make it change to a hand icon. The description (name) of the newly displayed report then appears in the tab at the top of the report. The tabs displays all the subreports you have accessed. Select Main Report to return to the original report.

9.7 Troubleshooting reports

The following are several report tips and solutions that you can use to troubleshoot report problems.

Font

Reports require the Arial Unicode MS font. This font is designed to support a wide variety of code pages and is included with Microsoft Office 2002 and later. To view Unicode data in PDF reports, this font must be installed on the computer being used to view the reports. For more information about the Arial Unicode MS font, including how to install from a Microsoft Office CD, visit the Microsoft Web site.

Slow reports or timeout error

If you encounter a timeout error or notice that your reports are running appreciably slower, your DBA should update the database statistics on your repository database, primarily the AL_STATISTICS ADDRINFOCODEDATA ADDRSTATUSCODEDATA table. In Oracle, this is called “Gather statistics.”

If you use an Oracle database, here are some additional options that your DBA can modify to try to correct the issue (other databases may have similar options):

- Increase the Processes value to 400 or greater.
- Increase the PGA Memory to 194MB or greater.
- Set the Cursor_Sharing value to Force.

### 9.8 USA CASS report: USPS Form 3553

**Description**

The Coding Accuracy Support System (CASS) report is a facsimile of United States Postal Service (USPS) Form 3553. You need this form to qualify mailings for postage discounts. For more information about CASS, visit the USPS RIBBS (Rapid Information Bulletin Board) web site at [https://ribbs.usps.gov/](https://ribbs.usps.gov/).

**To enable the report**

To generate this report, use the USA Regulatory Address Cleanse transform. Ensure the following options have been defined, or configure the appropriate substitution parameters:

- Enable Report And Analysis Generate Report Data
- Disable Non Certified Options Disable Certification
- Set all applicable options in the CASS Report Options option group.
- Set all applicable options in the Assignment Options group to <Yes> and specify a valid directory path for each. Applicable options are those that are required for CASS.

### 9.9 NCOALink Processing Summary Report

**Description**

The NCOALink Processing Summary Report can provide a detailed breakdown of the various codes returned by NCOALink and ANKLink processing, information regarding how the NCOALink job was configured, and summary information for some job processing statistics. The report generates information and completes the applicable fields based on your service provider level. The NCOALink Processing Summary Report can be used for USPS certification and audit purposes.

**To enable the report**

To generate this report, use the USA Regulatory Address Cleanse transform. On the Options tab, enable the following options or configure the appropriate substitution parameters:
● Set Assignment Options > Enable NCOALink to Yes.
● Set Report And Analysis > Generate Report Data to Yes.
● Ensure that the other required NCOALink fields on the Options tab have been correctly configured.

How to read this report

The first section of the report includes the report title, the date of the report, and other general information about your job as follows:

● The job name
● The run ID, which specifies a unique identification of an instance of the executed job
● The name of the repository where the job is located
● The official transform name
● The path to the transform in the form <data flow name>/<transform name>

Depending on the transform option settings, the remainder of the report includes the following sections.

Table 62:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Update Summary</td>
<td>Contains information about the job configuration and statistics for move-updated addresses as well as pre-move update counts for Postcode2, DPV, LACSLink, and SuiteLink matches. The Data Returned value shows the processing mode for the mailing list. The possible values are C (change of address), F (return codes), or S (statistics). For a detailed description of the values, see the Reference Guide. To change the processing mode, modify the NCOALink Processing Options List Processing Mode option in the transform. The Match Logic value is a single character code that denotes the combination of move types processed. The setting for each move type (business, individual, and family) displays in the area of the report immediately below the list of all processes used. To change the match logic, modify the NCOALink Processing Options Retrieve Move Types option in the transform. The Mail Class character code is derived from the settings for processing standard mail, first class mail, package services, and periodicals. The setting for each mail class is shown in the section immediately below the list of all processes used. To change the settings, modify the previously noted fields located in the NCOALink Processing Options option group in the transform.</td>
</tr>
<tr>
<td>NCOALink Move Type Sum­mary</td>
<td>Displays statistics for the types of moves (Individual, Family, or Business) processed.</td>
</tr>
<tr>
<td>NCOALink Return Code Sum­mary</td>
<td>Displays a summary of the NCOALink codes returned.</td>
</tr>
<tr>
<td>Move Effective Date Distribu­tion Analysis</td>
<td>Contains the number of records in each category and time period. Categories include new address provided, new address not available, and new address not provided. Time frames include in months: 0-3, 4-6, 7-12, 13-18, 19 plus.</td>
</tr>
</tbody>
</table>
### Section Description

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANKLink Return Code Summary</td>
<td>If ANKLink is enabled, displays a summary of the ANKLink codes returned. The section won’t display if there aren’t any ANKLink return codes in the output.</td>
</tr>
<tr>
<td>Return Code Descriptions</td>
<td>If enabled in the NCOALink Report Options Generate Return Code Descriptions option, displays detailed return code descriptions.</td>
</tr>
<tr>
<td>Service Provider Summary</td>
<td>Contains information specific to processing for limited or full service providers. This section does not display if processing the job as an end user.</td>
</tr>
</tbody>
</table>

### Related Information

Management Console Guide: Administrator, Exporting NCOALink certification logs [page 26]

### 9.10 Delivery Sequence Invoice report

#### Description

The DSF2 Delivery Sequence Invoice is required by the USPS when you claim walk sequence discounts or when you are certifying.

The Delivery Sequence Invoice report is automatically generated when you include the DSF2 Walk Sequencer transform in your job.

#### Note

The DSF2 Walk Sequencer transform adds walk sequencing information to your data. However, to claim walk sequence postage discounts, you must further process your data using presorting software (such as the SAP BusinessObjects Presort product). There are four walk sequence discounts for which you may be eligible:

- Carrier Route
- Walk Sequence
- 90% Residential Saturation
- 75% Total Active Saturation

#### Tip

The Delivery Sequence Invoice report can be large, sometimes exceeding 1000 pages. The number of pages relates to the number of postcode1/sortcode route combinations in your input.
9.10.1 Contents of report

The Delivery Sequence Invoice contains header information and information for each collection of data processed. Header information includes the licensee name, customer ID, site location, and processing date. The body of the report lists data for each postcode/sortcode route combination. The list below describes the data reported in the Delivery Sequence Invoice.

Table 63:

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Deliveries</td>
<td>Indicates the total number of deliveries within the specified postcode/sortcode combination.</td>
</tr>
<tr>
<td>Total Residences</td>
<td>Indicates the total number of residences within the specified postcode/sortcode combination.</td>
</tr>
<tr>
<td>Delivery Points Sequenced</td>
<td>Indicates the number of delivery points sequenced by the transform for the specific postcode/sortcode combination.</td>
</tr>
<tr>
<td>Residences Sequenced</td>
<td>Indicates the number of residences sequenced for the specific postcode/sortcode combination.</td>
</tr>
<tr>
<td>Percent Residences</td>
<td>Indicates the percent of the residences sequenced by the transform for the specified postcode/sortcode combination. The formula is 100 (residences sequenced + total residences).</td>
</tr>
<tr>
<td>Percent Active Deliveries</td>
<td>Indicates the percent of delivery points sequenced by the transform for the specified postcode/sortcode compination. The formula is 100 (delivery points sequenced + total deliveries).</td>
</tr>
<tr>
<td>Discounts</td>
<td>Indicates the type of discount the postcode/sortcode combination is eligible for.</td>
</tr>
<tr>
<td>A = Sortcode Route (Carrier Route)</td>
<td></td>
</tr>
<tr>
<td>B = 125 Walk Sequence</td>
<td></td>
</tr>
<tr>
<td>C = 90% Residential Saturation</td>
<td></td>
</tr>
<tr>
<td>D = 75% Total Active Saturation</td>
<td></td>
</tr>
</tbody>
</table>

9.11 US Addressing Report

The US Addressing Report provides a detailed breakdown of the various codes returned by DPV, DSF2, LACSLink, and SuiteLink processing. DPV, SuiteLink, and LACSLink are mandatory for USPS address processing according to CASS guidelines.
9.11.1 Enabling the report

To enable the US Addressing Report with the USA Regulatory Address Cleanse transform, complete the following options or configure the appropriate substitution variables:

- In the Report and Analysis group, select <Yes> for the Generate Report Data option.
- In the Reference Files group, set the DPV Path, DSF2 Augment Path, LACSLink Path, and SuiteLink Path as appropriate (you can use substitution variables).
- In the Assignment options group, set Enable DPV, Enable DSF2 Augment, Enable LACSLink, and Enable SuiteLink to <Yes> as appropriate.

9.11.2 Percent calculation

Many areas of the USA Regulatory Address Cleanse transform reports include percentages. The software calculates the denominator portion of the percentage calculation based on the following for the U.S. Addressing Report and the Address Validation Summary report:

**US Addressing Report:** The calculation of the denominator is based on the total of all DPV return codes of Y, D, S, and the addresses that are not DPV valid.

**Address Validation Summary report:** The calculation of the denominator is based on the total of all records processed by the USA Regulatory Address Cleanse transform.

For both reports, the following record types will no longer be factored into the percentage calculation:

- Number of records where all input fields mapped into the transform contain NULL or blank values.
- Number of records that contain Unicode characters.
- Number of records that are not processed because of Z4Change functionality.

Related Information

US Addressing Report [page 131]
Address Validation Summary report [page 140]

9.11.3 Information in the US Addressing report

The first section of the US Addressing Report includes the report title, the date of the report, and other general information about your job as follows:

- The job name
- The run ID, which specifies a unique identification of an instance of the executed job
- The name of the repository where the job is located
- The official transform name
- The path to the transform in this format: <data flow name> / <transform name>
Audit information, which specifies how many records were processed during address cleansing, the start and end time, any idle time, and the amount of active processing time.

The remainder of the report includes:

- LACSLink summary
- Counts for the LACSLink return codes encountered during processing
- DPV summary
- Counts for the DPV return codes encountered during processing
- SuiteLink return codes
- DSF2 counts from the Second Generation Delivery Sequence File (DSF2) Summary
- DSF2 Address Delivery Types

**Note**

Pre and post NCOALink processing sections appear in the report when NCOALink is enabled in the job. Pre NCOALink counts exist for DPV, DSF2, LACSLink, and SuiteLink. Post NCOALink counts exist for DPV and DSF2 counts/statistics.

### 9.11.4 DPV sections

The US Addressing Report contains the following sections for DPV:

<table>
<thead>
<tr>
<th>Section name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery Point Validation (DPV) Summary</td>
<td>Separate DPV number and percent for each DPV status indicator of Y, S, and D.</td>
</tr>
<tr>
<td>DPV Return Codes</td>
<td>Number and percent for DPV validated/not valid, CMRA validated, DPV vacant addresses, and DPV NoStats addresses.</td>
</tr>
</tbody>
</table>

When processing for NCOALink, the US Addressing Report includes pre and post NCOALink processing information for the Delivery Point Validation (DPV) Summary and DPV Return Codes sections.

### 9.11.5 Information in the DSF2 sections

The US Addressing Report contains the following sections for DSF2:
Table 65:

<table>
<thead>
<tr>
<th>Section name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Second Generation Delivery Sequence File (DSF2)</td>
<td>Number and percentage of addresses in your file that match these DSF2 address categories:</td>
</tr>
<tr>
<td>Summary</td>
<td>• Drop addresses (including CMRA)</td>
</tr>
<tr>
<td></td>
<td>• Business addresses</td>
</tr>
<tr>
<td></td>
<td>• Throwback addresses</td>
</tr>
<tr>
<td></td>
<td>• Seasonal addresses</td>
</tr>
<tr>
<td></td>
<td>• Educational Institute addresses</td>
</tr>
<tr>
<td></td>
<td>When you are processing for NCOALink, the US Addressing Report includes pre-NCOALink processing information and post-NCOALink processing information for this section.</td>
</tr>
<tr>
<td>Address Delivery Types</td>
<td>Number and percentage of addresses for these delivery type categories:</td>
</tr>
<tr>
<td></td>
<td>• Curb</td>
</tr>
<tr>
<td></td>
<td>• Central</td>
</tr>
<tr>
<td></td>
<td>• Door Slot</td>
</tr>
<tr>
<td></td>
<td>• Neighborhood Delivery Centralized Box Unit</td>
</tr>
<tr>
<td></td>
<td>When processing for NCOALink, the US Addressing Report includes pre and post NCOALink processing information for this section.</td>
</tr>
</tbody>
</table>

9.11.6 LACSLink sections

The US Addressing Report contains the following sections for LACSLink:

Table 66:

<table>
<thead>
<tr>
<th>Section name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locatable Address Conversion Summary</td>
<td>Number and percent of records that were converted and the number and percentages of addresses that were not converted through LACSLink.</td>
</tr>
<tr>
<td>LACSLink Return Codes</td>
<td>Number and percent of records for each return code type.</td>
</tr>
</tbody>
</table>

When processing for NCOALink, the US Addressing Report includes pre and post NCOALink processing information for the Locatable Address Conversion Summary and the LACSLink Return Codes sections.

9.11.7 SuiteLink sections

The US Addressing Report contains the following section for SuiteLink:
Table 67:

<table>
<thead>
<tr>
<th>Section name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>SuiteLink Return Codes</td>
<td>The number and percent of SuiteLink matches for the following return codes:</td>
</tr>
<tr>
<td></td>
<td>- A: Secondary exists and assignment made.</td>
</tr>
<tr>
<td></td>
<td>- 00: Lookup was attempted but no assignment.</td>
</tr>
</tbody>
</table>

When processing for NCOALink, the US Address Report includes SuiteLink Return Codes only for pre NCOALink processing.

### 9.12 DSF2 Augment Statistics Log File

The USPS requires DSF2 licensees to save monthly information about their processing in the DSF2 Augment Statistics Log File. The USPS has a specific naming format for the log files:

```
[DSF2_Licensee_ID][mm][yy].dat
```

Access the DSF2 Augment Statistics Log File through the Management Console.

**Note**

The DSF2 Log File is based on when the job completes, not when the job starts. For example, a job that is started on 31 December and completes on 1 January will be included in the January DSF2 Log File.

The USPS dictates the content of the DSF2 Log File and requires that you submit log to them monthly. For details, see the DSF2 Licensee Performance Requirements document, which is available on the USPS RIBBS website. The DSF2 licensee must keep the log file data for at least 5 years.

You must submit the DSF2 Augment Statistics Log File to the USPS (National Customer Support Center) within the first seven (7) calendar days of each month.

**Related Information**

*Exporting DSF2 certification log [page 27]*

### 9.13 US Regulatory Locking Report

**Description**

The software generates this report only when it encounters a false positive address during DPV or LACSLink processing with the USA Regulatory Address Cleanse transform.
The USPS includes false positive addresses with the DPV and LACSLink directories as a security precaution. Depending on what type of user you are, the behavior varies when the software encounters a false positive address.

If you use DPV or LACSLink processing for purposes other than NCOALink or if you are an NCOALink end user without an alternate stop processing agreement, the US Regulatory Locking Report contains the false positive address record (lock record) and lock code. You need this information in order to retrieve the unlock code from the SAP Service Marketplace.

If you are an NCOALink service provider or end user with an alternate stop processing agreement, the US Regulatory Locking Report contains the path to the DPV or LACSLink log files. The log files must be submitted to the USPS.

For more information about DPV and LACSLink locking and unlocking, see the Designer Guide.

**To enable this report**

To enable this report with the USA Regulatory Address Cleanse transform, verify the following options, or configure the appropriate substitution parameters:

- In the Report And Analysis options group, ensure Generate Report Data is set to Yes.
- In the Reference Files options group, set the DPV Path or LACSLink Path as appropriate.
- In the Assignment options group, set Enable DPV or Enable LACSLink to Yes.

**How to read this report**

The first section of the report includes the report title, the date of the report, and other general information about your job as follows:

- The job name
- The run ID, which specifies a unique identification of an instance of the executed job
- The name of the repository where the job is located
- The official transform name
- The path to the transform in the form data <flow name>/transform name
- Audit information, which specifies how many records were processed during address cleansing, the start and end times, any idle time, and the amount of active processing time

Depending on your user type, the second section of the report contains either the lock code as well as the information related to the record that caused the directory locking or the path to the DPV or LACSLink log files.
9.14  Canadian SERP report: Statement of Address Accuracy

Description

The Canadian Software Evaluation and Recognition Program (SERP) Statement of Address Accuracy report includes statistical information about Canadian address cleanse processing such as the Address Accuracy Level.

To generate the report

To generate this report with the Global Address Cleanse transform, ensure the following options are defined, or configure the appropriate substitution parameters:

- In the Global Address Cleanse transform, enable Report And Analysis Generate Report Data.
- In the Canada group, complete all applicable options in the Report Options subgroup.
- In the Engines section, set Canada to Yes.

9.15  Australian AMAS report: Address Matching Processing Summary

Description

The Australian Address Matching Approval System (AMAS) Address Matching Processing Summary report includes statistical information about Australian address cleanse processing.

To generate the report

To generate this report with the Global Address Cleanse transform, ensure the following options have been defined, or configure the appropriate substitution parameters:

- In the Global Address Cleanse transform, enable Report And Analysis Generate Report Data.
- In the Australia group, complete all applicable options in the Report Options subgroup.
- In the Engines section, set Australia to Yes.
9.16 New Zealand Statement of Accuracy (SOA) report

Description

The New Zealand Statement of Accuracy (SOA) report includes statistical information about address cleansing for New Zealand.

To enable the report

- In the Global Address Cleanse transform, enable Report And Analysis > Generate Report Data.
- In the Global Address Cleanse transform, set Country Options > Disable Certification to No.
- Complete all applicable options in the Global Address > Report Options > New Zealand subgroup.
- In the Engines section, set Global Address to Yes.

Note

The software does not produce the SOA Report when Global Address certification is disabled or when there are no New Zealand addresses included in the present job.

Related Information

Management Console Metadata Administrator Guide: Exporting New Zealand SOA certification logs [page 27]

9.17 Address Information Codes Sample report

Description

The Address Information Codes Sample report is a sampling of the records that were assigned information codes (Global Address Cleanse) or fault codes (USA Regulatory Address Cleanse) during processing. The transform uses these codes to indicate why it was unable to standardize the address. These codes can help you correct the data in specific records or find a pattern of incorrect data entry.

The software initially outputs the first fault record encountered. After that, it outputs every 100th fault record (for example 1, 101, 201, and so on). There is a maximum of 500 fault records.

Note

Depending on your configuration settings, you might see different information/fault records each time the transform processes a particular set of input records.
How to read this report

The first section of the report includes the report title, the date of the report, and other general information about your job as follows:

- Job name
- Run ID, which specifies a unique identification of an instance of the executed job
- Repository name where the job is located
- Full transform name
- Path to the transform in the form <data flow name>/<transform name>
- Engine name. For the Global Address Cleanse transform, it is the name of the global engine that processed the data, and for the USA Regulatory Address Cleanse transform, it is always USA.

The second section of the report includes a table that specifies the field details for each record for which an information/fault code was found. The table is subdivided by country.

The third section of the report lists a description of each information/fault code.

9.18 Address Information Code Summary report

Description

The Address Information Code Summary report provides record counts of each information or fault code of a specific project.

How to read this report

The first page of the report is a summary of all the information codes if one of the following is true:

- The job contains more than one USA Regulatory Address Cleanse or Global Address Cleanse transform.
- A single Global Address Cleanse transform processes records from more than one engine.

Subsequent pages will include a report for each transform or engine.

The first section of the summary page includes the report title, the date of the report, and other general information about your job as follows:

- Job name
- Run ID, which specifies a unique identification of an instance of the executed job
- Repository name where the job is located
- Official transform name
- Path to the transform in the form <data flow name>/<transform name>
- Audit information, which specifies how many records were processed during address cleansing, the start and end time, any idle time, and the amount of active processing time
The second part of the report includes a bar graph that shows how many different information/fault codes were assigned during processing. With this graph, you should be able to see which information/fault code occurred the most frequently, which could help you detect any consistent problems with your data.

The section below the bar graph shows how many different information/fault codes occurred along with a description of each code. For the Global Address Cleanse transform, this section is organized by engine name. At the end of the listing, the report shows the total number of information/fault codes assigned.

9.19 Address Validation Summary report

Description

The Address Validation Summary report provides record validation statistics for each Global Address Cleanse transform or USA Regulatory Address Cleanse transform of a specific job.

How to read this report

The first section includes the report title, the date of the report, and other general information about your job as follows:

- Job name
- Run ID, which specifies a unique identification of an instance of the executed job
- Repository name where the job is located
- Official transform name
- Path to the transform in the form `<data flow name>/transform name`
- Audit information, which specifies how many records were processed during address cleansing, the start and end time, any idle time, and the amount of active processing time

The second section of this report includes a bar graph that shows the output fields and how many were unchanged or corrected during address cleansing.

The third section of this report also shows the same data as in the second section, but in a table.

If NCOALink processing is enabled, this report also displays pre and post NCOALink processing graphs and statistics.

Related Information

Percent calculation [page 132]
9.20  Address Type Summary report

Description

The Address Type Summary report contains record counts of each Assignment_Type field value used per Global Address Cleanse transform or Address_Type field value per USA Regulatory Address Cleanse transform of a specific job.

How to read this report

The first section of the report includes the report title, the date of the report, and other general information about your job as follows:

- Job name
- Run ID, which specifies a unique identification of an instance of the executed job
- Repository name where the job is located
- Official transform name
- Path to the transform in the form <data flow name>/<transform name>
- Audit information, which specifies how many records were processed during address cleansing, the start and end time, any idle time, and the amount of active processing time

The second section includes a pie chart that shows the percentage for the values of the Assignment_Type field (Global Address Cleanse) and the Address_Type field (USA Regulatory Address Cleanse) used in the transform.

The third section of this report also shows this same data as in the second section, but in a table.

If NCOALink processing is enabled, this report also displays pre and post NCOALink processing graphs and statistics.

9.21  Address Standardization Sample report

Description

The Address Standardization Sample report shows records where fields changed during processing. The fields displayed are your input fields and the associated output fields. Status codes are on the report to indicate why the change was necessary. This information helps you to determine which fields are frequently incorrect. You can also use this report to verify that your addresses are standardized correctly.
**How to read this report**

The first section of the report includes the report title, the date of the report, and other general information about your job as follows:

- Job name
- Run ID, which specifies a unique identification of an instance of the executed job
- Repository name where the job is located
- Full transform name
- Path to the transform in the form `<data flow name>/<transform name>`
- Engine name. For the Global Address Cleanse transform, it is the name of the global engine that processed the data, and for the USA Regulatory Address Cleanse transform, it is always USA.

The second section of the report includes the table that shows which records had fields that were standardized along with the status code that explains why the change was necessary. The section also shows the country and the input source taken from the Physical Source field.

The final page of the report has a description of the status codes.

---

**9.22 Address Quality Code Summary report**

**Description**

The Address Quality Code Summary report provides record counts of each quality code assigned per Global Address Cleanse Address Quality Code transform for a specific job. This report is not available for the USA Regulatory Address Cleanse transform.

**How to read this report**

Address Quality Code SummaryThe first page of the report is a summary of all the information codes if:

- The job contains more than one Global Address Cleanse transform.
- A single Global Address Cleanse transform processes records from more than one engine.

In these cases, subsequent pages will include a report for each transform or engine.

The first section of the report includes the report title, the date of the report, and other general information about your job as follows:

- Job name
- Run ID, which specifies a unique identification of an instance of the executed job
- Repository name where the job is located
- Official transform name
- Path to the transform in the form `<data flow name>/<transform name>`
- Audit information, which specifies how many records were processed during address cleansing, the start and end time, any idle time, and the amount of active processing time
The second section of the report includes a pie chart that shows the percentage of the quality codes that were assigned during processing. This chart illustrates the level of quality of your data.

The third section of the report shows, in a table format, the quality codes that were assigned, the record count, and a description of each quality code. This section is also divided by engine name and the country.

9.23 Data Cleanse Information Code Summary report

Description

The Data Cleanse Information Code Summary report provides record counts of each information code for a specific job. The information codes identify characteristics about the data. For example:

- some data went to the Extra output fields
- some person data has a family name, but not a given name
- a date’s year was converted from 2-digits to 4-digits

How to read this report

The first section of the summary page includes the report title, date, and other general information about your job as follows:

- Job name
- Run ID, which specifies a unique identification of an instance of the executed job
- Repository name where the job is located
- Official transform name
- Path to the transform <dataflow name>/<transform name>
- Audit information, which specifies how many records were processed during data cleansing, the start and end time, any idle time, and the amount of active processing time.

The report begins with a summary of the frequency of information codes. The rest of the charts show the information codes per parser such as Date, Person, Firm, Phone, and so on. With the information in this report, you should be able to see which information codes occurred most frequently. This information could help you detect any consistent problems with the data.

To enable the report

In the Designer, choose Tools > Substitution Parameter Configurations and configure the Generate Report Data option to [$$ReportsDataCleanse]. This is a parameter that can be configured to either Yes or No for report generation.

Then, in the Data Cleanse transform, enable Report And Analysis > Generate Report Data
9.24 Data Cleanse Status Code Summary report

Description

The Data Cleanse Status Code Summary report provides record counts for each generated status code. The status codes describe the standards applied in the Data Cleanse transform.

How to read this report

The first section of the summary page includes the report title, date, and other general information about your job as follows:

- Job name
- Run ID, which specifies a unique identification of an instance of the executed job
- Data Cleanse Status CodeRepository name where the job is located
- Official transform name
- Path to the transform <dataflow name>/<transform name>
- Audit information, which specifies how many records were processed during data cleansing, the start and end time, any idle time, and the amount of active processing time.

The charts include a list of status code names, descriptions, and the number of records that used each status code. The report includes a chart and data for each parser, for example, Date, Phone, Firm, Person, and so on. With this report, you should have a better understanding of the generated status codes that show how the data is standardized and can be used for better matching results with the Match transform.

To enable the report

In the Designer, choose Tools > Substitution Parameter Configurations and configure the Generate Report Data option to [$ReportsDataCleanse]. This is a parameter that can be configured to either Yes or No for report generation.

Then, in the Data Cleanse transform, enable Report And Analysis > Generate Report Data.

9.25 Geocoder Summary report

Description

The Geocoder Summary report includes statistical information about geocoding.
To enable the report

In the Geocoder transform, enable Report And Analysis Generate Report Data.

9.26 Overview of match reports

Setting up match reports

To set up the Physical Source Field, Logical Source Field, and matching process transforms, refer to the Designer Guide: Data Quality, Match section. Verify the appropriate substitution parameter configurations.

Common match report information

The first section includes general information about your job such as:

- The job name
- The run ID, which specifies a unique identification of an instance of the executed job
- The repository where the job is located
- The official transform name
- The path to the transform in the form `<data flow name> / <transform name>`

9.27 Best Record Summary report

Description

The purpose of best record post-processing is to salvage data from matching records—that is, members of match groups—and consolidate, or post, that data to a best record or to all matching records. The Best Record Summary report shows statistics about the best record process used in the match. It indicates what settings were selected and the results of the posting.

If your results show any trends that could be improved by adjustments to your settings, then change those settings and re-process the step.

How to read this report

The Best Record Contribution table shows the overall results of the posting. The report columns are as follows.
Table 68:

<table>
<thead>
<tr>
<th>Report column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best Record Name</td>
<td>The name of the Best Record operation you specified in the Match transform.</td>
</tr>
<tr>
<td>Posting Destination</td>
<td>The destination (either Master, Subordinate, or ALL) for the post.</td>
</tr>
<tr>
<td>Post Only Once Per Destination</td>
<td>Setting shows Yes or No to indicate whether more than one posting will be attempted for each record.</td>
</tr>
<tr>
<td>Post Attempts</td>
<td>The number of Best Record operations that were attempted. This is the total of the protected drops, destination field drops, filter drops, and posts completes.</td>
</tr>
<tr>
<td>Protect Drops</td>
<td>The number of operations that were cancelled because a posting destination was protected.</td>
</tr>
<tr>
<td>Destination Field Drops</td>
<td>Operations that were canceled because the Best Record operation was set to allow posting only once per destination record.</td>
</tr>
<tr>
<td>Strategy Drops</td>
<td>Operations that were canceled because the Best Record strategy returned False.</td>
</tr>
<tr>
<td>Post Completes</td>
<td>The number of Best Record operations that successfully completed.</td>
</tr>
</tbody>
</table>

The next section of the report contains audit information such as:

- How many records were processed during the match
- The start and end time
- Any idle time
- The total amount of time it took to run the Match transform

The Best Record Strategy section shows:

- The name of the best record strategy field containing the statistics
- The source and destination fields used in the best record action

## 9.28 Match Contribution report

### Description

The Match Contribution report provides you with information on the effect of the individual break groups and individual criteria on the total matching process. By studying the largest and smallest break groups and their break keys, you can determine whether they must be realigned for more accurate distribution in the matching process. The software generates one report for each match set.

You can also look at the criteria that are making the highest percentage of match/no-match decisions to verify the accuracy as well as the effectiveness of the criteria settings.

The size of the break groups has a significant impact on the speed of the matching process. If you have many large break groups (break groups with large numbers of records), the matching process slows down because it has to do so many comparisons. If that is the case, you might want to adjust your break group formation strategy so the resulting break groups are smaller.

Results showing break groups with only a single record could indicate criteria that is too restrictive. Because data in one break group is never compared with data in another break group, the restrictive criteria could be isolating data that would otherwise match.
Use this report in conjunction with the Match Criteria Summary report to understand the contributions of the various criteria and to view the detailed criteria definitions.

**Break Group Contribution**

The Break Group Contribution table lists the smallest and largest break group contributors. This section contains data only if you create break groups in your job.

Other information includes:

Table 69:

<table>
<thead>
<tr>
<th><strong>Total number of break groups</strong></th>
<th>The number of break groups created based on your break group settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Theoretical maximum comparisons</strong></td>
<td>The number of comparisons that would be made without using any break group strategy (or putting all records in a single break group).</td>
</tr>
<tr>
<td><strong>Break group comparisons</strong></td>
<td>The number of actual comparisons made because of breaking.</td>
</tr>
<tr>
<td><strong>Comparisons per hour</strong></td>
<td>The number of comparisons made per hour.</td>
</tr>
<tr>
<td><strong>Hours saved by breaking</strong></td>
<td>The amount of time saved because of breaking.</td>
</tr>
<tr>
<td><strong>Max records in compare buffer</strong></td>
<td>The maximum number of records that can fit in the memory buffer used for comparison. This value, in conjunction with the largest break group size, can be used to fine-tune performance of match process. If the largest break group size is smaller than the number of records that can fit in the compare buffer, then the records will be stored and accessed from memory. This makes the process go faster. However, if the largest break group is bigger, then some caching will be involved and it may slow down processing. In order to fix it, you can either change the breaking strategy to make smaller break groups or you can increase the buffer size by doing the following:</td>
</tr>
<tr>
<td>1. In the Designer, Choose [Tools] &gt; [Options] &gt; [Job Server] &gt; [General].</td>
<td></td>
</tr>
<tr>
<td>2. In the <strong>Section</strong> box, type <strong>MatchSettings</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. In the <strong>Key</strong> box, type <strong>MemoryInKBForComparisons</strong>.</td>
<td></td>
</tr>
<tr>
<td>4. In the <strong>Value</strong> box, type the number of kilobytes of memory you want as your buffer. The default value is 4096 KB.</td>
<td></td>
</tr>
<tr>
<td>5. Click [OK].</td>
<td></td>
</tr>
</tbody>
</table>

**Audit Information**

The Audit Information section specifies how many records were processed during the match, the start and end time, any idle time, and the total amount of time it took to run the Match transform.

The audit section is followed by the Match Set Name and the Match Level Name(s) if the match set has multiple levels.

**Match Criteria Contribution**

The last section shows the Match Criteria Contribution listed by criteria name and in order of the criteria execution. Focus on the criteria that are the most productive—that is, the criteria making the most decisions. The
criteria that make the most decisions should be the first to be evaluated, so order your criteria appropriately in your Match transform. This will help with performance.

Related Information

Match Criteria Summary report [page 148]

9.29 Match Criteria Summary report

Description

The software generates one Match Criteria Summary report per match set. Use the report to obtain a consolidated view of all key settings and the criteria settings. Using this report can help you determine whether the values you set for each criteria are giving you the results you require.

After reading this report in conjunction with the Match Contribution report, which shows the break group contributions, you might decide to adjust field compare lengths or settings like match/no match score. The Match Criteria Summary report gives you the necessary information to fine-tune the settings and to compare multiple match criteria for consistency.

In the audit information section of the report, you will find information such as:

- How many records were processed during the match
- The start and end time
- Any idle time
- The total amount of time it took to run the Match transform.

The audit section is followed by the Match Set Name and the Match Level Name(s) if the match set has multiple levels.

The Match Input Fields table shows settings for the input fields used for this match including the criteria name, match criteria, field compare length, and any preprocessing options such as punctuation and casing.

The Detailed Criteria Definition table gives you a more detailed breakdown of the match criteria definitions listed by criteria in the order of execution. A list of the Match Level Options displays below the table so you can verify your settings.

i Note

In cases where the Blank Field Operation is set to EVAL, the evaluation score appears as a number instead of the word IGNORE.
Related Information

Match Contribution report [page 146]

9.30 Match Duplicate Sample report

Description

The Match Duplicate Sample report provides some duplicate records as a sample of the match results. One report is generated for each Match transform in the job. If a given transform results in no matches, the software does not generate a report for that transform.

The samples are taken from a maximum of 500 records per transform starting from group number 1, using every 10th match group, and up to 20 records from the selected match groups.

The Physical Source Field table displays the data sources used in the job, including the number of records sampled for that data source.

The Match Duplicate Results table displays the Match duplicate results including record number, group number, score, match type, logical source ID, and input field(s). The records are listed by group number in ascending order. If you do not see data in the Logical Source Field column, be sure that you have included an Input Sources operation in the Match transform, or defined the field that contains the logical source value.

Note

Depending on your configurations settings, you might see different information/fault records each time the transform processes a particular set of input records.

9.31 Match Input Source Output Select report

Description

The Match Input Source Output Select report shows you which types of records and the number of records that were flagged to be kept or dropped per source.

- Keeps: Records you selected in the Output Flag Selection operation of the Match transform (Match Editor).
- Drops: Records you did not select in the Output Flag Selection operation of the Match transform (Match Editor).
Report columns

Table 70:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Input</td>
<td>The number of records in the source.</td>
</tr>
<tr>
<td>Single Source Masters</td>
<td>Highest ranking member of a match group whose members all came from the same</td>
</tr>
<tr>
<td></td>
<td>source. Can be from Normal or Special sources.</td>
</tr>
<tr>
<td>Single Source Subordinate</td>
<td>A record that is a subordinate member of a match group whose members all</td>
</tr>
<tr>
<td></td>
<td>came from the same source. Can be from Normal or Special sources.</td>
</tr>
<tr>
<td>Multiple Source Masters</td>
<td>Highest ranking member of a match group whose members came from more than</td>
</tr>
<tr>
<td></td>
<td>one source. Can be from Normal or Special sources.</td>
</tr>
<tr>
<td>Multiple Source Subordinate</td>
<td>A record that is a subordinate member of a match group whose members came</td>
</tr>
<tr>
<td></td>
<td>from more than one source. Can be from Normal or Special sources.</td>
</tr>
<tr>
<td>Suppress Masters</td>
<td>A record that came from a Suppress source and is the highest ranking member</td>
</tr>
<tr>
<td></td>
<td>of a match group.</td>
</tr>
<tr>
<td>Suppress Subordinate</td>
<td>A record that came from a Suppress source and is a subordinate member of a</td>
</tr>
<tr>
<td></td>
<td>match group.</td>
</tr>
<tr>
<td>Suppress Matches</td>
<td>Subordinate member of a match group that includes a higher-priority record</td>
</tr>
<tr>
<td></td>
<td>that came from a Suppress source. Can be from Normal or Special type sources.</td>
</tr>
<tr>
<td>Suppress Uniques</td>
<td>Records that came from a Suppress source for which no matching records were</td>
</tr>
<tr>
<td></td>
<td>found.</td>
</tr>
<tr>
<td>Uniques</td>
<td>Records that are not members of any match group. No matching records were</td>
</tr>
<tr>
<td></td>
<td>found. These can be from sources with a Normal or Special source type.</td>
</tr>
<tr>
<td>Net Output</td>
<td>The number of records in the source minus the number of records dropped.</td>
</tr>
<tr>
<td>% Kept</td>
<td>The percentage of records that were not dropped from the original input source.</td>
</tr>
</tbody>
</table>

9.32 Match Multi-source Frequency report

Description

The Multi-source Frequency report shows, for each input source, how many of its records were found to match records in other sources.

The format of the Multi-source Frequency report is always the same. There is a row for each of the input sources of the job. The columns show, first, the name of the source, then the total number of the source’s records that appeared in more than one source. The remaining columns show how many records in that source were found in 2 sources, 3 sources, 4 sources, and so on.

If you created source groups, multi-source matches for the source groups are included in a separate table in the report.

- If a record from source1 matches a record from source2, then that record is included in the number in the 2 source column. If a record from source1 matches a record from source2 and also a record from source4, then that record is included in the number in the 3 source column.
- The entry in each column shows the number of multi-source instances—that is, how many records appeared on more than one source, not how many times they appeared. For example, if a record from source1 matches
three records from source2, then that record adds one to the this source’s total in the 2 source column—it’s not added to the 4 source column, nor is three added to the 2 source column.

- When determining the number of sources on which a record appeared, the software does not count single-source matches, or any matches to records from special or suppression sources.

9.33 Match Source Statistics Summary report

Description

The Match Source Statistics report provides information about the distribution of the duplicates found in various input source records including how the duplicates were distributed as master records and subordinate records. The duplicates could be distributed within one logical source (intrasource matches) or across multiple logical sources (intersource matches). This report shows the distribution of the duplicates in general and then the results for each source. The software generates one report per match set.

To generate a meaningful Match Source Statistics report, you must have a Group Statistics operation in your Match or Associate transform. You must also generate basic statistics in those Group Statistics operations.

If you also add an Input Source operation and generate input source statistics in the Group Statistics operations, you will find additional columns related to suppression records.

How to read this report

A pie chart shows what percentage of the duplicates were multiple source masters, multiple source subordinates, single source masters, and single source subordinates.

The source percentages are also detailed in a key list, indicating the distribution of the masters and subordinates.

Match Statistics table

The Match Statistics table lists the statistics for each source, enabling you to understand the impact of statistics such as total record counts and individual source counts. You can compare the number of masters and subordinates generated to the source record counts.

The columns list how many masters came from a single source or from multiple sources. Statistics are also given for the number of subordinates derived from a single source and from multiple sources.

Additional columns for input source statistics

If you chose to count input source statistics in the Group Statistics operation, you will also find the following columns.
Table 71:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suppress Matches</td>
<td>The number of records that match a record in a Suppress-type source.</td>
</tr>
<tr>
<td>Total Non Dupes</td>
<td>The number of master records and uniques in the input source.</td>
</tr>
<tr>
<td>Suppress Uniques</td>
<td>The number of unique records in the Suppress-type source.</td>
</tr>
<tr>
<td>Suppress Masters</td>
<td>The number of master records in the Suppress-type source.</td>
</tr>
<tr>
<td>Suppress Subordinate</td>
<td>The number of subordinate records in the Suppress-type source.</td>
</tr>
</tbody>
</table>

Source by Source Statistics table

The Source by Source Statistics table details the information by source, generating statistics for the number of duplicates that are both intersource (between distinct sources) and intrasource (within a single source).

The Source Name and Comparison Source Name columns display how many times a subordinate record in the specified comparison source was found when the master was from the named source. The other two columns (Number of Inter-Source Matches and Number of Intra-Source Matches) display how many matches were found with the master in one source and the subordinate in another source (intersource) and how many matches were found with the master and subordinate in the same source (intrasource).

For example, you can compare data from two sources: Source 1 lists people who have in-ground swimming pools and Source 2 lists people who have children under the age of two. Your goal is to find the people that fit in both categories. With this report, you can now send your Swimming Pool Safety pamphlet to pool owners who have children under the age of two.
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings (“Code”) included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP’s gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).